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About This Book and the Library

The User Guide provides conceptual information about the NetIQ Firewall Suite 
product (Firewall Suite). This book defines terminology and various related 
concepts.

nderstanding 

work with 

guidance for 
ch window.
About This Book an

Intended Audience

This book provides information for individuals responsible for u
Firewall Suite concepts.

Other Information in the Library
The library provides the following information resources:

Firewall Configuration Guide
Provides information about configuring your firewall to 
NetIQ firewall security applications

Help
Provides context-sensitive information and step-by-step 
common tasks, as well as definitions for each field on ea



Conventions

The library uses consistent conventions to help you identify items throughout 
the documentation. The following table summarizes these conventions.

Convention Use

Bold • Window and menu items

 interface

ter.
xiv     User Guide

• Technical terms, when introduced

Italics • Book and CD-ROM titles

• Variable names and values

• Emphasized words

���������	 • File and folder names

• Commands and code examples

• Text you must type

• Text (output) displayed in the command-line

Brackets, such as [value] • Optional parameters of a command

Braces, such as {value} • Required parameters of a command

Logical OR, such as
value1 | value 2

• Exclusive parameters. Choose one parame



 

About Marshal 
Marshal's Content Security products (MailMarshal for SMTP, MailMarshal for Exchange , 
WebMarshal, Security Reporting Center and Firewall Suite) deliver a complete email and 
Web security solution to a variety of Internet risks. They provide comprehensive 

t. It allows 
e sending and 

ailMarshal for 
olution to these 
he products sit 
ound 
nti-spyware 
a strategic, 
network, and as 

 
l 
u 
protection by acting as a gateway between an organization and the Interne
organizations to restrict, block, copy, archive, and automatically manage th
receiving of messages. 
 

Marshal Products 
Marshal's Content Security solution, which includes MailMarshal SMTP, M
Exchange and WebMarshal, delivers a complete email and Web security s
risks by acting as a gateway between your organization and the Internet. T
behind your firewall but in front of your network systems to control outb
documents and their content. By providing anti-virus, anti-phishing and a
protection at the gateway, Marshal's Content Security solution offers you 
flexible and scalable platform for policy-based filtering that protects your 
a result, your reputation. 
 

Contacting Marshal 
Please contact us with your questions and comments. We look forward to
hearing from you. For support around the world, please contact your loca
partner. For a complete list of our partners, please see our Web site. If yo
cannot contact your partner, please contact our Technical Support team. 
 
Telephone:       +44 (0) 1256 848 080 (EMEA) 

+1 404 759 2890 (Americas) 
+ 64 9 984 5700 (Asia-Pacific) 

Sales Email: info@marshal.com 
Support: www.marshal.com/support 
Web Site: www.marshal.com 
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Chapter 1

Installation

 install Firewall 
r proxy server 

ite on a Primary 

orting solution, 

module
Chapter

For security and performance reasons, we recommend that you
Suite on a workstation other than the one running the firewall o
software. We also recommend that you do not install Firewall Su
Domain Controller (PDC) or Backup Domain Controller (BDC).

This chapter covers topics related to installing your Firewall Rep
including:

• System requirements

• Steps for installing and uninstalling the software

• Considerations when installing the Alerting and Monitoring 

• Product license and registration

• Addition of firewall licenses



System Requirements
The following is a list of minimum system requirements for the computer 
running Firewall Suite: 

• Microsoft Windows NT 4.x, Windows 2000, or Windows XP

• 1.0 GB available disk space

• 512 MB RAM 

 log files. 
on.

r Excel 

higher

rocedure 

ically when 

Firewall 
nse and 
2     User Guide

More disk space and memory may be required to analyze large
Contact your Product Support representative for more informati

• Microsoft Office 97 or later (if you plan to use Microsoft Word o
reports)

• Internet Explorer 4.0 and higher or Netscape Navigator 4.5 and 

Installing Firewall Suite

The installation uses a straightforward setup program. Choose the p
that best suits your needs. 

Installing from the Autorun
Use this procedure if your system is set up to run CD-ROMs automat
you place them in the drive

Note
Although you do not need to provide license information to install 
Suite, you must do so before you can run the application. See “Lice
Registration” on page 5 for details.
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To install Firewall Suite:

1. Insert the program CD into your CD-ROM drive to launch the setup 
program.

2. Follow the on-screen instructions to install the program.

Installing from the Run Dialog Box

oose Run from 

e License 

 without 
Chapter

Use this procedure to start the installation program manually.

To install Firewall Suite:

1. Insert the program CD into your CD-ROM drive, and then ch
the File or Start menu.

2. In the Run dialog box, type:

�
���	
�

where d: is the letter of your CD-ROM drive. 

3. Follow the on-screen instructions to install the program.

Software License Agreement 
Before the program files are copied to your system, the Softwar
Agreement is presented.

• If you agree to the stated terms, click Accept. 

• If you do not agree, click Cancel to exit the setup program
installing. 



Registering your Software 
If you installed Firewall Suite from a CD-ROM you purchased, you can register 
your product online. If you purchased the product online, your registration is 
recorded automatically. Registration allows you to access technical support and 
ensures that you receive information about new releases of the product and 
other benefits.

To register your product:

1. Install Firewall Suite and then start it from either the Start > Programs 
Instructions 

ration. The 
 customer 

ter later by 
4     User Guide

menu or your WebTrends Firewall Suite desktop shortcut icon. 
for installing the product accompany the installation wizard.

2. From the Help menu of the product Main Console, select Regist
product will start your Web browser, then connect to the NetIQ
service Web site.

3. Complete the registration information requested at the site.

Uninstalling Firewall Suite
You can uninstall the program from the Windows Control Panel.

Note
If you do not register when you install Firewall Suite, you can regis
opening the Help menu and selecting Registration.
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License and Registration
When you download Firewall Suite from the Web site and run Setup for the first 
time, choose one of the following options in the first installation wizard panel:

• Install a free time-limited trial. During a limited trial, you may use the 
product free of charge to create profiles and run reports on your own log 
files for a period of 14 days. After that period expires, you must purchase 

ou do not, the 
ts you to 

wall Suite in its 

u a license to 
t restrictions. 
lephone or fax, 
ich you can use 
wall Suite” on 

Firewall Suite 
roduct version. 
 you may enter 

e first wizard 
 steps, Setup 
ox.
Chapter

the product to continue to create profiles or run reports. If y
product runs in a limited demonstration mode, which restric
creating reports only for the sample profiles provided.

• You will need to register for a trial code in order to use Fire
trial mode. See “Trial Mode” on page 5 for details.

• Install purchased software. Purchasing the product gives yo
create profiles and run reports on your own log files withou
You will need to supply purchase information online, via te
or by mail. NetIQ will issue you a product serial number, wh
to enable a full license for the product. See “Purchasing Fire
page 6 for details.

• Upgrade current product. If you have a previous version of 
installed on your system, use this option to install a current p
Setup will detect any previous product licenses you have, or
a product serial number during installation.

Trial Mode
If you selected the Install a free time limited trial option in th
installation panel and then completed the remaining installation
starts Firewall Suite and displays the Product Licensing dialog b



To run the product in trial mode:

1. Click Register for a Trial Serial Number. Firewall Suite opens the NetIQ 
customer service Web site.

2. Complete the Registration form, then click Submit. Your trial code is shown 
in the browser window and is sent to the email address you specify in the 
registration form.

3. Copy your trial code.

4. Return to the Product Licensing dialog box and paste the code you copied 

wizard 
next panel, 
ext start the 

owser, then 

ou have 

l number 

, without 
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into the text box provided.

5. Click Submit. Your trial mode registration is complete.

Purchasing Firewall Suite
If you selected the Install purchased software option in the first 
installation panel, but did not enter a product serial number in the 
Setup will install Firewall Suite without a serial number. When you n
product, the Product Licensing dialog box opens.

To purchase the product you downloaded:

1. Click Purchase Information. Firewall Suite starts your Web br
connects you to the NetIQ customer service Web site.

2. Complete the purchase information required at the site. When y
finished, you will receive a serial number for Firewall Suite.

3. Copy the serial number.

4. Return to the Product Licensing dialog box, then paste the seria
you copied into the text box provided.

5. Click Submit. You can now run the product under a full license
restrictions.
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Adding More Firewall Licenses
The standard software license lets you install Firewall Suite on one system and 
report on one firewall. If you want to report on more than one firewall, you 
must purchase Firewall Add-Ons. For example, if you purchased a three-
firewall Add-On, you could install Firewall Suite on one system and report on a 
total of four firewalls. You can purchase Firewall Add-Ons by contacting NetIQ 
or your reseller.
Chapter
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Chapter 2

Getting Started

r organization. 
create your first 
port. In 
sed on these 

sks:

 violations, 
 surfing habits, 

ice goes down 
cted at your 
ize alerts to 
a specific time 

ies, but these 
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This chapter tells you what capabilities Firewall Suite offers you
You will learn the components of the user interface and how to 
firewall activity report by using a sample profile to generate a re
addition, you will set up monitors and alerts and run reports ba
settings. 

Creating Firewall Reports
Firewall Suite enables you to accomplish two basic reporting ta

• Produce firewall and Web activity reports that detail security
protocol usage distribution, bandwidth usage, employee Web
incoming and outgoing traffic, FTP transfers and more. 

• Set up monitors and alerts and report on them. When a dev
or stops responding, or when a critical security event is dete
firewall, Firewall Suite can alert you to these events. Custom
notify you when the number of times an event occurs over 
period has exceeded your defined threshold.

Many other capabilities fall within these two high-level capabilit
more detailed features will be discussed in later chapters.



Producing Firewall and Web Activity Reports
Creating a firewall report requires that you:

1. Configure your firewall to produce log files that may be accessed and used 
by Firewall Suite.

2. Create a profile to define the information you want to capture in your 
report. 

3. Generate a report either on-demand or by scheduling a reporting event. 

occurring 
alyze and 
wall 
our firewall 
n on a 

tion you 

 download 
isiting 
nload 
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The following section discusses these three steps in detail.

Configuring Your Firewall
Most firewalls generate log files that contain data about the activity 
around the firewall. Firewall Suite uses these log files to capture, an
report on firewall activity; however, you need to configure your fire
properly to enable Firewall Suite to access and get the most from y
log files. The Firewall Configuration Guide provides this informatio
firewall-by-firewall basis. 

The configuration guide includes information about:

• Which versions of your firewall are supported by Firewall Suite

• Where the logs are located and how to retrieve or access them

• How to optimize your firewall log format to display the informa
want in reports

The printed guide is included with your purchase, but you may also
and view it in Adobe® Acrobat® Reader version 4.0 or greater by v
www.netiq.com\support. Make sure the cover of the guide you dow
specifies Firewall Suite.
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Understanding Firewall Log Files
Depending on which application protocols your firewall is configured to 
handle, your firewall log files may contain a variety of different information. For 
example, it could contain information about users, the protocols they used, 
what activity they generated, their system platforms, the search engine they 
used, keywords on which they searched, date and time information and more. 
To create a profile and generate a meaningful report on your firewall activity, 
you must determine which type and version of firewall you have, how the 

retrieve that log 

 service access 
not allow these 
around can be 
er for use with 

 support the 
 a consistent 
e the Firewall 

firewall log file 
lude in reports. 
ss and store log 
Chapter 2 • G

activity information is recorded in the log file, and how you can 
file.

For example, if Firewall Suite relies on FTP, HTTP, or Syslog/LEA
to retrieve log files, there will be an issue with firewalls that do 
types of access. If this issue is recognized ahead of time, a work
developed, such as making a copy of the log file on another serv
Firewall Suite.

The WebTrends Syslog Service
Many of the firewall log file formats supported by Firewall Suite
WebTrends Syslog Service, a service that gets firewall log files in
format that is usable by Firewall Suite. For more information, se
Configuration Guide.

Create a Profile
A profile is a group of settings that defines the location of your 
and the type of information you wish to capture from it and inc
Specifically, it contains the information needed to import, proce
files for analysis.



The three types of firewall and Internet activity profiles are:

• General Firewall Activity profiles. Let you produce reports on firewall and 
VPN security-related activity, including bandwidth and protocol usage, 
firewall rules, and firewall errors and warnings.

• Incoming Firewall Activity profiles. Help you analyze the Web activity 
coming through the firewall from external sources. Information in reports 
includes top requested pages; least requested pages; top paths through the 
site; and visitors by domain, geography, organization, browser, and 
operating system.

vity origi-
age by user 
ywords 

g you 
ts and text 
s in HTML. 

ting and 

 sizes—
ed. These 
 slow 

rts that you 

y reporting. 
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• Outgoing Firewall Activity profiles. Let you analyze the Web acti
nating from within your network. Reports include bandwidth us
or department, Web sites visited by IP address, search engine ke
used, and authenticated user

Generate a Report
Firewall Suite lets you tailor the appearance of your reports by lettin
choose the graphs and tables to include and the colors, fonts, layou
to use. Tables and graphs are organized under expandable categorie
See “Working with Reports” on page 201 for information on genera
customizing reports.

Reports output to multiple HTML files, which allows for smaller file
exactly how much smaller depends on the tables and graphs includ
smaller-sized files simplify printing and speed download times over
connections.

You may also use the Scheduler to automate the generation of repo
run regularly. See “Scheduling Reports” on page 241 for details.

Note
Different firewalls support different types of firewall and Web activit
For more information, see the Firewall Configuration Guide.
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Alerting and Monitoring
Firewall Suite’s Alerting and Monitoring capability lets you:

• Monitor Web-related devices and services

• Send alerts when something goes wrong with a Web-related device or 
service
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• Automatically restore Web-related devices and services whe
goes wrong

• Run reports on the status and health of Web-related devices

The Alerting and Monitoring profiles you create define the devic
you want to monitor and the type of response you want to occu
status of a monitored device or service changes.

For more information, see “Alerting and Monitoring” on page 10

Starting Firewall Suite
You can open the Main Console of Firewall Suite in any of thes

• Double-click the WebTrends Firewall Suite shortcut icon on 

• Select WebTrends Firewall Suite > WebTrends Firewall S
Start > Programs menu on your desktop

• Double-click �	������������� from the program group in t
Firewall Suite installation directory



The Main Console
The Main Console of Firewall Suite is the first window you see after starting the 
software. It contains five main areas:

• Profile Description list. Lists existing profiles, including sample profiles.

• Tasks area. Initiates common tasks such as profile creation and event sched-
uling.

• Functions area. Scheduler, Options, Feedback, and Help

ctivity, etc.
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• Main menu. File, Edit, etc.

• Profile Type tabs. General Firewall Activity, Outgoing Firewall A
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The following figure shows the Main Console of Firewall Suite.
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Profile Description List
Click one of the four Profile Type tabs: General Firewall Activity
Firewall Activity, Incoming Firewall Activity or Alerting & Monit
tab, you see a list of the profiles available for running reports. T
sample profiles for each profile type, and if you already created
earlier version of Firewall Suite, these are automatically placed i
Category folder of the appropriate profile type. 



The list contains folders, called categories, containing profiles. Each profile has 
an associated Profile Description column and other columns, depending on the 
selected profile type. Click any column heading to sort the list in alphabetically 
and numerically descending order (A, B, C... and 1, 2, 3...) according to the 
heading clicked.

For example, if you click the Incoming Firewall Activity tab, you will see the 
Profile Description called “Sample - Incoming” in the Default Category folder 
along with any other previously created Incoming Firewall Activity profiles. 
Beyond sorting the list of Profile Descriptions, there are other tasks you can 
perform on the Profile Description list.

 Profile 
.

ns dialog 
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tall Firewall 
lt Category. 
.
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Hiding or Showing Columns
When a profile description is so long that it can’t display fully in the
Description column, you can hide the other columns to make room

To hide or show columns:

1. Choose Select Columns from the View menu. The Select Colum
box displays.

2. Select a column check box to display the column, or clear the ch
hide the column. The Profile Description column cannot be hid

3. Click OK.

Organizing Profiles into Category Folders
You can organize your profiles using category folders. When you ins
Suite, the only category you have for each profile type is the Defau
You can create, rename and delete these category folders as needed

To create a new category:

1. Select Category from the File menu.

2. Type the new Category name and click OK.
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To rename a category:

1. Select the category to rename.

2. Select Rename from the File menu.

3. Type the new Category name and click OK.

To delete a category:
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1. Select the category to delete.

2. Select Delete from the Edit menu.

3. Type the new Category name and click OK.

Tasks Area
The tasks area, located along the left side of the Main Console, 
features needed to manage, schedule an event for and generate
selected profile. 

• Schedule Event. Click this to open the Scheduler and the Ne
Event - Analysis wizard. The Scheduler displays profile repo
been set up to run automatically. You can edit existing sche
this window, or schedule automated events for additional p

• New Profile. Click this to open the New Profile wizard and c
profile in the selected profile type and category folder.

• Edit Profile. Click this to display a dialog box in which you 
changes to the selected profile.

• Delete Profile. Click this to delete the selected profile.

• Reports. Click this to open a list of available, pre-defined rep
selected profile type. You can add, edit, rename or delete th
reports within this dialog box and you can choose what out
which to create the report: HTML, Microsoft Word, Microsof
delimited text, or text. You can also select a report and view
generated version of it or generate a report on-demand.



Main Menu
The Main menu contains the following items:

File Menu
• Generate Report. Accomplishes the same functionality as mentioned for 

Reports in the “Tasks Area” on page 17.

• New Profile. Accomplishes the same functionality as mentioned for New 
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 report style 
s added to 
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 processes, 
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Profile in the “Tasks Area” on page 17.

• New Category. Lets you create a new category folder in the sele
Type and/or selected category folder by opening the Category N
box.

• New Report. Opens up the New Report wizard, in which you de
report range, report format, location at which to save the report,
and report content for a new report template. This template get
the list of available reports, and may be used with an appropria

• Rename. Lets you rename the selected category folder or profile

• Schedule Event for Profile. Accomplishes the same functionality 
mentioned for Schedule Event in the “Tasks Area” on page 17.

• Open File/Saved Report. Lets you open an existing report throug
Windows Explorer-like interface.

• Close. Closes the program window, but the application continue
including any scheduled reports and real-time analysis.

• Exit and Unload. Shuts down the application and any automated
including the Scheduler and real-time analysis.

Notes
Many Main Menu tasks are also available through right-click functio
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Edit Menu
• Profile. Accomplishes the same functionality as mentioned for Edit Profile in 

the “Tasks Area” on page 17.

• Cut. Allows you to cut a profile or category folder, which can later be 
pasted in another folder or directly under the root of the Profile Descrip-
tions list.

• Copy. Allows you to copy a profile, which you can rename and edit as 

is useful if you 
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needed.

• Paste. Lets you paste a profile that was previously cut. This 
want to move a profile from one folder to another within th
Description list.

• Delete. Accomplishes the same functionality as mentioned fo
in the “Tasks Area” on page 17.

View Menu
• Collapse All Categories. Collapses category folders to show j

not the profiles contained within them.

• Expand All Categories. Expands all category folders so that y
profiles in each.

• Select Columns. Lets you choose which columns to hide or s
Profile Description list.

• Align Columns. Adjusts columns to show the maximum amo
mation possible per column.

• Auto Refresh Profile List. Updates the profiles list with the m
information.

• Print Profile List. Prints the list of profiles as it appears on-scr
or collapsed).



Tools Menu
• Scheduler. Opens the Event Scheduler main console.

• Style Editor. Opens the Style wizard, which lets you change the style of a 
selected available report style, or lets you create a new report style and add 
it to the list of available report styles. The Style Editor lets you change the 
colors, fonts, descriptive text, graph appearances and more for the reports 
you generate.

• FastTrends Maintenance. Lets you manage the contents of the FastTrends 
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database associated with a given profile.

• URL Categorization (Outgoing Firewall Activity profiles only). O
URL Categorization Databases dialog box, which lets you registe
the SurfControl databases available for use with Firewall Suite. U
databases to track Web surfing activity of inappropriate Web co

• Status of LEA Connections. Lets you check the status of connect
between the WebTrends LEA Service and a Check Point Manage
Server.

• Limit Memory Usage. Lets you to limit the number of elements in
specific section of a report to reduce memory consumption.

• Department Management. Lets you create, edit or delete departm
addresses. This feature allows you to later report on the activity
specific department, or to break down activity by departments.

• Options. Opens the Options dialog box, which controls global o
well as options that affect only the Firewall Activity or the Alert
Monitoring module.
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Links Menu
• GeoTrends Information. Links you to a Web page from which you may 

download GeoTrends, an optional, free database that provides location 
information about Web visitors and companies for your reports.

• Customer Feedback. Opens a Web page in which you may enter your 
comments about NetIQ’s WebTrends brand of products.

• Contact Technical Support. Links you to the technical support page, in 
t Firewall Suite.
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which you may enter any technical questions you have abou

• Frequently Asked Questions. Links to a page of the question
commonly encountered by technical support.

• Purchase Technical Support. Opens a page on which you ca
and compare our three technical support packages. 

• Purchase Additional Licenses. Links to a page from which yo
additional licenses for Firewall Suite. You may also use the c
mation to order from a WebTrends sales representative or re

Help Menu
• Contents. Opens the Firewall Suite online Help.

• Add Serial Numbers. Opens the dialog box in which you ma
serial number for a Maintenance Subscription or a Server Ad

• Check for Product Updates. Runs a utility that lets you know 
Suite version is most current available version. You must ha
your product for this utility to provide accurate information.

• View Release Notes. Opens the latest copy of the product Re

• View Product License. Displays the license agreement you a
you installed Firewall Suite.

• About. Displays information such as Firewall Suite Version n
number of Firewall Add-Ons and more.



Functions Area
The Functions area contains the following items:

• Scheduler. Opens the Event Scheduler.

• Options. Opens the Options dialog box

• Feedback. Links to the Customer Feedback page (see “Links Menu” on 
page 21).

• Help. Opens the Firewall Suite online Help.
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Profile Type Tabs
The Profile Type tabs include:

• General Firewall Activity. Report on security related issues inclu
activity, FTP transfers, and Telnet connections. You can also trac
bandwidth usage and VPN activity. Identify large data transfers,
connection attempts by IP, the source that triggered firewall rule
suspicious activity.

• Outgoing Firewall Activity. Pinpoint where the employees in yo
zation are going on the Internet and how much time they’re spen
You can report on all the IP addresses to perform an organization
or focus on just one IP address to report on an individual’s activ

• Incoming Firewall Activity. If your Web server is behind your fi
Incoming Web Activity profiles to report on traffic coming into y
site, including the volume of activity on your site, where users a
from, and what pages interest them most.

• Alerting & Monitoring. Monitor any networked or Internet-conne
or service and receive alerts whenever a device goes down or a
actions to take when specific events occur.
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Reports Using a Sample Profile
In this section, you will use a sample profile included with the installation to 
create a report. Use the sample Incoming Firewall Activity profile called 
“Sample – Incoming”.

To create a report using the Sample – Incoming profile:

1. From the Main Console, click the Incoming Firewall Activity tab.

the Main menu. 
.

file dialog box 
 also modify 

 about each 
.

anges.
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2. Select the profile called “Sample – Incoming”. 

3. Review the profile’s settings by clicking Edit > Profile from 
The Edit Incoming Firewall Activity Profile dialog box opens

4. Select any tab within the Edit Incoming Firewall Activity Pro
to review the profile settings for the individual tabs. You can
profile settings within this dialog box. For more information
setting in this dialog box, see “Firewall Profiles” on page 27

5. Click Cancel to close the dialog box without making any ch



6. Reselect the sample profile from the Profile Description list.

7. Generate a report for this profile by clicking File > Generate Report from 
the Main menu. The Reports dialog box opens.

 opens.

 For 
rofile in the 
onality to:
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For this example, just use the default settings for the report.

8. Click Start to generate the report. The report compiles and then

Using Shortcuts
Firewall Suite includes a number navigational shortcuts.

Many Main Menu tasks are also available from the right-click menu.
example, to view a list of menu selections for a profile, select the p
Profile Description list and right-click. You can use right-click functi

• Create a new category, profile, scheduled event or report.

• Edit a selected profile
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• Generate a report

• Manage profiles.

• Collapse, expand, select, and align the columns in the Profile Description 
list.

• Print and refresh the profile list.

• Close or exit and unload the Firewall Suite application and its services.
Chapter 2 • G

In the Reports window, you can use right-click functionality to:

• Create, edit, rename, delete, start and format a report

• View a previously generated report

• Align and select columns

• Print a list of available reports



26     User Guide
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Chapter 3

Firewall Profiles
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This chapter explains the various settings available for creating 
Web activity profiles. Firewall Suite produces a report on the da
firewall or proxy server log files according to how these settings 
Profile settings specify:

• The hardware configuration of your firewall, which includes
proxy server and the computers behind your firewall.

• The location, format, and method for retrieving the log file d

• The information from the log file you want to include in a r

• The storage of log file analysis for future use.

Tables referenced in this chapter are included at the end of the 

Alerting and Monitoring profiles use different settings. They are
“Alerting and Monitoring” on page 103.

Notes
You may need to configure your firewall or proxy server before
firewall or Web activity profile. For more information, see the F
Configuration Guide. 



Profile Types
The tabs in the Main Console correspond to the types of profiles you can 
create. These include:

• General Firewall Activity. Use these profiles to report on security-related 
issues, such as failed connection attempts by IP, firewall rules that were 
triggered, firewall warnings and errors and other suspicious activity. You 
can also track bandwidth usage, email activity, FTP transfers and Telnet 
connections.
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• Outgoing Firewall Activity. Use these profiles to determine an
reports on employee Internet surfing habits. In addition, these p
you report on all the IP addresses for an organization, or focus 
IP address to report on an individual’s activity.

• Incoming Firewall Activity. If your Web server is behind you
use these profiles to report on traffic coming into your Web site
outside, including the volume of activity on your site, where us
coming from and what pages interest them most.

Viewing a Sample Profile
Firewall profiles have numerous settings. Before creating a profile f
time, it may be helpful to look at the settings for some of the sampl
activity profiles included in your Firewall Suite installation.

• Sample - General, a General Firewall Activity profile for a firewa
single computer. 

• Sample - General - Cluster, a General Firewall Activity profile fo
configuration spread across multiple computers.

• Sample - Outgoing, an Outgoing Firewall Activity profile or a fir
single computer.

• Sample - Incoming, an Incoming Firewall Activity profile for a fi
single computer.
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To view a sample profile:

1. On the Main Console, select any of the three firewall activity tabs, General 
Firewall Activity, Outgoing Firewall Activity or Incoming Firewall 
Activity.

2. Select the profile that you wish to view from the Profile Description list.

3. From the Edit menu, click Profile. The Edit Firewall Profile dialog box 
opens. Use this dialog box to review or make changes to the selected 

ith each 
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profile’s settings by selecting the individual tabs associated w
profile.



Choosing a Firewall Profile Type
You need two pieces of information when deciding which of the three Firewall 
profile types to use to create the report you want.

• The profile types supported by your firewall or proxy server.

see 

ee “Report 
an be 
 the profile 

Note
Some firewalls and proxy servers do not support all the capabilities 
available with Firewall Suite. For more information about your firewall or 
proxy server, see the Firewall Configuration Guide.
30     User Guide

For detailed information on designing Firewall Activity profiles, 
“Designing Firewall Profiles” on page 99.

• The log file information that you want to include in the report. S
Content” on page 99 for more information about what content c
included in a report, how that information can be reported, and
type you should use to generate the report.
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Creating a Firewall Profile
This procedure describes the sequence of panels in the New Profile wizard for 
creating a firewall profile. It describes the information required in each panel to 
set up a firewall profile. Refer to the online help in each panel for more 
information. 

To create a new firewall profile using the New Profile wizard:

 Main Console. 
and the type of 

he New Profile 
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1. Select a firewall profile type from the profile type tabs on the
Make your decision based on the type of firewall you have, 
information on which you wish to report.

2. From the File menu or the Tasks area select New Profile. T
wizard opens to the Firewall Configuration dialog box.



Firewall Configuration Dialog Box
The Firewall Configuration dialog box lets you specify whether your firewall is 
on one computer or distributed across multiple computers. A firewall or 
firewalls may be spread across multiple computers to distribute the work load 
for sites that experience high traffic volumes.
32     User Guide
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To specify your firewall configuration:

1. Choose one of the following two options depending on your circumstances:

− If your firewall resides on one computer, select My firewall is on 
one physical machine.

− If your firewall resides on multiple computers, select My firewall 
is on multiple machines.

, the Title, Log 
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2. Click Next. Depending on the selection you made in Step 1
File Format or the List of Servers dialog box opens. The nex
instructions will continue with creating a profile for a firewa
computer. 

3. To continue creating a profile for a firewall on multiple com
of Servers Dialog Box” on page 40.



Title, Log File Format Dialog Box
If your firewall is on a single computer, use the Title, Log File Format dialog 
box to name the profile and specify the log file format and path. You also have 
the opportunity to use the built-in WebTrends Syslog Service, a Windows 
service that makes firewall log files accessible by converting them into a 
consistent log file format. For more information about the WebTrends Syslog 
Service, see “About the WebTrends Syslog Service” on page 37. 
34     User Guide
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To specify the profile log file settings for a firewall on a single computer:

1. In the Description text box, enter the name you wish to call your profile.

2. In the Logs were generated in this Time Zone dropdown list, select the 
time zone, in comparison to Greenwich Mean time (GMT), in which the log 
files are generated. For example, if your firewall is located in the Pacific 
Time Zone, select GMT -08:00 because this zone is eight hours behind 
Greenwich Mean Time.
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3. In the Reports will be generated for this Time Zone dro
select the time zone for which reports for this profile will be
example, while you may work in the Pacific Time Zone, the
generate may be destined for your Paris offices. Because Pa
ahead of GMT, select GMT +01:00.

4. In the Log File Format area, which lists the firewalls suppo
selected Profile Type tab, select the firewall type and the fo
firewall’s log files. 

5. If you selected a Check Point firewall with OPSEC LEA,
Point LEA Instructions” on page 36.

6. If you are using any other firewall or log file format, c
the following steps.

Note
The options and fields available in the lower half of the dial
depending on the format you select.



7. If you want to use logs that are accessible by the Firewall Suite 
computer:

a. Select The log files are already in a location accessible by this 
machine. 

b. Select the firewall log file retrieval method from the dropdown list in the 
Log File Path area. For firewalls on a single computer, Firewall Suite 
supports ����
���, �	�
�� or �		�
��. For more information on 
selecting the appropriate retrieval method, see “Log File Retrieval 
Methods” on page 38.
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c. Enter or browse to the location of your log file in the text b
right of the log retrieval method. For more information on u
Firewall Suite’s browse features, see “Specifying a Single Log
page 82 and “Specifying Multiple Log Files” on page 82.

8.  If you want to use the WebTrends Syslog Service to collect your f
files, use the following steps:

a. Enter the IP address of your firewall in the Firewall IP Add
box.

b. Enter or browse to the location in which the WebTrends Sys
should save the collected log files in the Save Log Files To 

Check Point LEA Instructions
If you selected Check Point LEA, you must choose a Check Point O
connection to collect the data. Check Point LEA Connections are co
using the LEA Connection options under General Firewall Activity O
Before you can configure a LEA connection, you must configure yo
Point firewall to work with OPSEC LEA.  For more information,see t
Configuration Guide.
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If you are using a Check Point firewall with OPSEC LEA:

1. Make sure you selected the correct Check Point firewall type from the Log 
File Format list.

2. If no connections have been configured, click Create or Manage 
Connections to open the Manage Connections dialog box, and follow the 
instructions for creating a new OPSEC LEA connection on page “LEA 
Connections Dialog Box” on page 334.
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3. If one or more connections have been configured, selec
from the list.

About the WebTrends Syslog Service
Your firewall must be configured to use the WebTrends Syslog S
the Firewall Configuration Guide for information about configu
firewall.

To make firewall log files accessible in a consistent log file form
daemon of the WebTrends Syslog Service collects firewall log da
firewall. The daemon then writes a log file in a usable format to
on the computer running Firewall Suite. The log files created by
Syslog Service are stored locally on the computer running Firew
log files created by the firewall remain there.

Note
Because the WebTrends Syslog Service runs as a Windows servi
run Firewall Suite on a Windows NT, Windows 2000, or Window
and you must have administrator rights to configure Firewall Su
Windows service.



The WebTrends Syslog Service standardizes the prefix of the firewall log 
records. In the following example, the part of the firewall record that is 
formatted by WebTrends Syslog Service appears in bold:

���������	
���
��
�����������������
�����������������������
����������������������� !"�������������
	�#���	�$�
��	%������

By default, the WebTrends Syslog Service is bound to the IP address on the 
computer running Firewall Suite where it writes log data. If the computer 
running Firewall Suite has more than one IP address, WebTrends Syslog Service 
binds to all IP addresses by default. We recommend that you do not bind the 

ecessary. 
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WebTrends Syslog Service to a single IP address unless absolutely n

You can select the frequency with which log files are rotated in the
dialog box of the General Firewall Activity section of the Options w
files are rotated when the current log file is archived and a new log

Because the WebTrends Syslog Service collects data in real time, up-
are available for reporting. If the WebTrends Syslog Service is not ru
however, any log data generated is lost. 

When you create a profile that uses the WebTrends Syslog Service, t
configured to start whenever the computer running Firewall Suite is 
WebTrends Syslog Service will continue to run as long as the comp
running.

Log File Retrieval Methods
Firewall Suite supports the following retrieval methods:

• file:/// (file retrieval). Select this option if you have a drive map
firewall server. You can identify single, multiple, and compressed
one of three ways:

− Type the complete log file path in the Log File URL Path te

To specify multiple log files, use wildcards or use a vertical 
between log file path names. For more information, see “Spe
Paths” on page 351.

− Click Normal Browse to browse to the location of a single
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− Click Extended Browse to open the Selected Logfiles dialog box and 
specify multiple log files. See “Specifying a Single Log File” on page 82 
and “Specifying Multiple Log Files” on page 82 for instructions and 
examples.

• ftp:// (FTP retrieval). Select this option to retrieve your log file using FTP. 

a. Type the path and file name in the Log File URL Path text box, or click 
Browse to navigate to the log file location.When you specify an FTP 
URL, you must type the full path from the root of the FTP server.
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b. Type your user name and password for the FTP site. 

• http:// (HTTP retrieval). Select this option to retrieve your W
file over the Internet using HTTP.

a. Type the path and file name in the Log File URL Path t

b. If you are accessing a secure Web site, type the user nam
password information. This is usually not required to ac
server.

See “Specifying a Single Log File” on page 82 and “Spec
Log Files” on page 82 for detailed instructions on using 
features associated with each log retrieval method. 

Note
ftp and http retrieval are only available for firewalls that use sin
Clustered servers are assumed to have log files aggregated and 
single file location.



List of Servers Dialog Box 
The settings in the List of Servers dialog box parallel the Title, Log File Format 
dialog box for firewalls on single servers, only they pertain to firewall 
configurations that have firewalls and log files on multiple servers. This may 
occur when network traffic is heavy, and firewalls need to spread the workload 
to multiple computers.
40     User Guide



ewall Profiles     41

To specify the profile log file settings for a firewall on multiple 
computers:

1. In the Description text box, type the name you wish to call your profile.

2. In the Logs originate in Time Zone GMT dropdown list, select the time 
zone, in comparison to Greenwich Mean time (GMT), in which the log files 
are generated. For example, if your firewall is located in the Pacific Time 
Zone, this setting is eight hours behind Greenwich Mean Time, so you 
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would select GMT -08:00.

3. In the Report in GMT dropdown list, select the time zone fo
for this profile will be generated. For example, while you m
Pacific Time Zone, the reports you generate may be destined
offices, which is one hour ahead of GMT. Therefore, select 

4. In the Log File Format area, which lists the firewalls suppo
selected Profile Type tab, select the firewall and log file type
firewall configuration. 

5. Click New, to add a server and the path to a log file or files
The Firewall Name and Log File Path dialog box opens.

6. In the Firewall Name text box, type the name for your fire



7. In the Log File Path text box, either type or browse to the location of the 
log file(s) for that firewall.

8. Click OK to return to the List of Servers dialog box. The new server and 
path is added to the Servers list.

x opens.

 from the 

Note
Use wildcards (') in log file names to process multiple log files in one 
report. You can also specify compressed log files such as zip or gzip.
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9. Click Next. The IPs Behind Firewalls dialog box opens.

Editing the Server List
To edit a server in the list:

1. In the Server list, select the server you wish to edit.

2. Click Edit. The Firewall Name and Log File URL Path dialog bo

3. Edit the server settings as needed and click OK.

Deleting a Server from the List
To delete a server from the list:

1. In the Server list, select the server you wish to delete.

2. Click Delete. A confirmation message displays.

3. Click Yes to confirm the deletion. The selected server is deleted
list.
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IPs Behind Firewall Dialog Box
The IPs Behind Firewall dialog box allows you to specify the IP addresses or 
domains of computers located behind your firewall. The information in this 
dialog box tells Firewall Suite which computers are behind your firewall so it 
can distinguish between activity that originates inside the firewall (in other 
words, from within your organization) and activity that originates outside.
Chapter 3 • Fir



Adding an IP Address
To add an IP address to the list:

1. Enter an IP address or domain name in the text box above the Add button. 

he list:

Note
You can use wildcards (') to specify a group of IP addresses or domain 
names. For example, type ��������' to indicate that all addresses that 
begin with �������� are behind the firewall. Type the domain name 
'���(	��������# to add all computers on the ��(	��������# domain to the 
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2. Click Add. The contents of the text box are added to the list.

3. Click Next. The DNS Lookup dialog box opens.

Removing an IP Address
To remove an IP address or domain name from the list:

1. Select an IP address or domain name in the list.

2. Click Remove. The selected item is deleted from the list.

Selecting or De-selecting an IP Address
To select or de-select all IP addresses or domain names from t

• Click Select All to select all items in the list

• Click Un-select All to deselect any selected items in the list.

list. Adding  '���(	��������#�includes all computers on 
��	��������(	��������# and ������(	��������#.
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Internet Resolution Dialog Box
DNS lookup is the process of translating numeric IP addresses into domain 
names. Most users consider domain names more useful for analysis and reports 
than IP addresses; however, IP resolution can be a slow process, and for this 
reason, you may choose to not use this capability.

In general, DNS lookups are performed more efficiently by the firewall or proxy 
 Firewall Suite. 
or your 
it for you.
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server as the log is created, rather than during log file analysis by
If your firewall or proxy server does not perform DNS lookups 
administrator has disabled that capability, Firewall Suite can do 



The Internet Resolution dialog box allows you to choose whether or not to 
perform DNS lookup for the current profile. Resolving IP addresses into domain 
names takes a large amount of processing power the first time, but once 
resolution has occurred, the results are stored in a profile-specific DNS cache 
that is readily and quickly accessed for future analyses with the profile. 

e, you may 

Note
If multiple profiles refer to the same IP address, they may all share the same 
DNS cache rather than perform the same DNS resolution for each profile.
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Specifying Settings for DNS Lookup
Depending on the Resolution mode and/or cache settings you choos
be required to fill in or choose additional settings.
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To specify settings for DNS lookup:

1.  In the Domain Name/IP Resolution Mode dropdown list, select one of 
the following options:

− Quick mode. Uses the format from the log file. In this mode, Firewall 
Suite does not perform DNS lookups, but maintains the address in its 
original state in the log file. This is the fastest method for creating 
reports. If you select this mode, Cache Control is grayed out in the 

sses. Select this 
okups and you 

know whether 
 you want 
Suite examines 
IP address, it 
ontains a 
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dialog box.

− Resolve mode. Does a lookup for all numeric IP addre
option if your firewall or proxy does not perform DNS lo
need geographic or other domain-related information.

− Auto mode. This is the best method to use if you don’t 
you log file contains IP addresses or domain names, but
domain names in your analyses. In Auto mode, Firewall 
the first record in the log. If the first record contains an 
attempts to translate all IP addresses. If the first record c
domain name, it turns on Quick mode.



2. In the Cache Control area, select how and where you want the results of 
the IP address resolution to be stored. Cache Control settings allow you to 
load the DNS cache in the Firewall Suite default location and/or store it in a 
custom location of your choice. Choose one of the following two options:

− Load DNS cache in memory. Places the DNS cache in a profile-
specific default location. The DNS cache is made up of two files, 
dnscache.din and dnscache.dtx. The default storage location uses the 
profile’s file name when creating the storage path for these two files. 
For example, with the profile:

���������

�������	�

he files in a 

. 

s.

resolved or 
p is 
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����������	��	#���������)	������	����������������

the DNS cache files are:

����������	��	#���������)	������	��������������������

����������	��	#���������)	������	��������������������

− Store DNS Cache in custom location. Places the DNS cac
location of your choice. Type or browse to the location.

3. Click Next. If this profile is for:

− General Firewall Activity, the Filters dialog box opens.

− Outgoing Firewall Activity, the Categories dialog box opens

− Incoming Firewall Activity, the Home Page dialog box open

Clearing the DNS Cache
You can clear the DNS cache for the current profile to dispose of un
out-dated entries. The cache repopulates when the next DNS looku
performed.

To clear the DNS cache:

Click the Flush DNS Cache button.
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Sharing the DNS Cache
You can share a DNS cache among multiple profiles by choosing the Storing 
the DNS cache in custom location option, and pointing each profile to that 
custom location.
Chapter 3 • Fir



URL Categorization
With Outgoing Firewall Activity profiles, Firewall Suite provides access to 
databases from SurfControl. These databases list Internet URLs that may expose 
the organization to legal liability, detract from employee productivity, or waste 
bandwidth. Firewall Suite uses a modifiable����� file to map these Internet 
URLs to categories such as Hate Speech or General News. The software can 
then track and report on the categories of Internet content that individuals in 
your organization access to ensure that employees do not visit inappropriate 
Web sites.

engine that 
ownloaded 
files with 
ization. 

added, you 
rrent list of 
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The Firewall Suite software includes the SurfControl categorization 
licenses and accesses the categorization databases. Once you have d
the databases and activated URL Categorization, you can create pro
filters to track the scope and nature of Internet usage in your organ

Because Web sites change and new Web sites are continually being 
can update the database periodically to obtain access to the most cu
sites.



ewall Profiles     51

Use the Categories dialog box to enable categorization and assign either the 
default category mapping, or a custom mapping you have created. 
Chapter 3 • Fir



Choosing Settings for Categories
To choose settings for Categories:

1. In the Categories dialog box, click Categorize web activity to enable URL 
categorization.

2. In the Category Mappings dropdown list, select the type of category 
mapping you wish to use. 

3. Click Next. The Filters dialog box opens.

Core 
 may result 
 a General 
yee 

tegories 
gory types, 
information 
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Category Types
The Firewall Suite installation includes a Core Categories database. 
Categories include Web sites that contain objectionable content that
in liability issues. You can purchase a separate license to download
categories database that contains content believed to reduce emplo
productivity.

Note
You can create your own categories by assigning the existing ca
new names and associating them with one of the two major cate
Core or General. See “Mapping URL Categories” on page 57 for 
about creating your own category names.
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Core Categories
The Core categories database includes URLs of Web sites with the following 
types of content:

• ·Adult/Sexually Explicit
• Criminal Skills
• Drugs, Alcohol & Tobacco
• Gambling
Chapter 3 • Fir

• Hacking
• Hate Speech
• Violence
• Weapons



General Categories
Firewall Suite’s General Categories database contains the following additional 
categories of URLs that, while not objectionable, reduce employee productivity:

• Advertisements
• Arts & Entertainment
• Chat
• Computing & Internet
• Education
• Finance & Investment
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• Food & Drink
• Games
• Glamour & Intimate Apparel
• Government & Politics
• Health & Medicine
• Hobbies & Recreation
• Hosting Sites
• Job Search & Career Development
• Kids Sites
• Lifestyle & Culture
• Motor Vehicles
• News
• Personals & Dating
• Photo Searches
• Real Estate
• Reference
• Religion
• Remote Proxies
• Search Engines
• Shopping
• Sports
• Streaming Media
• Travel
• Usenet News
• Web-based Email
• Sex Education
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Updating the URL Categorization Database
Because the database is frequently updated to provide more relevant reports, 
use the URL Categorization Database dialog box to check the status of your 
database and update it when necessary. A good rule of thumb is to update the 
database monthly.

Categorization  

t the bottom of 
base is up to 

Categorization  

ox opens.

osted by that 
ss may host 

the news site, 
xplicit site. You 
 IP addresses.

Note
If you are accessing the Internet through a proxy server, you must provide your 

See “Proxy 
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To determine whether your database needs updating:

1. Select URL Categorization from the Tools menu. The URL 
dialog box opens.

2. Review the information in the Database Information area a
the dialog box. The Status tells you whether or not the data
date.

To  update your database:

1. Select URL Categorization from the Tools menu. The URL 
dialog box opens.

2. Click Update Database. The Update URL Database dialog b

3. Click Get Update.

Incorrect Categorization of IP Addresses
When a single IP address hosts multiple sites, visits to any site h
address can be mis-categorized. For example, the same IP addre
both a sexually explicit site and a news site. If a person visited 
reports may incorrectly categorize the visit as one to a sexually e
can avoid this problem of mis-categorization by not categorizing

proxy connection settings before you can update the database. 
Server Settings” on page 59.



To disable categorization of IP addresses:

1. Select URL Categorization from the Tools menu. The URL Categorization 
Databases dialog box opens.

2. Select the Do not categorize IPs check box.

System Performance and URL Categorization
URL categorization will categorize all file types unless you specify otherwise. In 

 you 
with ��	#, 
log box by 
. 

 system 
ry file. 

gorization  

ll Firewall 
. 
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most cases, you only need to categorize document file types, which
specified in the File Types dialog box. These typically include files 
��	#�, ����, �	�	, and similar extensions. Access the File Types dia
clicking Tools > Options> General Firewall Activity > File Types

By only categorizing document file types, you significantly improve
performance because Firewall Suite does not have to categorize eve

To improve system performance for URL categorization:

1. Select URL Categorization from the Tools menu. The URL Cate
dialog box opens.

2. Select the Only categorize documents check box.

Licensing the URL Categorization Database
When you install Firewall Suite, you install a sample database. A fu
Suite license lets you update the database as many times as you like



ewall Profiles     57

Mapping URL Categories
You can create new mappings for your standard URL categories to create URL 
categories that help your reports answer the questions you need to answer. For 
example, to see whether employee Web surfing activity is for work-related or 
non-work-related purposes, you can use the pre-defined Work Mappings 
setting, which assigns the pre-defined categories to either the Work-Related or 
Non-Work-Related mapping. Individual categories such as Sexually Explicit or 
Hate are not shown, but visits to these categories are shown under the mapped 

y Core or 
gorization 
gories graph 
le and a 

 Entertainment, 
t are more 

 is located in 
pty, no 

” on page 53 
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categories. 

Each category is made up of two elements:

• Category Type. Core or General. Reports are broken down b
General categories. For example, among the many URL cate
reports possible, you can generate a Most Popular Core Cate
and table, a Users Visiting Most Popular Core Categories tab
General Categories Visited by Most Active Users table.

• Category Name. For example, Sexually Explicit, Hate Speech,
General News. These names can be changed into names tha
meaningful for the user’s or organization’s reports.

Category mappings are defined in the 
����	#������ file, which
the f����������	��	#���������*�()
	directory. If this file is em
mappings are available in the Category Mappings list. 

Note
For a complete list of Category Names, see “Core Categories
and “General Categories” on page 54.



An Example of Mapped Categories
Firewall Suite includes one preconfigured alternate mapping called Work 
Mappings, which can be selected from the Category Mappings dropdown list. 
View this mapping by navigating to and opening the 
����	#������ file from 
the above location. Firewall Suite includes one pre-defined category mapping, 
Work Mappings. By default, this mapping maps all SurfControl categories to the 
category type "General" and the category "Non Work Related."  You can modify 
this mapping in the 
����	#�������file to change the way it maps categories. 

be a 
it at the top 
he order of 
Mappings 

 the Work 

�0�	�.��%�

e of the 
ill not be 

f this is 

e 
58     User Guide

Remapping Syntax
Add new mappings to the  !"��	#������ file. Each mapping must 
separate block of code from any other mapping code. You can add 
of the����� text file or at the very end of any text in the ���� file. T
the mappings in the .ini file determines their order in the Category 
dialog box. 

Each new mapping must have a new mapping name. For example,
Mappings settings are initiated by the mapping heading:

+*��,�-�����.�/

Category type and name changes can be assigned as follows:

0�	�.��%�1%��2�0�	�.��%�3�#��4�3���0�	�.��%�3�#�2�!�����.���
1%��

or

0�	�.��%�1%��2�0�	�.��%�3�#��4�3���0�	�.��%�3�#�

The order of Category Type and Name are reversed on the right sid
equals sign in syntax example 1. In example 2, the Category Type w
reassigned, only the Category Name will be changed--an example o
shown in the 

5������2�0��	�4�3���*��,�!���	���

mapping on the second line of the sample mapping excerpt from th
 !"��	#�������file. 
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Reporting with URL Categorization
The reports that you generate can include tables and graphs showing the most 
active authenticated users, non-authenticated users, and host names or IP 
addresses connecting to the proxy server. Of the categorized sites most visited, 
you can list the number of users that visit a site; the names of the categories of 
visited sites; the number of hits on each site; the number of user sessions; the 
amount of time visitors spent at a site; and the amount of data (in KB) that was 
downloaded

ites, or you can 
appings. For 
vity, see “Filters 
 “Category” on 
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figure menu or 

d type the 

TTP access 
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You can generate a report for all activity related to categorized s
create filters to limit reports to specific categories or category m
instruction on including or excluding categories of outgoing acti
Dialog Box” on page 66, “Working with Filters” on page 160, and
page 169.

Proxy Server Settings
If you connect to the Internet via a proxy server, you will need t
proxy connection settings in order to update the database.

To provide your proxy connection settings:

1. On the Main Console, select Tools > Options from the Con
click Options in the Functions area.

2. Click Main Options.

3. Select the Access to Internet option.

4. Select the Connect through a Proxy Server check box an
address of the proxy server and the port. 

5. Choose one of the following options:

− If your access requires authentication, select the H
requires a User Name/Password and type the user na
password for your proxy server.



− If your access does not require authentication, clear the check 
box.

6.  Click OK.

Category Names
The Category Mappings choice selected in the URL Categorization Databases 
dialog box determines which Category Names are available for the selected 
profile. You can see which Category Names are available from the Include Filter 

ivity, see 
 and 

e Filters 

check box 
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and Exclude Filter dialog boxes. 

For instruction on including or excluding categories of outgoing act
“Filters Dialog Box” on page 66, “Working with Filters” on page 160
“Category” on page 169.

To view the category names available for a selected profile:

1. While editing an existing profile or creating a new one, open th
dialog box.

2. Either edit an existing filter or create a new one

3. Select Include/Exclude activity based upon. 

4. Choose one of the following:

− If you are editing an existing filter, select the Category 
and select the Category tab.
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− If you are creating a new filter, click Next. The Category dialog box 
opens.

5. Click Examples to see a list of available Category Names available for using 
with category filters.

terpreted 
al litigious 
that require 
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 Interpreting Categorization Reports
The categorization feature is powerful, and the reports, when in
properly, can point to Web abuse and possibly head off potenti
issues. However, there are some aspects to Internet technology 
caution when interpreting categorization reports. 



Some Internet providers and Web hosting services host several Web sites on a 
single server. These Web sites are referred to as virtual Web sites. For such sites 
there are at least two host names: the host name of the virtual Web site itself 
and the host name of the server. The host name used for URL Categorization 
depends on how your firewall or proxy server records this information. If both 
are recorded, the virtual host name is categorized and the server host name is 
understood to belong to that category. This may mean that a server computer 
can trigger a “core category” ranking because it hosts a virtual Web site that is 
registered as objectionable. Thus, a visit to an innocuous site on that server will 
also trigger the “core category” ranking.

otally 
 
nable. This 

s hitting the 
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Ads or other embedded objects on a page may be served up by a t
different site from the page itself. The page may be registered as an
objectionable site when it is the site serving up the ad that is objectio
is complicated when ads come from sites on virtual servers.

With page title retrieval turned on, the analyzing host may register a
objectionable sites found by the analysis.

To maximize the usefulness of the information in reports, look care
KB transferred, at the number of hits, and of course, visit pages to j
content for yourself.

Before any action is taken to warn an employee about potential mi
highly recommended that the URLs in question be double-checked 
content and appropriateness. 

Note
The table “Core Categories Visited by Active Users” can be misinter
does not list the top offenders of the Core Categories, but rather list
breakdown of the Core sites visited by the Most Active Users.
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Home Page Dialog Box
With Incoming Firewall Activity profiles, you can use the Home Page dialog 
box to obtain accurate data about hits to your home page(s). Home pages are 
the pages a Web server defaults to when the user requests a URL without a 
specific file name. For example, if a user requests: 

�		�
$$������(	��������#$�

 site, the Web 

erver delivers:

hough for 
ber of hits to 

 entire site. The 
rts.
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and �������	# is the home page for the uppermost level of the
server delivers: 

�		�
$$������(	��������#$�������	#

Similarly, if the user requests:

�		�
$$������(	��������#$�����	�$����#��.

and ����
�	��	# is the home page for that directory, the Web s

�		�
$$������(	��������#$�����	�$����#��.$����
�	��	#

Both �������	# and ����
�	��	# are home pages for the site (t
different directories), so if you wish to accurately count the num
home pages, specify any file names used as home pages for the
specified paths and file names are shown in Firewall Suite repo



You may also wish to specify multiple home page file names when a home 
page file name changes, but you still want to perform analysis on log files 
created before and after the name change. For example, if the home page for 
www.webtrends.com, ����
�	��	#, was changed to �������	#, but you 
wanted to report on hits to both the new and old home page file names.
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To specify the home page:

1. In the Home Page File Names text box of the Home Page dialog box, type 
the home page file names that the Web server defaults to when a visitor 
requests a URL without a specific file name. The most common filenames 
are provided by default.

− Separate multiple file names with spaces.

− You can type up to 255 characters. 

ot of your site. 

r by using a 
ify a shared 
URL path or 

type or browse 
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Chapter 3 • Fir

2. Specify your Web site URL using the entire path from the ro
Do not include your default home page file name. 

− If you access your Web site from a mapped drive o
Universal Naming Convention (UNC) name to ident
file, select file:/// from the dropdown list and type the 
browse to it. For example, type��
����	�
(�������	�.

− If you access your Web site by FTP, select ftp:// and 
to the location of the site. For example, type �	��������
required, provide a user name and password.

− If yours is an HTTP site, select http:// and type your
for example ������#������#$. If authentication is requir
access requires User Name and Password and provid
and password. This is not usually required. 

3. Click Next. The Filters dialog box opens.



Filters Dialog Box
Filters focus the contents of a report by including only the data you want to 
analyze. You can use filters that include data based on defined criteria, and you 
can use filters to exclude data based on defined criteria. Because filters are such 
a powerful tool, they are discussed in their own chapter. See “Filtering for 
Focused Reports” on page 157 for detailed information about filters, and how to 
add, delete, edit, copy and combine them.

You can create a profile without using any filters. By default, this means that all 
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log file data is included in the log file analysis.

Use the Filters dialog box to create, edit, copy and delete filters.
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Creating a Filter
To create a filter:

1. In the Filters dialog box, click New to create a new filter using the New 
Filter wizard. 
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2. Select one of the following options:

− Include to include Web site activity that meets the selec
your analysis and reports.

− Exclude to exclude the Web site activity that meets the 
in your analysis and reports.

− Copy of another filter to copy an existing filter from a
filters for the selected profile type and edit it as needed.

3. Click Next. 

4. If you selected Copy of another filter, select the filter you w
click Next.

5. If you selected Include or Exclude, type a name for the filt
box and click Next.



6. Click Include/Exclude activity based upon. 

7. Select any filter elements you wish to include or exclude from your log file 
analysis and reports. 

8. Click Next. The dialog box for the first filter element you selected opens.

9. Fill in the settings for the filter element dialog box.

10. Click Next and continue to fill in the settings for the remaining selected 
filter elements. For more information, review “Filter Basics” on page 157.

e filters list.

 page 164 
age 166 for 

 the filters 
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11. Click Next. The Database and Real-Time dialog box opens.

Editing a Filter
To edit a filter:

1. In the Filters dialog box, select the filter you wish to edit from th

2. Click Edit and edit the filter as needed. See “Filter Elements” on
for a list of filter elements. See“Filter Element Descriptions” on p
a full description of each filter element.

3. Click OK.

Deleting a Filter
To delete a filter:

1. In the Filters dialog box, select the filter you wish to delete from
list.

2. Click Delete. A confirmation message displays.

3. Click Yes to confirm the deletion. The filter is now deleted.
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Copying and Pasting a Filter
To copy and paste a filter:

1. In the Filters dialog box, select the filter you wish to copy from the filters 
list.

2. Click Copy.

3. Click Paste. A copy of the filter is placed in the list with the name “Copy of 
Chapter 3 • Fir

filter name”.

4. Select and edit the copied filter as needed.



Bandwidth Cost Dialog Box
Use the Bandwidth Cost dialog box to specify the cost of service for each 
kilobyte of data transferred for General Firewall Activity profiles. The 
information collected in the Bandwidth Usage report chapter includes the 
number of events, the percent of total events, the kilobytes transferred, and the 
cost of bandwidth used by top user addresses, outgoing protocols, and 
incoming protocols.

Firewall Suite calculates and reports the cost of bandwidth usage for all types of 
d by 
 number of 
 transferred 
 with a 

hs and 
sage and 
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incoming and outgoing Internet activity. Bandwidth cost is calculate
multiplying the Cost of Bandwidth per Kilobyte you supplied by the
kilobytes transferred. All firewall events that log a value for kilobytes
are included. Typically, firewalls log this value for events associated
protocol.

To report on bandwidth cost accounting, you must include the grap
tables for Top Users by Bandwidth Utilization, Outgoing Protocol U
Incoming Protocol Usage.
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Specifying Bandwidth Cost
To specify the bandwidth cost:

1. In the Currency dropdown list of the Bandwidth Cost dialog box, select 
the currency to use when calculating bandwidth cost.

2. In the Cost of Bandwidth per Kilobyte text box, enter the cost per 
kilobyte transferred. 
Chapter 3 • Fir



Database and Real-Time Dialog Box
The Database and Real-Time dialog box allows you to activate the FastTrendsTM 
database and use real-time analysis when analyzing that data. Both features are 
useful for speeding up analysis and reporting, especially if your firewall 
generates large amounts of data.
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FastTrends Database 
Using the FastTrends database allows Firewall Suite to store analysis
cache. Because the cached data is more accessible, Firewall Suite ca
more efficient future analysis and report generation on the current p
example, if you activate the FastTrends database option and genera
on Monday, Firewall Suite stores the data in the FastTrends database
a report on the same profile for Monday and Tuesday, only the dat
Tuesday needs to be analyzed.
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Real-Time Analysis
Firewall Suite’s real-time analysis feature can keep your log file analysis as 
current as possible. Real-time analysis enables Firewall Suite to monitor log files 
at regular intervals and check for any new activity. If new activity is found, then 
FastTrends analyzes the new data in the background, and stores the analysis 
results in the FastTrends database. 

Real-time analysis is useful if your firewall generates unusually large amounts of 
cant amount of 
intervals, when 
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data and initial analysis of an entire log file would take a signifi
time. By collecting and analyzing log file information at regular 
an analysis and reporting event kicks off, only the new log file 
need to undergo analysis before a report can be generated.

To specify settings for the FastTrends database and real-tim

1. To store the results of log file analysis in a database to use f
reports, select the Use FastTrends Database checkbox.  .  Th
location of the FastTrends database is 
InstallDir\wtm_FirewallOther\datfiles\profile_name.dat.  

Use the Advanced FastTrends tab (enabled when you activa
to specify a location for the database different from the defa

2. Select or clear the Analyze log files in real-time check bo
whether log files are analyzed in real time. For more inform
time analysis, see “Advanced FastTrends Dialog Box” on pa

Maintaining the FastTrends Database
You may need to manage the amount of data in your FastTrend
free up available space.



To maintain the FastTrends database:

1. On the Main Console, select the profile type tab containing the profile for 
which you want to perform FastTrends database maintenance.

2. On the Main Console, select Tools > FastTrends Maintenance. The 
FastTrends Database Maintenance dialog box opens.

 want to 
tabase list 

escending 
ding order. 
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3. From the Profile dropdown list, select the profile for which you
perform FastTrends database maintenance. The Contents of Da
shows all the FastTrends database entries by date.

The Contents of Database list may be sorted in ascending or d
order. Select the Descending order check box to sort in descen
Clear the check box to sort in ascending order.
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4. Delete entries from the list using one of the following buttons:

− Click Delete All Entries to delete all entries in the list.

− Click Delete Selected Entries to delete a selected entry from the list.

− Click Delete All Entries Before to delete all entries before a specified 
date.

− Click Delete All Entries After to delete all entries after a specified date.

een two user-

nt log file, 
e database and 

ce.
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− Click Delete all Entries From to delete all entries betw
specified dates

5. Click Close.

Notes
If you make changes to a profile, for example by using a differe
changing DNS Lookup settings, or modifying the filters, clear th
rerun the analysis to store the correct data in the database. 

If you turn off FastTrends, clear the database to free up disk spa



Advanced FastTrends Dialog Box
This dialog box is shown only if you activated FastTrends database in the 
Database and Real-Time dialog box. The Advanced FastTrends dialog box lets 
you specify a database location other than the default location. 

Storing FastTrends data in a location other than the default can save space on 
your local computer; however, it can slow down processing.

ck box.

e Location 
ion.
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To specify an alternate data storage location:

1. Clear the Store FastTrends databases in default location che

2. Type the path and directory for the new location in the Alternat
text box, or use the browse button to navigate to the new locat

3. Click Finish.
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Setting Up Syslog Dialog Box
The Setting Up Syslog dialog box is the last dialog box you will see when 
setting up a profile that uses the WebTrends Syslog Service.

If you have not already configured your firewall to send its log files to the 
WebTrends Syslog Service, you will need to do so. The Firewall Configuration 
Guide contains specific information for your firewall.

om of the 
e computer 
ce is bound. 
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To finish setting up your profile:

1. Write down the IP Address or addresses you find at the bott
Setting Up Syslog dialog box. These are the addresses on th
running Firewall Suite to which the WebTrends Syslog Servi

2. Click Finish.



Editing a Profile
You can edit an existing profile in the Edit profile window.

To edit an existing profile:

1. On the Main Console, select the profile that you want to change in the 
Profile Description list.

2. Select Edit > Profile from the Main menu, or Edit Profile on the Tasks 
area. The Edit Firewall Activity Profile window opens.

the top of 
ond to the 

rewall 
h tab. Make 

or click OK 
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3. View the current settings for the profile by selecting the tabs at 
the window to open the associated dialog box. The tabs corresp
dialog boxes used in the New Profile wizard. See “Creating a Fi
Profile” on page 31 for more information on the settings for eac
any needed changes to the settings. 

4. Click Cancel to close the window without saving any changes, 
to save your changes and close the window. 
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Copying a Profile
You can create a new profile based on existing profile settings. This may be 
useful if many of the settings in the existing profile are needed in the new 
profile.

To copy a profile:

1. On the Main Console, select the profile you want to copy and modify from 

irewall Activity 

d then type a 

 Use the scroll 
l of the tabs
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the Profile Description list.

2. Select Edit > Copy Profile from the Main menu. The Edit F
Profile window opens.

3. Select the Title, Log File Format or List of Servers tab, an
name for your new profile in the Description text. 

4. Select other tabs as needed, making any necessary changes.
arrows in the upper-right corner of the window to access al

5. Click OK to save the new profile and its settings.



Deleting a Profile
If you have profiles that are no longer needed, you can delete them.

To delete a profile:

1. On the Main Console, select the profile that you want to delete from the 
Profile Description list.

2. Click Edit > Delete from the Main menu or Delete Profile from the Tasks 
area. A confirmation message displays.
80     User Guide

3. Click Yes to confirm the deletion. The profile is deleted.
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Specifying Log Files
When creating or editing a profile, you can specify single or multiple log files 
using the browse buttons in the Log File Path section of the Title, Log File 
Format dialog box. This section discusses how to browse for log files and how 
to specify multiple logs using date macros or wildcards. For most firewalls, you 
will see the dialog box shown below. 
Chapter 3 • Fir



Specifying a Single Log File
To specify a single log file:

1. In the Title, Log File Format dialog box, click the browse button .

2. Navigate to the directory with the log file.

3. Select the file, and click Open. 

le log files:

Note
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4. Click Next.

Specifying Multiple Log Files
Firewall Suite provides you with a number of ways to select multip

• Using a browser

• Using wildcards to select log files with similar names

• Using date macros to select log files that have dates as names

You can specify compressed logs, such as �7�� or �.7�files.
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Multiple log files are specified using the Selected Log Files dialog box. 

se button  on 
les dialog box 

Firewall Name 

iles dialog box 

 log file.

e List.
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To add files using the browser:

1. Choose one of the following two options:

− Firewall on single machine. Click the extended brow
the Title, Log File Format dialog box. The Selected Logfi
opens. 

− Firewall on multiple machines: 

a. Click New in the List of Servers dialog box to open the 
and Log File URL Path dialog box.

b.  Click the extended browse button . The Selected Logf
opens.

2. Click New.

3. Navigate to the directory that contains the log file. Select the

4. Click OK to add the file to the File Specification and Log Fil



5. Repeat to add additional files.

6. Click OK to return to the Title, Log File Format dialog box.

To add files using wildcards:

1. On the Title, Log File Format dialog box, click the extended browse button 
. The Selected Logfiles dialog box opens.

2. Click Wildcard. The Wildcard dialog box opens.

ames or file 
 examples.

ist.

x.
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3. Select the directory that contains the log files.

4. In the Wildcard Specification text box, type the log file path n
names using ' or�8. See “Specifying Log Paths” on page 351 for

5. Click OK to add the files to the File Specification and Log File L

6. Click OK again to return to the Title, Log File Format dialog bo
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To add files using date macros:

1. On the Title, Log File Format dialog box, click . The Selected Logfiles 
dialog box opens.

2. Click Date Macro. The Create or Edit Date Macro dialog box opens.

wse to the 

ay in which the 
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3. In the Location text box, type the path to the log file or bro
directory.

4. In the Style text box, use the dropdown list to specify the w
date is arranged in the file name. 



5. In the various Log File Name text boxes, specify the following:

− Prefix: Type any text that precedes the date.

− Year: If the file name contains the year, select a year format from the 
dropdown list.

− Month: If the file name contains a month, select a month format from 
the dropdown list. 

The three-character text abbreviations for the month are case sensitive. 
Select the case desired.

m the 

 the system 

subtract 
e text box.

s, then type 

x. Click OK 

 Save As 
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− Day: If the file name contains a day, select a day format fro
dropdown list.

− Suffix: Type the log file extension.

6. Make any necessary adjustments to the system date:

− Select Use the current system date to make no changes to
date.

− Select Subtract this many days from the system date to 
days, then type the number of days to be subtracted into th

− Select Add this many days to the system date to add day
the number of days to be added into the text box.

7. The resulting macro is displayed in the Review Results text bo
to close the dialog box.

8. Click OK to return to the Title, Log File Format dialog box.

Note
You can also use macros in the Log File URL path as well as the
paths of the Scheduler and the Create Report dialog boxes.
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To remove log files from the File Specifications and Log File List:

1. On the Title, Log File Format dialog box, click . The Selected Logfiles 
dialog box opens.

2. Select the log files in the list.

3. Click Delete. A confirmation message displays.

4. Click Yes to confirm. The log file is removed from the list.

 by the date, 
ly the previous 
ile Path text 
r Edit Date 

 by the date, 
log files, type a 
Log File Format 
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Using Date Macros
If your firewall maintains a separate log file for each day named
and you would like to define a log profile which incorporates on
day’s firewall activity, type a line like the following in the Log F
box in the Title, Log File Format dialog box, or use the Create o
Macro dialog box.

0
�*9:;!<!�")5�="9;�>?@19A�>>##>>��>>%%>���.

If your firewall maintains a separate log file for each day named
and you would like to specify the previous three days’ worth of 
line like the following in the Log File Path text box in the Title, 
dialog box, or use the Create or Edit Date Macro dialog box.

0
�*9:;!<!�")5�="9;�>?@19A�>>##>>��>>%%>���.&>?@19A
�>>##>>��>>%%>���.&>?@19A�>>##>>��>>%%>���.



Using Firewall Add-On Support for Clusters
The Firewall Add-On analyzes the multiple log files created by firewalls, VPNs, 
or proxy servers hosted on multiple servers or server clusters. Using WebTrends 
ClusterTrends technology, it automatically consolidates the data to provide an 
accurate analysis of firewall activity. While Firewall Suite offers accurate, 
sophisticated reporting for log files for a single firewall, the Firewall Add-On 
support for clusters provides additional reporting capability for firewalls hosted 
by multiple servers. Firewall Add-On addresses the problem of overlapping log 
files.

perating to 
 common 
cing device 
runs 
irewalls in 

PNs, or 
hieves a 

dware or 
andwidth 

 server is 
ers can 

hile others 
 to other 

ld 
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A firewall cluster is a group of firewalls, VPNs, or proxy servers coo
provide high bandwidth and reliable access. The simplest and most
form of a firewall cluster includes multiple servers and a load balan
or redirector. Each server has identical firewall content and usually 
mirroring software to maintain the duplicate content across all the f
the cluster. 

Activity through the firewall is distributed among all the firewalls, V
proxy servers in the cluster by a redirector device. The redirector ac
balanced load for each server in the cluster. 

Firewall clusters provide the following benefits:

• High bandwidth capabilities. Because of the load balancing har
software that distributes the requests, you can achieve greater b
than with a single server configuration.

• Reliability. Because an identical firewall is on each server, if one
down because of software or hardware problems, the other serv
continue to handle activity.

• Maintenance. You can upload changes to one firewall server w
are still available for access. Once uploaded, changes are copied
servers in the cluster.

However, the individual log files from the firewalls in the cluster yie
inaccurate data because they are logging only part of the activity. 



ewall Profiles     89

To remedy this issue, the Firewall Add-On time-stamps firewall activity, and 
records it in sequence, even though the activity may be directed to and logged 
on different firewalls in the cluster. Using the time stamp, the Firewall Add-On 
collects all of the data from each server, reorders it, and analyzes it to produce 
accurate and complete results for the firewall. You must purchase a Firewall 
Add-On to implement this technology.
Chapter 3 • Fir



Using Department Management
You may wish to configure your profile using the Department Management 
feature. This feature provides a more detailed break-down of your 
organization’s domain name into groups of users using their IP address or 
domain names. You can configure Firewall Suite to report on domain activity by 
department including the following: 

• Which pages users access, and how much time they spend on them.

ccurs.

organi-

 included in 
e 
sted in. See 
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• Which departments access your intranet and when that access o

• Where your users and departments are located.

• Which operating systems are used most widely within the your 
zation.

• Which browsers are used.

• Which days and times are the most active and inactive. 

• Which forms users submit.

• Which scripts run and when they run.

Once you have set up departments, this information is automatically
General and Outgoing Firewall Activity reports. You can also use th
Departments filter element to report on just the ones you are intere
“Departments” on page 172.
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Defining a Department
To set up departments to be included in reports or used in filters: 

1. On the Main Console, select Tools > Department Management. The 
Department Management dialog box appears.

 

list window.

ens.
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A list of departments that have been defined appears in the 

2. Click New. The Edit User and/or Department dialog box op



3. In the IP or Domain text box, type an IP address, IP address range, or 
domain name. 

− You can type a subnet using CIDR format. For example:

������������$���

where /26 indicates the number of bits used to identify the network.

− You can use wildcards to specify a range of addresses. For example, 
type:

 spaces or 

nt 

s you want 

domains 
t dialog 
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�BB��BB��BB�'

to specify an entire Class C subnet, or type:

�BB��BB�'�

to specify a Class B subnet, or type 

�BB�'�

to specify a Class A subnet.

You cannot list IP addresses or domain names separated by
commas.

4. Do one of the following:

− Select a previously-defined department from the Departme
dropdown list.

− In the Department text box, type a new department name a
it to appear in reports.

5. Click OK.

Editing a Department
You can make changes to the departments and the IP addresses or 
associated with the departments within the Department Managemen
box. 
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To edit a department:

1. On the Main Console, click Tools > Departments. The Department 
Management dialog box opens.

2. In the Department Management dialog box, select the department definition 
that you want to change, and click Edit. The Edit User and/or Department 
dialog box opens.

3. In the IP or Domain text box, type an IP address, IP address range, or 

ment 

e as you want 

the Department 
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domain name. 

4. Do one of the following:

− Select a previously-defined department from the Depart
dropdown list.

− In the Department text box, type a new department nam
it to appear in reports.

5. Click OK to save your changes, or click Cancel to return to 
Management dialog box without saving your changes.



Running Firewall Activity Profiles from the 
Command Line

You can run any profile from the command line. To prevent collisions, the 
Scheduler handles command-line processing. When you run a profile, it is 
placed in the Scheduler queue until it can be processed.

Basic Information

for running 

s the files 
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Command-Line Help
Get help for any command by typing:


�,����

Files
Each profile type is referred to as a cartridge. The command syntax 
a profile specifies three files:

• The cartridge application extension

• The profile configuration

• The memorized report. 

Following each command-line component section is a table that list
and their locations.
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Syntax
The syntax for running a profile is:

C�
��D��	�
�	�	�����
	����������	�����	�
�	������	�������C

. You can use 
and file name. 

n file name.

Note
The distribution option is not required.

������;
�	�

������;
�	�

������;
�	�
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Command-Line Components
The following sections provide descriptions of each component
the name of the component, its file name, or its complete path 

Cartridge
Use the following command�to specify the cartridge:

$�4C���	���.��������#�C�

where 
�	�	������������� is the cartridge application extensio

 Profile
Use $��or $���to identify the profile. For example:

$�4
	���������
	�
����

or

$��4
	���������������

Cartridge File name Location

General �	#���������)	������� �*�(1���������

Incoming �	#���������*�(=����� �*�(1���������

Outgoing �	#���������*�()
	���� �*�(1���������



where 
	���������
	�
���� is the value of the Description parameter in the 
profile configuration file (or the profile description from the Main Console) and 

	����������������is the name of the profile configuration file.

The following table shows profile configuration file extensions.

 report. For 

on 
rized report 
����	�
�	��

le.

Note
When you use the user interface to create profiles, the corresponding 
configuration files are named numerically beginning with ������������. You 
can rename them.

�
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Memorized Report
If you are running a report, use $# or $#� to specify the memorized
example, type

$#4����	�����	�
�	�����
	�
����

or

$#�4����	�����	�
�	�����������

where ����	�����	�
�	�����
	�
���� is the value of the Descripti
parameter in the memorized report configuration file (or the memo
name in the Create Report window of the user interface) and ����	�
��������� is the file name of the memorized report configuration fi

Cartridge File name Location

General ����� �*�(1���������������
;
�	���	#���������)	������	�����

Incoming '���� �*�(1���������������
;
�	���	#���������*�(=��?�	�����

Outgoing '���� �*�(1���������������
;
�	���	#���������*�()
	�?�	����
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The following table shows memorized report file extensions.

saved or 
or send it as an 

re you want to 

���� is the path 
rt; ���	���� 

ess the FTP site.

Cartridge File Name Location

General �#�� �*�(1���������������
;
�	���	#���������)	������	�����

Incoming �#�� �*�(1���������������
;
�	���	#���������*�(=��?�	�����

port.
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Distribution Method
If you are running a report, use�$� to specify how the report is 
distributed. You can save a report to a file, transfer it using FTP, 
email attachment. 

In this example:

$�4C��	�����������	���#�C�


��������	�
�	������ is the complete path of the location whe
save the report and the file name for the report. 

In this example:

$�4C�	�
$$�	����	�$��	�����������	���#��
$
�����#�4
�����#��$��������4��������C�

��
������is the domain name of the FTP site; 
��������	�
�	��
from the root directory of the site and the file name for the repo
and 
�����	� are the login name and password required to acc

Outgoing �#�� �*�(1���������������
;
�	���	#���������*�()
	�?�	�����

Note
Using $� overrides the distribution method in the memorized re



In this example:

$�4C#���	�

���E��#������#$�
������	��%������	��	#�C�

���	��������
���is the recipient of the report, and �
������	��%������	��	#� 
is the directory and file name for saving the report. Note that there is no space 
between the recipient and the $��D�A	� directory path.

Command-Line Examples
arate lines. 
ch option.

s for the 
ectory.

dge to 
sent via 

#�CC
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In these examples, the options and their values are displayed on sep
Each command is on a single line, with a single space preceding ea

This example uses the profile and the memorized report description
General Firewall Activity cartridge. The report is saved to a local dir

C�
��D��	�$�4C�	#���������)	�������C�
$�4C5����������������@�	�D�	%C�
$#4C?���
�	�;
##��%�FG1-"HC�
$�4C�
������	�������	��	#CC

This example uses file names for the General Firewall Activity cartri
identify the cartridge, profile, and memorized report. This report is 
email:

C�
��D��	�$�4C�	#���������)	�������C�
$��4C��#�������C�
$#�4C?9�@ "1��	#�#��C�
$�4C#���	�
��#����	��	��E��(	��������#$�
������	�������	��	
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Designing Firewall Profiles
This section contains information that will help you design a Firewall or Web 
Activity Profile.

Report Content
The following table shows which type of profile you should use to get the 

file Type

all Activity

wall Activity

wall Activity

wall Activity

wall Activity

all Activity

wall Activity

wall Activity

all Activity
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report content you need.

To Report On Using These Criteria Use This Pro

Bandwidth Users, by protocol General Firew

Users, by day of week Incoming Fire

Users, through proxy server Incoming Fire

Categories Categories of Web sites 
accessed by organization 
user

Outgoing Fire

Directories Most accessed Incoming Fire

Email Top senders by direction, 
largest messages by 
direction

General Firew

Files Files downloaded by an 
external user by type

Incoming Fire

Files downloaded most by 
an internal user

Outgoing Fire

FTP Upload activity, download 
activity, largest uploads/
downloads

General Firew



Geographic Information By country, by North 
America, by city for external 
users

Incoming Firewall Activity

Countries accessed by 
internal users

Outgoing Firewall Activity

Incoming Activity Summary Activity by day, by hour Incoming Firewall Activity

Incoming Activity Details Activity by day, by hour Incoming Firewall Activity

 Activity

 Activity

 Activity

 Activity

 Activity

ctivity

ctivity

ctivity

To Report On Using These Criteria Use This Profile Type
100     User Guide

Organizations Visited by internal users Outgoing Firewall

Visited by external users Incoming Firewall

Outgoing Web Activity 
Summary

Activity by hour, by day Outgoing Firewall

Outgoing Web Activity 
Details

Activity by hour, by day Outgoing Firewall

Pages Most/least requested 
pages, top entry pages, top 
exit pages, single access 
pages, paths through sites

Incoming Firewall

Rules By internal address, by 
external address, by 
protocol

General Firewall A

Telnet Top telnet users by 
direction, largest telnet 
sessions

General Firewall A

Traffic By direction, by time of day, 
by day of week

General Firewall A
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Users By region, organization, 
paths through site

Incoming Firewall Activity

email senders, telnet 
sessions, FTP activity, 
users triggering firewall 
rules

General Firewall Activity

all Activity

To Report On Using These Criteria Use This Profile Type
Chapter 3 • Fire

VPNs IP addresses, events General Firew
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Chapter 4

Alerting and Monitoring

rting and 
ed in “Firewall 
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This chapter explains how to create and use profiles for the Ale
Monitoring module. Firewall and Web Activity profiles are cover
Profiles” on page 27. 

The Alerting and Monitoring module keeps tabs on a number of
of networked objects such as Web sites, files, event logs, service
database servers, and devices identified with an (IP) address—n
objects in your organization that must be running and available. 
change of state occurs with a monitored object, the module can 
recovery actions, or do both.

The module can also generate reports that help you track how 
monitored device or object is and determine how the software re
any device failed. You can tailor your reports to see which obje
when they do so, and for how long. You can also automate stat
find the data you need and make it available when you need it 

Alerting and Monitoring Profiles
Much like the firewall activity modules, you must first create a p
advantage of the features available with the Alerting and Monito
Once you’ve created a profile, you can generate reports of respo
that profile. See “Working with Reports” on page 201.



Use alerting and monitoring profiles to:

• Monitor Web-related devices and services for changes in state. For a 
complete list of devices you can monitor, see “Monitor Types” on page 148.

• Send and receive alerts when the state of a device changes or a particular 
event triggers an alert.

• Set up recovery actions to automatically restore devices and services that 
have stopped operating.

 monitored 

network 
evice that is 
le functions 
query the 

ent error 
ddition to 
s that might 

 trigger 
mmed 

 actions to 
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• Run alerting reports that contain information about the status of
devices and services.

• Create automated status reports.

How Alerting and Monitoring Works
A state is a condition that can be repeatedly tested. For example, a 
device that is operating is considered to be in an up state, while a d
not operating is in a down state. The Alerting and Monitoring modu
by polling a target object—that is, using a Ping utility to repeatedly 
object about its state at user-specified intervals. 

In contrast, an event is a unique occurrence. For example, an NT Ev
that is entered in your Web server log a single time is an event. In a
monitoring an object’s state, the module can watch for certain event
occur. 

When an object’s status varies from a certain preset state, or when a
event occurs, the Alerting and Monitoring module uses a pre-progra
method to alert you and takes a course of pre-determined recovery
respond to the event or return the object to its initial state.
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Sample Alerting and Monitoring Profiles
It may be helpful to view a sample profile as you review the next section, 
“Alerting and Monitoring Profile Settings” on page 106. Two sample alerting 
and monitoring profiles are provided in the profile description list of the Main 
Console under the Alerting & Monitoring tab. In one sample, the profile 
specifies a network device to be monitored using the Ping utility, the response 
configuration specifies a single-phase response, and the response action profile 
Chapter 4 • Alerting an

specifies an audio alert.



To view the sample Alerting and Monitoring profile:

1. Select the Alerting & Monitoring tab on the Main Console.

2. Select the profile called "Sample - Alerting & Monitoring - Ping".

3. Click Edit > Profile from the Main menu. The sample profile opens.

4. Select the various tabs in the Edit Alerting & Monitoring Profile dialog box 
to view the settings specified for the profile.

which 
t or change 
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106     User Guide

Alerting and Monitoring Profile Settings
When creating an alerting and monitoring profile, you must define 
device or object to monitor, when to monitor the device, what even
in state for that device should trigger a response, and what action o
should occur when the response is triggered. These elements are d
the following sections. 

Configuring some of these elements requires drilling down several d
deep. To familiarize you with these dialog boxes and their settings, 
for creating an alerting and monitoring profile follow this section.

Device or Object Being Monitored
When first creating an alerting and monitoring profile, you must spe
device to monitor and point to the device so that the Alerting and M
module can access it. For a complete list of devices you can monito
“Monitor Types” on page 148. 
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Monitoring Schedule
The monitoring schedule specifies when the alerting and monitoring profile 
should actively monitor the specified device or object by polling it with the Ping 
utility. The monitoring schedule also includes the frequency with which to poll 
the device, and the amount of time to wait after a failure occurs before initiating 
a response.

cify:

e the Response 

nse Schedule 

which to apply 
e the Select 
d the Response 
se settings.

e response. 
idual configu-
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Response Settings
The combination of settings and dialog boxes in which you spe

• The device state change or event that triggers a response. Us
Settings dialog box to make these selections.

• The schedule for applying the response. Use the Edit Respo
dialog box to specify these settings.

• The set of actions that constitute the response, the order in 
those actions, and how many times to apply each action. Us
Response Configuration, Response Configuration Settings, an
Profile Phase Settings dialog boxes as needed to specify the

• The specific configurations for each action that constitutes th
Use the Select Response Actions dialog boxes and the indiv
ration dialog boxes for each possible action to specify the a
settings.

 Response Schedule
The response schedule specifies how and when to apply respon
configurations in reaction to an event or change of state in a mo
You can create new response schedules, or you can edit, copy, 
existing response schedules. 

Once you have created and saved a response schedule, you can
monitoring and alerting profiles.



Response Configuration
A response configuration specifies the response or responses you want to occur 
for a given time period when a state changes or an event occurs. This includes 
any response actions and those actions’ settings, and if applicable, the settings 
that specify when to escalate from one phase to the next. 

Once you have created and saved a response configuration, it can be used in 
multiple response schedules.

A response can be either of two types: single phase or multi phase.

ple, when a 
rator, while 

 the 
 first try 
s not come 
 attempts at 
ministrator 

se action.

 the next 

 response 
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Single-phase applies any assigned actions simultaneously. For exam
server goes down, a pager alert could be sent to the server administ
simultaneously, the module could attempt to reboot the server.

Multi-phase applies to an assigned action or actions in phases. With
previous example, when the server goes down, the computer could
rebooting. This would be the first phase. Then, if the computer doe
back up (change state) for a specified amount of time or number of
rebooting, a second phase could be initiated, in which the server ad
is sent an email message and is also paged. 

With a multi-phase response, you can set each phase to:

• Wait a specified number of seconds before repeating the respon

• Repeat a phase a specified number of times before escalating to
phase of response action.

• Repeat a phase until the profile state changes, which causes the
profile to reset itself.

Note
A response phase can consist of a single action or multiple actions.
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Response Actions
A single action, such as a pager alert, a system reboot, or an audio alert that can 
be configured to occur in a specified manner when an event or a change of 
state for a device or object triggers a response. Once the settings for a response 
action have been configured, they can be used within either a single or multi 
phase response.

Possible response actions include: 

unning a group 
se the same 

le
ofile wizard for 
rmation 
help in each 

 profiles.
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• Sending an audio or email alert 

• Broadcasting an alert to a pager 

• Passing an SNMP trap

• Running a program

• Running a group of responses

• Rebooting a device

• Restarting a Windows service

A response action can initiate a single action or, in the case of r
of responses, can initiate multiple successive actions. You can u
response action with different response configurations. 

Creating an Alerting and Monitoring Profi
This procedure describes the sequence of panels in the New Pr
creating an alerting and monitoring profile. It describes the info
required in each panel to set up the profile. Refer to the online 
panel for more information. 

Note
You can create an unlimited number of alerting and monitoring



To create a new alerting and monitoring profile:

1. Select the Alerting & Monitoring profile type tab on the Main Console. 

2. From the File menu or the Tasks area select New Profile. The New Profile 
wizard opens to the Specify Profile Description and Type dialog box.

Specify Profile Description and Type
ng profile, 
 you are 

tions” on 

files.
110     User Guide

In this dialog box, you specify a name for the alerting and monitori
select a device to monitor, and specify any dependencies the profile
creating has on other profiles. See “Defining Advanced Monitor Op
page 144 for more information on dependencies.

Note
You can create an unlimited number of alerting and monitoring pro
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To specify the profile name and device to monitor:

1. Type a name for the profile in the Description text box. The description 
identifies the profile in the Profile Description list in the Main Console and 
is used as a sub-heading for reports. 

2. Select the device you want to monitor with this profile from the Device to 
Monitor dropdown list. 

on other 
 Settings dialog 
n page 144.

y profiles that 

 Type dialog 
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itors, SNMP 
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3. If you wish to set dependencies on other profiles:

a. Click Advanced Monitor Settings to set dependencies 
profiles monitoring other objects. The Advanced Monitor
box opens. See “Defining Advanced Monitor Options” o

b. In the Monitor Profiles list, select the check boxes of an
the current profile depends on.

c. Click OK to return to the Specify Profile Description and
box.

4. Click Next. The Specify Profile Details dialog box opens. 

The list is sorted by device type: IP Device, NT System Mon
Monitors, LAN Computer Monitors, Disk and File Monitors. 
monitors with descriptions, see “Monitor Types” on page 14

Notes
The current profile is enabled only when the devices for
you select here are active. If one of these profiles goes d
current profile is disabled. 

If you are editing an existing profile, click Flush Log Fil
box to delete the profile’s log data. Use this option only
created the reports you need.



Specify Profile Details
Use this dialog box to enter the location of the device to be monitored and 
settings relevant to the selected device. The fields that appear in this dialog box 
vary according to the device selected.

he dialog 
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To specify profile details:

1. Fill in the fields in this dialog box, clicking the Help button in t
box to get device-specific information.

2. Click Next. The Specify Schedule Settings dialog box opens.
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Specify Monitoring Schedule Settings
Use this dialog box to enter the frequency with which you want to poll the 
monitored device and specify how long to wait after a device fails before 
sending an alert. Then set up a weekly monitoring schedule using the monitor 
schedule. For more information, see “Monitoring Schedule” on page 107. 

 poll the 
e Poll Devices 
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Chapter 4 • Alerting an

To specify the monitor schedule settings:

1. Enter the frequency with which you want the Ping utility to
monitored device by typing or scrolling to a number to set th
every values in the Monitor Timing area and in the dropdow
either Seconds or Minutes as the time unit. 

2. Enter the amount of time after a device has failed to initiate 
typing or scrolling to a number in the Send Alert after... of
in the Monitoring area and in the dropdown box. Select eith
Minutes as the time unit.



3. Set the Monitor Schedule by clicking on or off individual grid squares or by 
clicking and dragging vertically or horizontally to select or un-select days 
and hours. The areas in blue indicate the times that this profile will actively 
monitor the device.

4. Click Next. The Specify Response Settings dialog box opens.

Specify Response Settings
 chosen to 
down” 
lerting and 
al state 
ule for any 
d reuse 
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What you see in this dialog box depends on which device you have
monitor. Some devices allow you to monitor for an “up” state or a “
state—that is, whether the device is functional or accessible to the A
Monitoring module. Other devices allow you to monitor an addition
particular to the device. You can choose to create a response sched
or all of the states available with that device. You can also create an
response schedules with different monitoring profiles. 
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Choosing Response Options
To create a response schedule for the device you want to monitor, select the 
state or states to which you want the module to respond. You can specify more 
than one state by creating multiple schedules. For example, if you want to be 
notified when a server is down and when it comes back up, create response 
schedules for both states.

• Enable Up Response. Select this option if you want to receive notification 
ice is “up,” as 
quest. You 
s down or 
t exist and you 

ssible.

er has created 
ng and 
s crated. 
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and/or trigger a response when the monitored object or dev
indicated by its ability to respond to the module’s polling re
would choose this option if the normal state for the object i
inaccessible, or if the object you want to monitor does not ye
want notification when it becomes available, active, or acce

For example, if you want to be alerted when your Web serv
and saved a new log file for processing, configure the alerti
monitoring module to poll the directory where the log file i
Ordinarily, that file will not exist until the server creates it, s
be “down.” Once the server creates the file, however, its state
“up,” and the module can notify you.

• Enable Down Response. Select this option if you want to 
cation and/or trigger a response when the monitored object
“down,” which means that it no longer responds to the mod
request. Choose this option if the monitored object or devic
active, available, or accessible and you want notification wh
changes.

For example, if you want to monitor the state of your Web s
its availability, you would have the module poll it periodica
state. If the server fails to respond to the polling request, aft
time period of non-responsiveness, the module could notify
server is down and initiate the response action you have pr
your response profile for that condition.



• Enable [other] Response. Select this option if you want to receive notifi-
cation and/or trigger a response when the monitored object or device 
changes its state from an expected state. What happens to change the state 
from the expected state to a different state depends on the nature of the 
object or device property you want to monitor.

To specify response settings in the response schedule:

1. In the Specify Response Settings dialog box, select one or more response 
states to configure, for example Enable Up Response, or Enable Down 
Response. 

 response 
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2. Click the  button located below the check box for a selected
state to open the Edit Response Schedule dialog box.



d Monitoring     117

3. In this dialog box, specify which actions the module should take when the 
monitored device changes state. Using this dialog box you can:

− Create a new response schedule by clicking Add New and defining new 
response configurations and their response actions. If you choose to 
save the response schedule, you can use it later with another 
monitoring profile. For more information, see “To create a response 
schedule:” on page 119.

− Edit an existing response that is already associated with the profile by 
edules and 

t profile by 
edules and 

n altering and 
 schedule is a 
 make changes 
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selecting a response schedule in the list of response sch
clicking Edit New. 

− Dissociate an existing response schedule from the curren
selecting a response schedule in the list of response sch
clicking Remove Response.

− Load an existing response schedule by clicking Load, the
saving it to suit the current monitoring profile. A loaded
standalone copy of the original response schedule. If you
to the loaded (copied) schedule, changes to it only affect
profile to which it is attached. When you modify the resp
you are asked to give it a new name. The schedule is id
name when loading or linking to it from other monitorin

− Link to an existing response schedule by clicking Link to
settings to the current monitoring profile. Because the m
profile is only linked by reference to the response sched
made to the schedule affect every monitoring profile link
Typically, you link to a schedule if several monitoring p
have the same response schedule applied and you do n
enter the settings for each profile.

Conversely, you can unlink from an existing profile by c
to dissociate the current monitoring profile from a linked
schedule.



− Save a response schedule by clicking Save to save the response schedule 
settings. Once saved, you can use a loaded or new response schedule 
with other profiles. If you made changes to a linked profile, saving 
these changes affects all other profiles to which the response schedule 
is linked.

4. If necessary, add another response schedule for the current response state, 
or add a response schedule for another state.

It now 

cify 

the 

ilable 
n use this 
om this list. 

log box’s 

chedule 
dure could 

Note
You can add more than one response schedule for a given response state. 
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5. Click Finish to complete your Alerting and Monitoring profile. 
appears in your Profile Description list in the Main Console.

Adding a Response Schedule
You can create a response schedule:

• While creating a new Monitoring and Alerting profile in the Spe
Response Settings dialog box.

• While editing an existing Alerting and Monitoring profile using 
Response Settings tab. 

When a response schedule is complete, its name appears in the Ava
Schedules list in the Select a Response Schedule dialog box. You ca
response schedule with the current or other profiles by selecting it fr

If the response schedule appears in the Edit Response Schedule dia
list, then it is active for the current Alerting and Monitoring profile.

The following procedure follows the steps for creating a response s
while editing an existing Alerting and Monitoring profile. This proce
be followed just as well when creating a new profile.



d Monitoring     119

To create a response schedule:

1. Select an Alerting and Monitoring profile from the Profile Description list in 
the Main Console.

2. Click Edit on the toolbar and select the Response Settings tab.

3. Click the  button located below the check box for a selected response 
state to open the Edit Response Schedule dialog box. 

 dialog box 

 response 
nd click OK to 

 response 
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4. Click Add Response. The Select Response Configuration(s)
opens. 

5. To use an existing response configuration, select an existing
configuration from the list at the bottom of the dialog box a
exit. 

6. To edit an existing response configuration, select an existing
configuration and click Edit. Skip to Step 8.

7. To create a new response configuration, click New. 



8. Type a name for the Response Profile. This name will appear in the list of 
Response profiles. You can select it for other Alerting and Monitoring 
profiles.

9. Select one of the following response types:

− This is a single phase Event Response Profile. Select this option to 
create a response configuration that triggers all of its component 
response actions once, simultaneously, before resetting.

− This is a multi phase Escalating State Response Profile. Select this 
 persists for 
 new or 

oose this to 
cording to 
20 to 

ails list, and 
s dialog 

g phase 
actions 
an add new 
se 
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option if the condition that originally triggered the response
a set time, and you wish to escalate to a new phase that has
different response actions.

10. Choose one of the following options:

− New Phase (only available if you selected multi phase). Ch
add a new phase of response actions that will be applied ac
the settings. See “Adding or Editing a New Phase” on page 1
continue this procedure. 

− Edit Phase. Select an existing phase from the Response Det
click Edit Phase to open the Response Profile Phase Setting
box.

11. Click OK.

Adding or Editing a New Phase
With a single phase response configuration, you can edit the existin
(there will always be a default phase called "Single Phase" with no 
configured for it). With a multi phase response configuration, you c
phases or edit existing phases. This procedure assumes the Respon
Configuration Settings dialog box is already open.
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To add or edit a new phase:

1. Click New Phase or select an existing phase and click Edit Phase. The 
Response Profile Phase Settings dialog box opens.

xt box, or edit 
etails list.
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2. Enter a descriptive name in the Display Text (Optional) te
the existing name. This name will appear in the Response D



3. Select from among the following options:

− Add a new action. Click Add Action to open the Select Response 
Action(s) dialog box, in which you may add and configure an action 
using the steps that follow.

in the 
g Response 
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 changes to 
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configuring 
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− Click New to configure a new action and make it available 
Available Response Actions List. See “Adding and Configurin
Actions” on page 123 for detailed instructions on configurin
various types of available response actions.

− Select an action from the Available Response Actions List an
to change the settings for the selected response action. Make
the selected response action as needed. See “Adding and Co
Response Actions” on page 123 for detailed instructions on 
the various types of available response actions.
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− Remove an action. Select an action in the Phase Action List, then click 
Remove Action to remove the action from the list.

− Reorder the action list. Select an action in the Phase Action List, then 
click Move Up or Move Down to specify the order in which you want 
the actions to be applied. Although the actions occur almost 
simultaneously, they are applied in the order in which they appear in 
the Phase Action List.

4. If the Wait N sec. before repeating this phase or escalating response 
mber of 
the next phase.

 phase 

eat this 
a number of 

anges, select 
hanges.

sponse 
ng a profile, or 
can get to this 
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field is available (for multi phase responses only), type a nu
seconds to wait before repeating this phase or escalating to 

5. If the Response Phase Repeat settings are available (for multi
responses only), do one of the following:

− If you want a specific number of repetitions, select Rep
Response Phase N times before escalating and type 
times to repeat.

− If you want the phase repeated until the profile state ch
Repeat this Response Phase until the profile state c

6. Click OK.

Adding and Configuring Response Actions
You can add and configure a response action from the Select Re
Action(s) dialog box. You can access this dialog box while editi
while creating a new profile using the New Profile wizard. You 
dialog box by following the instructions up through Step 3 for “
Editing a New Phase” on page 120.



To add and configure a response action profile:

1. In the Select Response Actions dialog box, click New. The Select Response 
Action dialog box opens with all possible response actions available.

at action 

nse Action” 

 page 129.

138.

ction” on 

ge 141.

u return to 
ured 
ons. 

log box.
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2. Select a response action and the configuration dialog box for th
opens.

− Audio Alert: See “Creating an Audio Alert” on page 125.

− E-mail Alert: See “Creating an Email Alert” on page 126.

− Execute Program: See “Creating an Execute Program Respo
on page 128.

− Multi-Response: See “Creating a Multi-Response Action” on

− Pager Alert: See “Creating a Pager Alert” on page 130.

− Reboot: See “Creating a Reboot Response Action” on page 

− Restart Service: See “Creating a Restart Service Response A
page 140. 

− SNMP Trap Alert: See “Creating an SNMP Trap Alert” on pa

3. Complete the settings for the response action, and click OK. Yo
the Select Response Action(s) dialog box with the newly config
response action appearing in the list of Available Response Acti

4. Click OK. You return to the Response Profile Phase Settings dia
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Creating an Audio Alert
An Audio Alert plays a system sound, such as a beep, when the Alerting and 
Monitoring module detects a change in state of the monitored object or device.

See “Adding and Configuring Response Actions” on page 123 for the steps to 
access the Select Response Action(s) dialog box.

To create an audio alert:

 box.
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e text box.
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name to use 
rofiles. 
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1. Click New to open the Select Response Action (type) dialog

2. Select Audio Alert. The Audio Alert Profile dialog box open

3. Type a name for the audio configuration in the Profile Nam

It may be useful to name this profile something like Aud
Whenever you need an audio alert, you can select it by 
with other response phases for this or other Response p

4. Select the sound to use: 

− System Beep plays a predefined beep.

− Wave File plays a �*@< file. Click Browse to specify the
of the file.



5. Specify the duration by choosing one of the following options:

− Sound for sets the number of seconds that the sound will play. Select 
the number of seconds to play the sound.

− Repeat specifies the number of times to repeat the sound.

6. Click Test to make sure your alert works.

7. Click OK. 
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Creating an Email Alert
An E-mail Alert sends an email message to the address you specify 
Alerting and Monitoring module detects a change in state of the mo
object or device.

See “Adding and Configuring Response Actions” on page 123 for th
access the Select Response Action(s) dialog box.

Note
You must configure your email server settings in the General Optio
box for email alerts to work.
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To create an email alert:

1. Click New to open the Select Response Action (type) dialog box.

2. Select E-Mail Alert from the Select Response Action dialog box. The E-Mail 
Alert Profile dialog box opens.

x.

in the Send To 

 the message in 
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3. Type a description for this alert in the Profile Name text bo

4. Type the email address to which you wish to send the alert 
text box. 

5. Type the text that you want to appear on the subject line of
the Subject text box.

6. Click Customize Message to change the message sent for t
“Customizing Text Messages” on page 142 for details.

7. Click Test to make sure your alert works.

8. Click OK. 



Creating an Execute Program Response Action
The Execute Program response launches a specified program when the Alerting 
and Monitoring module detects a change in state of the monitored object or 
device.

See “Adding and Configuring Response Actions” on page 123 for the steps to 
access the Select Response Action(s) dialog box.

To create a response action:

.

g box. The 
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1. Click New to open the Select Response Action (type) dialog box

2. Select Execute Program from the Select Response Action dialo
Configure Execute/Launch Program dialog box opens.

3. Type a name in the Profile Name text box.

4. Type the path to the executable file or command line in the Pat
Command Line text box. If desired, click Browse to navigate 
executable file.

5. Click OK.
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Creating a Multi-Response Action
A multi-response action carries out a series of response actions when the 
Alerting and Monitoring module detects a change in state for the monitored 
object or device. Response actions can include one or more of the existing 
response action types such as audio alert or pager alert. A response action can 
also consist of another multi-response action.

See “Adding and Configuring Response Actions” on page 123 for more 
g box.

 box.

log box. The 
nse action 

e for this group 

 Select 
figured actions 
Chapter 4 • Alerting an

information about accessing the Select Response Action(s) dialo

To configure a multi-response action:

1. Click New to open the Select Response Action (type) dialog

2. Select Multi-Response from the Select Response Action dia
Response Profile Phase Settings dialog box for a multi-respo
opens.

3. In the Response Group Profile Name text box, type a nam
of response actions. 

4. Click Add Action to open the multi-response version of the
Response Action(s) dialog box, which lists the available con
you can select and add to your multi-response action.



5. Select an existing action in the list and click Select. You return to the 
Response Profile Phase Settings dialog box, and the selected item appears 
in the Response Action List.

x, and the 
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6. Add more actions as needed by repeating Steps 2 and 3.

7. Click OK. You return to the Select Response Action(s) dialog bo
new multi-response alert is added to the Available Response Ac

Creating a Pager Alert
A pager alert sends a page when the Alerting and Monitoring modu
change in state of the monitored object or device.

See “Adding and Configuring Response Actions” on page 123 for th
access the Select Response Action(s) dialog box.
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To create a pager alert:

1. Click New to open the Select Response Action (type) dialog box.

2. Select Pager Alert from the Select Response Action dialog box. The Pager 
Alert Profile dialog box opens.

es with either 
d the page in 

settings. See 
r details.
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3. In the Profile Name field, type a description for this alert.

4. In the Pager Type section, specify the type of pager:

− Select Alpha-Numeric Pager if the pager accepts messag
letters or numbers. Specify the ID number needed to sen
the ID field. 

− Click Advanced if you need to further define the pager 
“Defining Alpha-Numeric Pager Settings” on page 132 fo

− Select Numeric Pager if the pager accepts only messages
If your paging service requires a PIN, type it in the PIN 

− Click Advanced if you need to further define the pager 
“Defining Numeric Pager Settings” on page 134 for detai



5. Specify how your pager can be accessed:

− Select Web if your paging service supports Web paging, then select your 
paging service from the list. 

− If your service doesn’t appear in the list, select the Custom list item, and 
click Advanced to set up your paging service options. “Defining 
Custom Web Paging Settings” on page 134 for details.

− Select Modem to access your pager through a modem connection, then 
type the complete telephone number in the Phone Number text box. 
Click Advanced to display the Modem Settings dialog box if you need 

odem 

e a 
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to modify the default modem settings. See “Changing the M
Settings” on page 136.

6. Click Test to make sure your alert works.

7. Click OK.

Defining Alpha-Numeric Pager Settings
Use the Advanced Alpha-Numeric Pager Settings dialog box to defin
message length or password for alpha-numeric paging.
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To define settings:

1. In the Pager Alert Profile dialog box, select Alpha-Numeric Pager in the 
Pager Type area.

2. Click Advanced in the Pager Type area. The Advanced Alpha-Numeric 
Pager Settings dialog box opens.

your pager will 
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3. Use the Length list box to define the length of the message 
accept.

Most alpha numeric pager will accept messages with up to 1
Some have a higher restriction on the number of characters 
message. If this is the case for your pager, use this setting to
maximum length of the message sent by Firewall Suite your
accept. Select or type the maximum number of characters th
to this alpha-numeric pager.

4. If your service requires a password, type the pager’s passwo
Password text box. 

5. Click Customize Message to tailor the message that is sent f
“Customizing Text Messages” on page 142 for details.

6. Click Time Range to open the Edit Schedule dialog box in 
specify when you want the alert enabled. 



Defining Numeric Pager Settings
You can modify the pager message sent when the device goes down, and the 
message sent if the device has recovered.

To define settings:

1. In the Pager Alert Profile dialog box, select Numeric Pager in the Pager 
Type area.

2. Click Advanced in the Pager Type area. The Advanced Numeric Pager 
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Settings dialog box opens

3. In the Down text box, type the message to be sent when the d
down. The default message is ����.

4. In the Reactivated text box, type the message to be sent when t
reactivated. The default alert is ����.

5. Click Time Range to open the Edit Schedule dialog box in whi
specify when you want the alert enabled.

Defining Custom Web Paging Settings
Use these settings if your paging service supports Web paging, but y
doesn’t appear in the Service Name dropdown list.
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To define custom Web paging settings:

1. In the Pager Alert Profile dialog box, select Web in the Connect to Paging 
Service via area,

2. In the Service Name dropdown list, select Custom.

3. Click Advanced in the Connect to Paging Service via area. The Advanced 
Web Pager Settings dialog box appears.

paging service 
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4. In the HTTP Get Request text box, copy the URL from the 
Web page that provides a paging form. The URL should spe
request, and look something like this:

�		�
$$������.��.���D������	8��.
?�	�4>��	�>I1�4>��>I

In this example, you would type values for date, id, and ms
arguments and the data you use vary according to paging se
“Custom Web Paging Variables” on page 136 for details on u
to include user defined values. 

5. Click Time Range to open the Edit Schedule dialog box in 
specify when you want the alert enabled.

6. Click OK to save your changes and close the dialog box.



Custom Web Paging Variables
If your paging service doesn’t appear in the Web paging service list in the Pager 
Alert dialog box, you can set it up using a custom Web paging alert. You can 
use any of the variables listed below in your custom Web paging settings.

The following table shows the supported variables.

rt, you can 

ect to 

 Phone 

This variable: Does this:

>��.
�����4 Adds a field to the Advanced Web Pager Alert dialog box 

t dialog box.

gers, this is 
r settings 

log box.

. For 

�4
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Changing the Modem Settings
If you need to modify the modem default settings for your pager ale
do so in the Modem Settings dialog box.

To change modem settings:

1. In the Pager Alert Profile dialog box, select Modem in the Conn
Paging Service via area.

2. Enter the complete phone number (area code + number) in the
Number text box.

�������������>� displaying the default value you specify. 

>��> Includes the paging ID specified in the Pager Aler

>#�.> Includes the pager alert message. For numeric pa
the alert specified in the Advanced Numeric Page
dialog box.

>�
#> Includes the phone number used in the Pager dia

88
�������� Indicates that the preceding URL is an HTTP post
example:

�		�
$$������.��.���D������	88��.
?�	
>��	�>I1�4>��>I-����.�4>#�.>�
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3. Click Advanced in the Connect to Paging Service via area. The Modem 
Settings dialog box opens.

s. The pager 
e’s settings. It 
e, �3�, K9�, K9�.

ch data word 
 setting.

 use (odd, even 
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4. Make any needed changes to the following settings:

− Port. Select the port used by the modem.

− Baud Rate. Select the rate of data transmittal (bps).

− Data. Select the number of bits in a data word. 

The default is 7, which is usually right for pager service
service provider can give you a description of the servic
looks something like [?�	�/+J���	%/+;	��/. For exampl

− Stop Bits. Select the number of stop bits terminating ea
(either 1 or 2). This option defaults to the most common

− Parity. Select the type of data checking that you want to
or none).



− Init String. Type any necessary modem initialization string. 

− Dial String. Type the command that tells the modem to start dialing. 

− Dial Prefix. Type any prefix that must be entered before dialing the 
phone number. For example, type 9 if you are required to enter 9 
before dialing the phone number.

− Dial Suffix. If you must enter a suffix such as a dialing code or an 
extension number, type the number here. 

f seconds 

. If your 
ox empty.

ch you can 

 Monitoring 

e steps to 

Note
ould wait 
er of 
.
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− Timeout connection after x seconds. Select the number o
to wait before ending an attempted transmission.

− Wait. Select the number of seconds for each waiting period
connection doesn’t require a waiting period, leave the text b

5. Click Time Range to open the Edit Schedule dialog box in whi
specify when you want the alert enabled.

6. Click OK to save your settings.

Creating a Reboot Response Action
A reboot response action reboots the system when the Alerting and
module detects a change in state of the monitored object or device.

See “Adding and Configuring Response Actions” on page 123 for th
access the Select Response Action(s) dialog box.

You can select the number of seconds that Firewall Suite sh
before entering the suffix. Use commas to specify the numb
seconds to wait. One comma is equal to 2 seconds of delay



d Monitoring     139

To create a reboot response action:

1. Click New to open the Select Response Action (type) dialog box.

2. Select Reboot from the Select Response Action dialog box. The Configure 
Reboot Computer dialog box opens.

.

populates the 

em.

g box.

 check box to 

e number of 
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3. Type a name in the Profile Name text box.

4. Choose Select System to open the Select System dialog box

5.  Navigate to and select the system to reboot. This selection 
System Name text box.

6. If required, type the User Name and Password for the syst

7. Click OK to return to the Configure Reboot Computer dialo

8. Select the Display Warning before Rebooting Computer
set the response.

9. Type the message to display into the text box, and select th
minutes to display the message.

10. Click OK.



Creating a Restart Service Response Action
A restart service response action restarts a Microsoft Windows service when the 
Alerting and Monitoring module detects a change in state of the monitored 
object or device.

See “Adding and Configuring Response Actions” on page 123 for the steps to 
access the Select Response Action(s) dialog box.

To create a restart service response action:

.

ox. The 

lates the 

 dialog box.
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1. Click New to open the Select Response Action (type) dialog box

2. Select Restart Service from the Select Response Action dialog b
Configure Restart NT Service Recovery dialog box opens.

3. Type a name in the Profile Name text box. 

4. Choose Select System to open the Select System dialog box.

5. Navigate to and select the system to reboot. This selection popu
System Name text box.

6. If required, type the User Name and Password for the system.

7. Click OK to return to the Configure Restart NT Service Recovery

8. Select a service from the Select NT Service dropdown list.

9. Click OK.
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Creating an SNMP Trap Alert
If you have an SNMP Management console and the WebTrends SNMP Agent is 
activated, you can have an SNMP trap sent if the device you are monitoring 
fails.

See “Adding and Configuring Response Actions” on page 123 for the steps to 
access the Select Response Action(s) dialog box.

 box.

alog box. The 

me for this 

Options” on 
t.
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To create an alert:

1. Click New to open the Select Response Action (type) dialog

2. Select SNMP Trap Alert from the Select Response Action di
SNMP Alert Profile dialog box opens.

3. Type a name for the SNMP Alert profile in the Specify a na
SNMP Alert Profile text box. 

4. Click Test to make sure your alert works. See “Configuring 
page 291 for details on enabling the WebTrends SNMP Agen



5. To create a custom alert message, click Customize Message. See 
“Customizing Text Messages” on page 142 for more information about this 
feature.

6. Click OK.

Customizing Text Messages
feature 

such as the 
og box 

scribed in 
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Many of the alerting dialog boxes have a Customize Alert Message 
which enables you to change the message used for the alert. 

To change the message:

1. Click Customize Message in the dialog box you’re working in (
E-mail Alert Profile dialog box). A Customize Alert Message dial
appears.

2. Type the new message. You can include any of the variables de
the table below in your message.

3. Click OK..
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The following table shows the variables you can use to customize your 
messages.

Variable Result

>>J!)�="9�?9;0>> Includes the text from the profile’s Description field.

>>G);1�3@-9>> If a host name or IP address has been defined, it is 
included.

en defined, as it 
cluded.

rofile.

 the Device to 

 as down.

onitor has been 

ed for the profile.

ccurred.

 the event.

nt recovery 

nt retry for the 
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>>J)!1>> If a port number for the device has be
is for the HTTP monitor, the port is in

>>-)3=1)!�?9<=09>> Includes the device specified in the p

>>-)3=1)!�1LJ9>> Includes the monitor type specified in
Monitor list.

>>-)3=1)!�;1@19>> Includes the state of the device, such

>>-)3=1)!�;1@19�1=-9>> Includes the length of time that the m
in the current state.

>>-)3=1)!�9<931>> Includes the last event that was logg

>>-)3=1)!�9<931�1=-9>> Includes the time that the last event o

>>-)3=1)!�9<931�-9;;@59>> Includes additional information about

>>!90)<9!L�;1@59>> Includes the number of the most rece
attempt (first, second, or third).

>>!90)<9!L�@119-J1>> Includes the number of the most rece
current recovery attempt.



Formatting the Message
Use��C to put quotation marks around a word or phrase. This example:

�C>>-)3=1)!�9<931�-9;;@59>>�C

puts quotation marks around the results of the event message variable in the 
message sent.

Use ���� to insert a paragraph return.

e current 
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Defining Advanced Monitor Options
Define the dependencies of the current profile on others, disable th
profile, and flush the logs for the current profile.

To define advanced options:

1. On the Main Console, select a profile and click Edit.

2. Select the General tab.
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3. Click Advanced. The Advanced Monitor Settings dialog box opens, with a 
list of all available Monitoring profiles.

 profile 
ces for the 
oes down, the 

he current 

sh Log File to 
you have 
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4. Select the check boxes of any profiles on which the current
depends. The current profile is enabled only when the devi
profiles you select here are active. If one of these profiles g
current profile is disabled. 

5. If desired, select the Disable Profile check box to disable t
profile. 

6. If you no longer need existing log data for reports, click Flu
delete the for the current profile. Use this option only after 
created the reports that you need.

7. Click OK.



Configuring Alerting and Monitoring 
as a Windows Service

If you are running Firewall Suite on a Windows NT, Windows 2000, or Windows XP 
system, Alerting and Monitoring installs as a service. You must configure your 
Windows NT, Windows 2000, or Windows XP system to give Firewall Suite the rights it 
needs.

Monitoring systems over multiple domains is possible as long as the proper 

st have the 

itored

ger.

. 
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trust relationships exist.

Setting up the Required Rights
To run Alerting and Monitoring as a service, the account you use mu
following privileges:

• Act as part of the operating system

• Log on as a service

• Log on locally

To monitor systems remotely, the account you use must also have:

• Administrative rights on the system doing the monitoring

• Administrative rights on each of the systems that are being mon

To set up administrative rights:

1. Select Start > Programs > Administrative Tools > User Mana

2. Select the Policies, User Rights command.

3. In the User Rights Policy dialog box, select the 
Show Advanced User Rights check box.

4. Select Act as Part of the Operating System from the Right list
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5. Click Add and select the account that Firewall Suite uses to run as a service. 

6. Click OK.

7. Select Log on Locally from the Right list. 

8. Click Add and select the account that Firewall Suite uses to run as a service. 

9. Click OK.

un as a service. 

Suite.

ia.
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10. Select Log on as a Service from the Right list. 

11. Click Add and select the account that Firewall Suite uses to r

12. Click OK.

13. Click OK to close the User Rights dialog box.

Running the Service

To run Alerting and Monitoring as a service:

1. Close Firewall Suite.

2. Select Start > Settings > Control Panel.

3. Select WebTrends Alerting and Monitoring for Firewall 

4. Click Start Up.

5. Select This Account.

6. Type a user name and password that meets the above criter

7. Stop and restart the service. Firewall Suite can be restarted.



Monitor Types
The following table lists the monitor types used by Firewall Suite, along with 
each monitor’s default port and the monitoring method used.

Type Purpose Default port Method

All device 
monitors, 
excluding DNS

Test connection Various All device monitors, 
excluding DNS, do a simple 
port connect test unless 

ocol 
vailable and 

onitoring 
quest to the 

the specified 

dvanced 
tion, Alerting 
 will send a 
o the port 
cho Test”) 
t it receives 
onse.
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Advanced Prot
Monitoring is a
enabled.

IP device monitors

BOOTP Monitors a BOOTP 
server. BOOTP gives 
diskless client computers 
the information they 
need to start-up (or 
boot). 

TCP 67

DNS Monitors a Domain 
Name System (DNS). 
DNS translates numeric 
IP addresses into 
domain names. 

UDP 53 Alerting and M
sends a DNS re
DNS server at 
address.

Echo Monitors an Echo server. 
Echo is a basic server 
that sends the client the 
same message it 
received. This is useful 
for troubleshooting 
network communication 
problems where data is 
being corrupted. 

7 If you use the A
Protocol Valida
and Monitoring
specific string t
(“WebTrends E
and ensure tha
the proper resp
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Finger Monitors a finger 
daemon. A finger 
daemon provides 
information about users 
such as the last login 
time, terminal location 
and other information. 

79 If you use the Advanced 
Protocol Validation, Alerting 
and Monitoring ensures that 
it receives a properly 
formatted finger response.

the Advanced 
alidation, Alerting 
ring ensures that 

 a successful 

the Advanced 
alidation, Alerting 
ring ensures that 

 a properly 
HTTP response.

the Advanced 
alidation, Alerting 
ring ensures that 

 a successful 

Type Purpose Default port Method
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FTP Monitors an FTP server, 
which provides users/
visitors remote access to 
files. 

21 If you use 
Protocol V
and Monito
it receives
banner.

Gopher Monitors a Gopher 
server, which provides 
access to WAIS services 
similar to HTTP. 

70

HTTP Monitors a Web server, 
which handles HTTP 
requests from browsers.

80 If you use 
Protocol V
and Monito
it receives
formatted 

HTTPS Monitors a secure Web 
server, which handles 
HTTP requests from 
browsers. 

443

IMAP3 Monitors an IMAP3 mail 
server, which enables 
user to manage remote 
mailboxes. This is a 
simple port connect test.

220

IMAP4 Monitors an IMAP4 
server, which uses 
SMTP to provide remote 
mailbox management.

143 If you use 
Protocol V
and Monito
it receives
banner.



IRC Monitors an Internet 
Relay Chat (IRC) server, 
which provides a system 
for “chatting” on the 
Internet. 

6667

Kerberos Monitors a Kerberos 
server. Kerberos handles 
requests for those using 

88

dvanced 
tion, Alerting 
 ensures that 
ccessful 

dvanced 
tion, Alerting 
 ensures that 
ccessful 

Type Purpose Default port Method
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the Kerberos data 
authentication system. 
Typically, it is used to 
verify the identity of a 
user to a host when 
using Telnet or FTP. 

NFS Monitors an NFS server. 
NFS allows users to 
access shared files on 
remote computers as if 
they were stored locally. 

2049

NNTP Monitors a Network 
News Transfer Protocol 
(NNTP) server that 
enables users to post or 
read messages on a 
newsgroup. 

119 If you use the A
Protocol Valida
and Monitoring
it receives a su
banner.

PING Sends an ICMP PING 
request to the specified 
device and waits for a 
response.

ICMP

POP2 POP2 is a client-side 
email protocol. A POP2 
server stores incoming 
email for client retrieval. 

109 If you use the A
Protocol Valida
and Monitoring
it receives a su
banner.
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POP3 POP3 is a client-side 
email protocol. A POP3 
server stores incoming 
email for client retrieval. 

110 If you use the Advanced 
Protocol Validation, Alerting 
and Monitoring ensures that 
it receives a successful 
banner.

RLOGIN Monitors an RLOGIN 
server, which handles 

221 If you use the Advanced 
Protocol Validation, Alerting 

ring ensures that 
 a properly 
Rlogin response.

the Advanced 
alidation, Alerting 
ring ensures that 

 a successful 

Type Purpose Default port Method
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requests for users 
accessing a remote 
computer. RLOGIN 
enables users to access 
local services.

and Monito
it receives
formatted 

RPC Monitors an (RPC) 
Remote Procedure Call 
used by programs and 
hidden to users.

530

RSH Monitors an Rshell 
server, which allows 
users to access to a Unix 
computer remotely.

222

RWHOIS Monitors a RWHOIS 
server, which can tell 
users about a second-
level domain name and 
allows for recursive 
queries. An experimental 
form of WHOIS. 

4321

SMTP Monitors an SMTP 
server. SMTP servers 
are used to transfer 
Internet email. 

25 If you use 
Protocol V
and Monito
it receives
banner.

SPOP3 A secure version of the 
POP3 mail protocol. 

995



Telnet Monitors a TELNET 
host, which allows users 
to log on and use the 
host services. 

23 If you use the Advanced 
Protocol Validation, Alerting 
and Monitoring ensures that 
it receives a login prompt 
and responds to telnet 
escape codes.

Time Monitors a Time server, 
which is used to return 

13

as the status 
lerting and 

us is UP. 
 Alerting and 
us is DOWN. 

Type Purpose Default port Method
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the current date and 
time. 

UUCP Monitors a server used 
to automatically copy 
files from one Unix 
computer to another. 

540

WHO Monitors a WHO server 
which provides 
information about a 
domain.

513

WHOIS Monitors a WHOIS 
server, which can tell 
users about a second-
level domain name, such 
as the owner of the 
domain. 

43

Windows NT system monitors

NT Service Monitors a Windows NT 
service. If you are 
monitoring remote 
computers, the Windows 
API uses the SMB and/or 
RPC requests to 
operate.

None/SMB If the service h
RUNNING, its A
Monitoring stat
Otherwise, the
Monitoring stat
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NT EventLog Watches for new entries 
matching user specified 
criteria in the NT Event 
log.

You select the system, 
event source, and type. If 
you are monitoring 

None/SMB

quest is sent in 
P manager to 

 agent.

 used to monitor 
and when the 
 value is 

he trap is sent.

ows networking 
ne whether a 
is present /
.

Type Purpose Default port Method
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remote computers, the 
Windows API uses the 
SMB and/or RPC 
requests to operate.

NT 
Performance 
Data

Monitors the Windows 
NT performance data. If 
you are monitoring 
remote computers, the 
Windows API uses the 
SMB and/or RPC 
requests to operate.

None/SMB

SNMP monitors

SNMP Get Monitors the value of a 
SNMP get request 
variable. 

161 The get re
by the SNM
the SNMP

SNMP Trap Monitors an SNMP trap, 
which is sent from the 
SNMP agent to the 
SNMP manager. 

162 The trap is
the agent 
predefined
reached, t

LAN computer monitors

Windows 
System

Monitors presence and/
or accessibility of a 
Windows Networking 
computer on your local 
network.

SMB Uses wind
to determi
computer 
accessible



Netware 
Server

Monitors presence and/
or accessibility of a 
Netware server on your 
local network.

SMB Uses windows networking 
to determine whether a 
computer is present /
accessible.

A valid Netware driver must 
be installed.

Disk and file monitors

Type Purpose Default port Method
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File Monitors a file to which 
you have access. When 
the file size or date 
stamp changes (or does 
not change), a response 
is sent. If you are 
monitoring remote 
computers, the Windows 
API uses the SMB and/or 
RPC requests to 
operate.

None/SMB
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Log File Monitors a user specified 
log file for new entries 
matching user specified 
criteria. Generates an 
event when a new 
matching entry is found. 
This profile type can 

None/SMB

Type Purpose Default port Method
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optionally register a 
down state when the 
specified log file is 
inaccessible. Many 
programs record relevant 
activity in a file called a 
log file. The application 
must allow other 
programs access to its 
log file between writes. 
Monitoring will not be 
possible if an application 
keep its log file(s) locked 
between writes.



ODBC Monitors a remote 
ODBC database 
sources. SQL Server 
and other ODBC data 
sources can be 
configured for a wide 
variety of protocol 
options. Port activity 
depends on the local 

Depends on 
ODBC data 
source

Type Purpose Default port Method
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configuration.

Disk Space Monitors a drive on a 
computer. A response is 
sent if the minimum disk 
space specified can not 
be verified on the 
specified drive. If you are 
monitoring remote 
computers, the Windows 
API uses the SMB and/or 
RPC requests to 
operate.

None/SMB

URL Monitors a specified Web 
page or ftp file for 
availability/content.

TCP 80/
TCP 21
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Chapter 5

Filtering for Focused Reports

clude only the 
 are only 
, and Outgoing 

pes and one or 

e filters ensure 
e defined will 
pt the activity 

 multiple 
ains, you might 
our multi-home 
 store activity 
de the domain 
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This chapter explains how to use filters to make your reports in
data you need, while excluding the data you don’t need. Filters
available for General Firewall Activity, Incoming Firewall Activity
Firewall Activity profiles.

Filter Basics
When you configure a filter, you can specify one of two filter ty
more filter elements.

Filter Types
There are two possible filter types: Include and Exclude. Includ
that only activity in the log file that matches the criteria you hav
be processed. Exclude filters ensure that all log file activity exce
matching the criteria you specify will be processed. 

For example, if you have a multi-home log file (one that crosses
domains) and you want to store activity for only one of its dom
create an include filter to include data for only one domain. If y
log contains activity for three of your domains, and you want to
for two of them only, you might create an Exclude filter to exclu
you want to leave out.



Filter Elements
A filter element defines one of the criteria used for filtering. 

For example, suppose the firewall log includes events for more than one 
firewall. If you wanted to filter the log file data to view only events related to 
one firewall, you could create an Include filter specifying that firewall. To do 
so, you would create an Include filter and select the Firewall Name filter 
element, specifying the name of the firewall you want to include.

You can find a complete list of available filter elements in “Filter Elements” on 
ment 

tain spaces 

 files with a 
nd so on.

l Suite finds 
the result to 

rent profile 
 and at the 
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page 164. For a full description of each filter element, see “Filter Ele
Descriptions” on page 166.

Formatting Filter Element Criteria
Use a space to separate several entries.

Use quotation marks to enclose filter element criteria entries that con
or commas. For example, the URL:

�����#��	�����.����	#

looks like this as a filter element:

M�����#��	�����.����	#N

Use wildcards to filter groups of items. For example, '�.�� filters all
�.�� extension, while �#�.�'�.�� filters �#�.���.��, �#�.���.��, a

Multi-Element Filters
You can also combine several filter elements in one filter. If Firewal
a match that meets all criteria, it returns the result to you and writes 
the report.

For example, you can filter the data in the log files defined in the cur
for all activity related to the internal IP addresses you have defined,
same time, filter for the occurrence of a particular firewall rule. 
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In this case you would first select the Include filter type and the Internal 
Address filter element. You would then place an asterisk (') in the Internal 
Address text box to indicate all internal addresses. See “Formatting Filter 
Element Criteria” on page 158. Next, you would select the Rule filter element. If 
Firewall Suite finds a match that meets both criteria, it returns the result to you 
and writes the result to the report.

When you select more than one filter element, Firewall Suite reads the elements 
as Boolean AND statements. For example, if Log File Activity matches Filter 

xclude the 

ple filters of the 
at if the criteria 
ort.

e. The result of 
ters are 

m your 
. 

include all 
hen create a 
artment using 
 IP addresses 

 Firewall Suite 
 and writes the 
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Element1 AND matches Filter Element2 AND... then include or e
result in the report.

Combining Multiple Filters
Firewall Suite lets you combine multiple filters in a profile. Multi
same type are processed with Boolean OR logic. This means th
of any one of the filters is met, the record is included in the rep

You can also combine include and exclude filters within a profil
this combination is dependent on the sequence in which the fil
processed. Include filters are always processed first.

For example, you might want to look at all outgoing activity fro
organization, except for that of users in the Finance department

In this case, you would create an include filter that specifies to 
outbound activity using the Traffic Direction tab. You would t
separate exclude filter that specifies to exclude the Finance dep
the Departments tab. This assumes that you earlier defined the
associated with the Finance department of your organization. If
finds a match that meets both criteria, it returns the result to you
result to the report.



The include filter selects all outgoing activity, and then the exclude filter filters 
out the Finance department users. 

rofiles, 

 any profile.

n list of the 

filters. For a 

Tip
To create reports on a single log file using different sets of filters, you must use 
a separate profile for each set of filters. Use the Copy option on the File menu 
to copy a selected profile and modify it to specify the desired filter(s).

This filter 
ust delete 
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Working with Filters
This section provides step-by-step instructions for adding filters to p
modifying the settings for filters, and deleting filters.

Adding a Filter to a Profile
To create a more focused report, you can add one or more filters to

To define a filter for a profile:

1. Select the profile that you want to filter in the Profile Descriptio
Main Console.

2. Click Edit.

3. Select the Filters tab in the Edit Profile dialog box. 

4. Select the Include Everything filter, and click Delete.

5. The Include All filter is selected by default. It overrides all other 
new filter to take effect, you must delete the Include All filter. 

6. Click Yes to confirm the deletion.

Note
When you create a profile, the Include All filter is used by default. 
processes and stores all log file data. To use your own filters, you m
the Include All filter because it overrides all other filters.
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7. Click New to open the Type dialog box. 

8. Choose whether to add an Include or Exclude filter.

9. Click Next. The Title dialog box opens. 

10. In the Name text box, type a unique name to identify the filter in the 
Filters tab. 

11. Click Next. The Elements dialog box opens. 

de in this filter. 
her you are 

ou may 
for the activity 
tions” on 
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12. Select the Include (Exclude) activity based upon option.

13. Select the check box for each filter element you want to inclu
The specific filter elements available vary according to whet
using a general, incoming, or outgoing profile.

14. Click Next to display the individual dialog boxes in which y
configure the filter elements you selected. Enter the criteria 
you want to filter in this profile. See “Filter Element Descrip
page 166 for details about each filter element.



15. After you have defined the filter criteria in the Filter Elements dialog boxes, 
the Summary dialog box opens. Click Back if you need to back up and 
make adjustments.

16. Click Finish to return to the Edit Profile window.

Modifying a Filter
You can change the filter criteria if you want to change the results. 

file that has 

ify.
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To modify a filter:

1. In the Profile Description list of the Main Console, select the pro
the filter that you want to modify. 

2. Click Edit. The Edit Filter dialog box opens.

3. Select the Filters tab, then select the filter that you want to mod
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4. Click Edit. The Filter Properties dialog box opens with the General tab 
selected. Select and clear the check boxes to add or remove filter elements. 
A tab will appear for each filter element that you select. 

5. Select the filter elements tabs to make changes to the criteria of specific 
elements. 

6. When you have made your changes, click OK. 

e defined 
u no longer 

 profile that has 

st of existing 

 delete the 
d filter.

Note
ase and update 
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Deleting a Filter
Firewall Suite looks for data that matches all the criteria you hav
through your filters. You can remove a filter from a profile if yo
want to use it.

To delete a filter:

1. In the Profile Description list of the Main Console, select the
the filter that you want to delete.

2. Click Edit.

3. Select the Filters tab in the Edit Profile window.

4. Select the name of the filter that you want to delete in the li
filters.

5. Click Delete.

6. When you are prompted to confirm your action, click Yes to
selected filter or No to continue without deleting the selecte

If you are using FastTrends technology, clear the existing datab
it after editing a filter.



Filter Elements

Overview
The table lists each filter element, along with a short description of the filter 
criteria and the profile types with which the filter can be used.

Filter element Specifies: Profile types 
ed

icated 
e

y

g

g

g

g

g

g

 (Check 
N-1/

-1 only)
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support

Actions Firewall actions based on categorization. 
Only for firewalls using WELF format.

Actions

Authenticated 
Username

Authenticated users. This filter is useful if 
your Web site requires visitors to log on with 
a user names and password.

Authent
Usernam

Browser Spider or robot. Browser

Category Web site content. Categor

Day and Time Hour of the day for each day of the week. General

Incomin

Outgoin

Department Departments in your organization, broken 
down by domain name. 

General

Outgoin

Directory A particular directory on your Web site. Incomin

External User 
Address

Specific domains or IP addresses coming 
from outside the firewall.

General

File A particular file name or type on your Web 
site, for example �.��. 

Incomin

Outgoin

Firewall Actions Check Point VPN-1/Firewall-1 actions. 
Actions can include responses to logon 
attempts or data transfers.

General
Point VP
Firewall
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Firewall Name Activity for a specific firewall. This is useful if 
your firewall log file includes events for more 
than one firewall.

General

Internal User 
Address

Hits from specific domains or IP addresses 
behind the firewall.

General

ming

going

ming

ming

eral

going

eral

eral

Filter element Specifies: Profile types 
supported
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Multi Homed 
Domain

Domains. Inco

Proxy Cache Codes associated with the request. Out

Referrer Entire user session coming from the 
specified referrers. Using this, you can 
establish the effectiveness of your Internet 
advertising.

Inco

Return Code Browser return codes. The log file records 
the results received from browsers, which 
are called return codes.   

Inco

Rule Specific firewall rule. A rule identifies what 
activities and protocols are allowed through 
the firewall. They are usually identified by a 
number and vary from firewall to firewall.

Gen

Sites A specific Web site or group of sites to 
include or exclude in your report (for 
example  '���
).

Out

Status Codes Status codes. These are numeric responses 
to attempts made to logon to the network to 
perform an activity or access a service.

Gen

Traffic Direction Where the activity was initiated. This can be 
either inbound or outbound.

Gen



for firewalls 
ay block 

ng to visit a 
) site.

Type of Traffic Protocols associated with traffic. General

User Address or 
Country

Domains, IP addresses, or countries from 
the results of this profile. 

Incoming

Users by IP Activity of specific computers according to 
their IP address.

Outgoing

Filter element Specifies: Profile types 
supported
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Filter Element Descriptions

Actions
The actions filter relates to URL categorization and is only available 
using WELF format. Based on how a site is categorized, a firewall m
that site or allow access to it. The firewall logs the action of attempti
blocked site as well as the action of visiting an approved (or passed



sed Reports     167

The Actions filter element includes data on those firewall actions in the report, 
or excludes that data from the report. 

visits. If you do 

rized sites. 

Note
The Actions filter element is available only for firewalls using WELF format.
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To add an Actions filter element:

1. The default includes both possible values (') and reports all 
not want to accept the default, type one of the following: 

− Block reports the attempts to visit blocked sites. 

− Pass reports visits to all other sites, including non-catego

2. Click Next.



Authenticated Username
If you have a secure site that requires visitors to log on with a user name and 
password, you can use the Authenticated Username filter element to include or 
exclude authenticated users from the report. Use quotations mark around any 
authenticated user name that includes a space. For example, type O����#�	� to 
filter the authenticated user janesmith, but type “Jane Smith” to filter the 
authenticated user Jane Smith.

 want to 
parate 
box if you 
e case-
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To include or exclude all authenticated user names:

1. Select Include or Exclude Only Authenticated Users.

2. Click Next.

To include (exclude) specific authenticated user names:

1. In the Authenticated Username text box, type the names you
filter. Put quotation marks around names that contain spaces. Se
individual entries with spaces. Select the Case Sensitive check 
want to look for exact case matches. Most servers do not requir
sensitive matches.

2. Click Next.
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Browser
Use the Browser filter element to either include or exclude a browser, spider or 
robot from the report. You can filter for any browser if you know how it 
appears in the �.��	 field of the log file.

To define a Browser filter element:

1. In the Browsers text box, type the name of the browser you want to filter 
ct common 
ple browsers. 
n spaces. For 
de or exclude 

te assumes that 
ing it to the 

n in your 
n. You can 
 and liability 

ults because 
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as it appears in the log file, or use the dropdown list to sele
browsers, spiders, and robots. Use a space to separate multi
Use quotation marks to surround browser names that contai
example, type C-�������	�=�	����	�9�������$��N to inclu
any activity that matches Internet Explorer v4.x.

Wildcards are not supported for Browser filters. Firewall Sui
wildcards at either end of each browser entry when compar
�.��	 field in the log file. 

2. Click Next.

Category
Use the Category filter element to include or exclude informatio
reports about sites visited by users from inside your organizatio
monitor Internet usage by category for bandwidth, productivity,
concerns. 

Note
Filtering for Netscape Navigator may not return accurate res
many browsers identify themselves as Netscape Navigator.



The Category filter element lets you generate a report for all activity related to 
categorized sites, or limit the reports to specified categories. 

 

ou want to 
egories

r commas.

egories and 

Note
The categories available for filtering depend on the category databases that you 
download. Click Examples in the Add Filter—Category dialog box for a list.
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To define a Category filter element:

1. In the Category text box, type the names of the categories that y
include or exclude in your reports. The default is to filter all cat

− Separate categories with spaces.

− Put quotation marks around categories that contain spaces o

2. Click Next.

See “URL Categorization” on page 50 for more information about cat
category databases.
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Day and Time
The Day and Time filter element includes or excludes activity according to the 
day of the week and the time of day. 

lue box 
gh Friday, 8:00 
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To define a Day and Time filter element:

1. Click on boxes, or drag rows or columns to select them. A b
indicates an hour is selected. The figure shows Monday throu
a.m. to 5:00 p.m. selected.

2. Click Next.



Departments
The Departments filter element includes or excludes departments from your 
analysis and reporting. For example, you can find out which department is 
using the Internet the most.

t you want 

ment dialog 
ement” on 
172     User Guide

To define a Departments filter element:

1. Use the Department dropdown list to select the department tha
to include or exclude. 

Any departments already defined using the Department Manage
box appear in the dropdown list. See “Using Department Manag
page 90 for information about setting up departments.

2. Click Next.
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Directory
Use the Directory dialog box to include or exclude the activity of a specific 
directory. 

be filtered. Use 
s with a 
ain spaces. For 

ectories starting 
ry text box. 

clear the Also 
ewall Suite will 

matches. Most 
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To define a Directory filter element:

1. In the Directory text box, type the path for the directory to 
wildcards to specify multiple directories. Separate directorie
space.Put quotation marks around directory names that cont
more information, see the table of Directory filter examples.

By default, an include directory filter element includes all dir
at the root directory, indicated by a slash ($) in the Directo
There is no default for an exclude directory filter.

2. If you do not want to include or exclude all subdirectories, 
Include/Exclude Subdirectories check box. Otherwise, Fir
activates the subdirectories by default. 

3. Select the Case Sensitive check box to look for exact case 
servers do not require case-sensitive matches.

4. Click Next.



The following table shows examples of Directory filter definitions.

Example Result

$�#�.�� Specifies the directory $�#�.�� is to be included or excluded. 
If Include Subdirectories is selected, all subdirectories of /
images will also be included or excluded.

M$�#�.�������N Specifies the long directory $�#�.�������.

M$�#�.�������N�$ Specifies the directories $�#�.�������, $��	����	, and 

s in 
t 

�����, such 
��, but not 

uch as
ectories is 

ies named 
�, and 
s such as 

nly if 

aining 
����, and 
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��	����	�$.������� $.�������.

$'.������� Specifies any first-level directory whose name end
.�������, such as $(�	#���.�������, but no
$��	����	$(�	#���.�������.

$'$.������� Specifies all second-level directories named $.��
as�$��#�$.������� and�$��	����	$.�����
$��#�$�����$.�������. Includes directories s
$��#�$.�������$��.�� only if Include Subdir
selected. 

$.��������$'$
.��������$'$'$
.�������

Specifies all first-, second-, and third-level director
graphics, such as $.�������,  $��#�$.������
���#�$�����$.�������. Includes subdirectorie
$��#�$.�������$��.�� and�
$��#�$�����$.�������$��.��$�������� o
Include Subdirectories is selected. 

$'.�������'$ Specifies all first-level directories with names cont
.�������, such as�$.�������,�$.���������
$(�	#���.�������.
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External User Address
Use the External User Address filter element to include or exclude activity from 
specific domains or IP addresses outside the firewall. For example, you can 
create a filter that includes activity from a questionable IP address if you think 
someone is trying to break into your firewall. 

 that you want 
er address. The 
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To define an External User Address filter element:

1. In the External User Address box, type the user addresses
to specify, or use the dropdown list to select a predefined us
default setting is All User Addresses ('). 

2. Click Next.



The following table shows examples of how to specify user addresses.

Example Result

������B������A�� Specifies all numeric IP addresses from 204.245.240.0 through 
204.245.240.63

������B������A
������B�������

Specifies all numeric IP addresses from 204.245.240.0 through 
204.245.240.64

������B�������$�� CIDR notation. Specifies all addresses of the classless subnet: 

rough 

ars to the left 
 and 
 subdomain. 

ith or without 

ames in filter 
ps are being 

#, or ��	.

ain.
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204.245.240.64 - 204.245.240.127.

�������K���$�� Specifies all subnet addresses from 111.92.76.0 th
111.92.76.63.

'�*�(1��������# Only those addresses with a subdomain that appe
of this domain, for example www.WebTrends.com
ftp.WebTrends.com. Excludes addresses without a

'*�(1��������# Any address that includes the specified domain, w
a subdomain, for example www.WebTrends.com, 
ftp. WebTrends.com, or WebTrends.com. 

Tip: 
You can specify IP addresses as well as domain n
text boxes if you are uncertain whether DNS looku
performed. 

'���
�'���#�'���	 All addresses that have the domain types ��
, ��

'��� All addresses from Germany. 

����' Only those addresses that have ��� as a subdom
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File
Use the File filter element to include or exclude specific files. 

ect a file type 
ile names or 
.��). You can 
en each file 

 files, indicated 
ude filter.

ck box to 
ple, if a visitor 

rver may log 

lso Include 
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To define a File filter element:

1. In the Files text box, type the file name or extension, or sel
from the dropdown list. Use wildcard characters to specify f
extensions, such as all HTML files ('��	#) or all 5=� files ('�
specify several file types at once by inserting a space betwe
type. 

The default for an Include files filter element is to include all
by '�'�in the Files text box. There is no default for an excl

2. Select the Also Include Requests Without Filenames che
include activity in which no filenames are specified. For exam
to your site accesses �		�
$$����#%��#������#, the Web se
this hit without a file name, but return the file 
�		�
$$����#%��#������#�����
�	��	#. 

Note
If you used the default setting for your filter, selecting the A
Requests Without Filenames check box has no effect. 



3. Select the Case Sensitive check box to look for exact case matches. Most 
servers do not require case-sensitive matches.

4. Click Next.

The following table shows examples of how to specify files.

Example Result

������	# Filters the file ������	#.
178     User Guide

'�.���'�(#� Filters bitmap (�(#�) and gif (�.��) files.

����'��	#� Filters all html files whose name begin with 
����.

����'�' Filters all files whose name begin with ����, 
regardless of file type.

#��,�	��.��	#�
M#��,�	��.�
������	#N�
M#��,�	��.�
�������	#N

Filters the files�#��,�	��.��	#, 
#��,�	��.�������	#, and 
#��,�	��.��������	#. 
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Firewall Actions
Use the Firewall Actions filter element to include or exclude Check Point VPN-
1/Firewall-1 actions such as responses to logon attempts or data transfers.

r exclude. 

Note
Use the Firewall Actions filter element with Check Point VPN-1/Firewall-1 only. 
All other firewalls use the Status Codes filter.
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To define a Firewall Actions filter element:

1. Select the check box for each actions you want to include o

2. Click Next.



Firewall Name
The Firewall Name filter element includes or excludes activity for a specific 
firewall from analysis and reporting. If your firewall log file includes events for 
more than one firewall, you can use this element to look at the activity for a 
single firewall.

actly as it is 
 address.
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To define a Firewall Name filter element:

1. In the Firewall Name text box, type the name of the firewall ex
recorded in the log file. The name is either a text name or an IP

2. Click Next.
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Internal User Address
The Internal User Address filter element includes or exclude hits from specific 
domains or IP addresses behind the firewall. You could use this filter element to 
focus your reports on the activity of one or more people. The default, All User 
Addresses, is indicated by an asterisk (') in the text box. 

sses that you 
e a hyphen to 
rd. 
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To define an Internal User Address filter element:

1. In the Internal User Address text box, type the user addre
want to specify. Separate multiple addresses with spaces.Us
indicate a range of addresses.Use an asterisk (') as a wildca

2. Click Next.



The following table shows examples of internal user addresses.

e same 
veral Web 
ress owned 

Example Result

������B������A�� Specifies all numeric IP addresses from 204.245.240.0 through 
204.245.240.63.

������B������A
������B�������

Specifies all numeric IP addresses from 204.245.240.0 through 
204.245.240.64.

������B�������$�� CIDR notation. Specifies all addresses of this classless subnet: 

rough 

 appears to 
om, or ftp. 

ubdomain. 

ith or without 

ames if you 
formed. 

 ��	.

ain.
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Multi-Homed Domain
Usually, there is only one Web site on a domain (they often have th
name). In some situations, however, a single IP address can host se
sites and its log files contain entries related to all of them. An IP add
by an Internet service provider is an example. 

204.245.240.64 - 204.245.240.127.

�������K���$�� Specifies all subnet addresses from 111.92.76.0 th
111.92.76.63.

'�*�(1��������# Only those addresses that have a subdomain that
the left of this domain, such as www. WebTrends.c
WebTrends.com. Excludes addresses without a s

'*�(1��������# Any address that includes the specified domain, w
a subdomain, such as www. WebTrends.com, 
ftp. WebTrends.com, or WebTrends.com. 

Tip: 

You can specify IP addresses as well as domain n
are uncertain whether DNS lookups are being per

'���
�'���#�'���	 All addresses with the domain types ��
, ��#, or

'��� All addresses from Germany. 

����' Only those addresses that have ��� as a subdom
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To create a report that analyzes data from only one or selected Web sites from a 
particular IP, use the Multi-Homed Domain filter. This filter element lets you 
specify the domains you want to include or exclude. For example, if your multi-
homed log file contains activity from these domains:

�����(����#
����������#
����.�����#

but you want to report only on �����(����#, create an include filter and specify 

ou want to 
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�����(����#.

To define a Multi-Homed Domain filter element:

1. In the Domains text box, type the names of the domains y
include or exclude. Put a space between domain names.

2. Click Next.



Proxy Cache
Use the Proxy Cache Codes filter element to include or exclude log records 
based on proxy cache codes. The default for an include filter element is All 
Proxy Status codes, indicated by an asterisk (') in the Proxy Cache Codes box. 
There is no default for an exclude filter.

t to exclude 
rate 
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To define a Proxy Cache filter element:

1. In the Proxy Cache Codes text box, specify the codes you wan
or include, or select a set of codes from the dropdown list. Sepa
multiple entries with spaces. 

2. Click Next.
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The following table shows the definition of each proxy cache code.

Option Description

All Proxy Status Values Includes or excludes records that have a proxy status value.

From the Internet 
(Summary)

Includes or excludes records that have a status value 
indicating that the file requested was downloaded from the 
Internet.

us value 
ded from either 

tream proxy 

us value 

us value 
ded from the 
’s cache for 
ile was not 

us value 
ded from the 
’s cache for 
der version of the 
nd was updated 

us value 
present in the 

ote server to 
.

us value 
present in the 
 remote server to 
.
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From the Cache 
(Summary)

Includes or excludes records that have a stat
indicating that the file requested was downloa
the local proxy server’s cache or from an ups
server’s cache.

Cache Unknown Includes or excludes records that have a stat
indicating that the cache is not known.

From the Internet, then 
cached (new)

Includes or excludes records that have a stat
indicating that the file requested was downloa
Internet and then placed into the proxy server
possible future use. It also indicates that the f
present in the cache before downloading it.

From the Internet, then 
cached (updated file)

Includes or excludes records that have a stat
indicating that the file requested was downloa
Internet and then placed into the proxy server
possible future use. It also indicates that an ol
file was in the cache before downloading it, a
by the newer version.

From the cache, verified 
by remote server

Includes or excludes records that have a stat
indicating that the file requested was already 
cache, and the proxy server contacted the rem
verify that it was the newest version of the file

From the cache, without 
verification

Includes or excludes records that have a stat
indicating that the file requested was already 
cache and the proxy server did not contact the
verify that it was the newest version of the file



Resource not cacheable Includes or excludes records that have a status value 
indicating that the file requested was downloaded from the 
Internet and was not added to the proxy server’s cache.

Cache write aborted Includes or excludes records that have a status value 
indicating that the file requested was downloaded from the 
Internet, and while the file was being added to the cache, 
something happened that caused the proxy server to cancel 
writing the file.

lue 
e cache. No 

lue 
proxy array 

lue 
proxy 
orted on.

lue 
 from the 

lue 
nection with 

lue 
nection and 

lue 
ection 

lue 
nection 

Option Description
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From the cache, no details Includes or excludes records that have a status va
indicating that the file requested was already in th
other details were given.

Returned from array 
member cache

Includes or excludes records that have a status va
indicating that the file requested was present in a 
member cache.

Returned from upstream 
cache

Includes or excludes records that have a status va
indicating that the file requested was present in a 
server’s cache upstream from the proxy server rep

From the Internet, no 
details

Includes or excludes records that have a status va
indicating that the file requested was downloaded
Internet. No other details were given.

Successful connection Includes or excludes records that have a status va
indicating that the client initiated a successful con
the proxy server.

Connection rejected by 
proxy server

Includes or excludes records that have a status va
indicating that the client attempted to initiate a con
was rejected by the proxy server.

Normal connection 
termination

Includes or excludes records that have a status va
indicating that the proxy server terminated a conn
normally.

Abortive connection 
termination

Includes or excludes records that have a status va
indicating that the proxy server terminated the con
abnormally.
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Referrer
The Referrer filter helps you analyze the number and quality of users coming to 
your site from other sites or from a specific Internet advertisement link. With 
this filter you can establish the effectiveness of your Internet advertising. 

Firewall Suite looks for exact case-insensitive matches.

hem from the 

f the URL string 
want to specify 

s with referring 
ilter element 
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To define a Referrer filter element:

1. In the Referrer text box, type the referring URLs or select t
dropdown list. Separate multiple referrers with a space.

You can use an asterisk (') as a wildcard at the beginning o
to include all protocols. Append the asterisk wildcard if you 
all activity from a referrer. For example, type:

�		�
$$����%�������#'�

By default, the include referrers filter element includes all hit
data regardless of site. The default for the exclude referrer f
excludes only hits without any referring information.

2. Click Next.



The following table shows examples for filtering referrers

gle page.

Examples Result

�		�
$$���������������#' Filters any activity coming from http://
www.referrer.com.

Excludes hits from ftp://www.referrer.com.

�		�
$$�������������' Filters www.referrer.com, www.referrer.net, 
www.referrer.org, and other sites beginning with 
www.referrer.

om. 
om and 

, for 
r.net, 

 referrer.

t the 

l,or 
errer.com 

tml from 
r.com and 

��	#�.

��O�..

ating from 
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The following table shows examples for filtering referrals from a sin

'������������#' Filters ftp.referrer.com or www.referrer.c
Excludes sites such as www.referrer2.c
www.referrer.net.

'��������' Filters any site with referrer in the name
example www.referrer.com, www.referre
www.notreferrer.com, referrer.com, and

�		�
$$���������������#$
��.���	#

Filters only references from page.htm a
www.referrer.com site.

�		�
$$���������������#$
��.���	#'

Filters sites such as page.htm, page.htm
page.html2 from the root of the www.ref
domain.

'������������#$��.���	#' Filters sites such as page.htm or page.h
referrer.com domains such as ftp.referre
search.referrer.com.

Example Result

����	#� Filters only references from the page ��

'���' Filters hits referred from ����	#�, 
%������������	#, ����.��, and #�

'�����	���	#� Specifies only the referring URLs origin
the �����	���	#� pages.
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Return Codes 
The log file records browser activity in the form of return codes. You can 
include or exclude browser activity in reports by including or excluding the 
return codes. 

t Success Only 
 with a 404 
ld help you 
have removed 

es, or use the 
return codes. 
 The default, 

.
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For example, if you want to report only on successful hits, selec
from the dropdown list. To find out about all hits that ended up
code, Failed Not Found, filter on the 404 return code. This wou
identify sites that have outdated references to material that you 
from your site.

To define a Return Code filter element:

1. In the Return Codes text box, type one or more return cod
dropdown list to select common return codes, or groups of 
Separate return codes by spaces. You cannot use wildcards.
indicated by an asterisk ('), is All Return Codes.

See the table for a list of return codes and their descriptions

2. Click Next.



The following tables shows return codes that can be filtered.

Code Description

' All Return Values

��� Success, OK

��� Success, Created

��� Success, Accepted
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��� Success, Partial Information

��� Success, No Response

��� Success, Redirected

��� Success, Moved

��� Success, Found

��� Success, New Method

��� Success, Not Modified

��� Failed, Bad Request

��� Failed, Unauthorized

��� Failed, Payment Required

��� Failed, Forbidden

��� Failed, Not Found

B�� Failed, Internal Error

B�� Failed, Not Implemented

B�� Failed, Overloaded Temporarily

B�� Failed, Gateway Timeout
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Rule
The Rule filter element includes or excludes the analysis and reporting on a 
specific firewall rule. A rule identifies what activities and protocols are allowed 
through the firewall. They are usually identified by a number.

to filter for. 
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To define a Rule filter element:

1. In the Rules text box, type the firewall rules that you want 
Separate multiple rules with spaces.

2. Click Next.



Sites
Use the Sites filter element to include or exclude a specific Web site or domain 
type for this analysis. For example, you might use the Sites filter element to 
report on the activity for your own intranet. Create an Include filter and specify 
the URL for your intranet, for example ������	����	���#���%���#. The 
resulting report shows only hits to your site.

exclude, or 
tensions. 

 putting an 
 to specify 

pe:
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To define a Sites filter element:

1. In the Sites text box, type the sites that you want to include or 
use the dropdown list to select common domain and country ex
Separate multiple entries with spaces. Specify multiple URLS by
asterisk (') wildcard ahead of or trailing an entry. For example,
all sites with����
 in the domain name, type:

'���


Separate individual URLs with a vertical bar (&). For example, ty

��������	���#&�������������#

2. Click Next.
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Firewall Status Code
Use the Firewall Status Codes filter element to include or exclude status codes 
from the analysis and reporting for this profile. Firewall status codes are 
numeric responses to attempts made to logon to the network. For example, 
status codes could indicate a problem on the network or someone abusing 
public space.

s that you want 
nge by using a 
rds are not 

stallation 
mple: 
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To define a Firewall Status Codes filter element:

1. In the Firewall Status Codes text box, type the status code
to filter. Use spaces to separate the entries. Specify a code ra
hyphen between the first and last codes in the range.Wildca
supported. 

2. Click Next.

Note
Files listing status codes can be found in the root of your in
directory. These files are identified by firewall name, for exa
0����-����.���	�	 and "
���	�-����.���	�	.



Traffic Direction
Use the Traffic Direction filter element to include or exclude activity according 
to where the activity was initiated. 

 or exclude. 

n the 

 on the 
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To define a Traffic Direction filter element:

1. Select a check box for each traffic direction you want to include

− Inbound Traffic filters traffic that is initiated by someone o
outside of the firewall.

− Outbound Traffic filters traffic that is initiated by someone
inside of the firewall (within your organization).

2. Click Next.
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Protocol Family
Use the Protocol Family filter element to include or exclude a particular type of 
traffic from the analysis and reporting for this profile. Use the Protocols dialog 
box in the General Firewall Activity options to create and manage the Protocol 
Families you select for this filter element.

l Family 

ivity.

Note
Only one Protocol Family filter can be used in a profile. Create separate profiles 
Chapter 5 • Filtering for Focu

To define a Protocol Family filter element:

1. Select the protocol that you want to filter from the Protoco
dropdown list. 

− web filters the log file for Internet/Intranet activity.

− e-mail filters the log file for email activity.

− ftp filters the log file for FTP (File Transfer Protocol) act

to filter different protocol types.



− telnet filters the log file for Telnet activity.

− realaudio filters the log file for RealAudio activity.

Any additional protocol families that you set up in the Protocols dialog box 
appear in the list as well. 

2. Click Next.

User Address
IP 
, if you 
t would not 
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Use the User Address filter element to include or exclude domains, 
addresses, or countries from the results of this profile. For example
create an exclude filter and you specify your own domain, the repor
include any activity from your domain.
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To define a User Address filter element:

1. In the User Addresses text box, type the user addresses that you want to 
specify, or use the dropdown list to select predefined user addresses. 
Separate multiple entries with spaces. You can use asterisks (') as 
wildcards. The default, All User Addresses, is indicated by an asterisk (') in 
the text box. See the table for examples of User Address filters.

resses.

Note
eb sites.

e left of this 
WebTrends.com. 

in, with or without 
 

, or ��	. 

in.
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2. Click Next.

The following table shows examples of how to specify user add

Country information is not always accurately reported by W

Example Result

'�'�*�(1��������# Only those addresses with a subdomain to th
domain, such as www.WebTrends.com, or ftp.
Excludes addresses without a subdomain. 

'�'*�(1��������# Any address that includes the specified doma
a subdomain, such as www.WebTrends.com,
ftp. WebTrends.com, or WebTrends.com. 

'�'���
�'���#�'���	 All addresses with the domain type ��
, ��#

'�'��� All addresses from Germany. 

'�����' Only those addresses with ��� as a subdoma



User (IP)
Use the User IP Address filter element to include or exclude activity from 
specific domains, subnets, or IP addresses. For example, you might use the user 
address filter element to focus on the activity of a specific user. 

or domains 
s with 
f IP 
dresses ('). 
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To define a User (IP) filter element:

1. In the User Addresses text box, type the IP addresses, subnets, 
that you want to include or exclude. Separate multiple addresse
spaces. You can use asterisks (') as wildcards to specify a set o
addresses. The default for an include filter element is All User Ad
The table shows User IP address examples.

2. Click Next.
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The following table shows examples of how to specify IP address ranges.

Example Result

������B������A�� Specifies all numeric IP addresses from 204.245.240.0 through 
204.245.240.63.

������B�������P
������B�������

Specifies all numeric IP addresses from 204.245.240.0 through 
204.245.240.64.

classless subnet: 

.0 through 
Chapter 5 • Filtering for Focu

������B�������$�� CIDR notation. Specifies all addresses of the 
204.245.240.64 – 204.245.240.127.

�������K���$�� Specifies all subnet addresses from 111.92.76
111.92.76.63.
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Chapter 6

Working with Reports

ou can start 
ty of reports, 

add new report 

ats. Most of 
rd, or Microsoft 

ing Firewall 
x.

ivity Reports 
lerting and 
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Once you have configured your firewall and created a profile, y
working with reports. With Firewall Suite, you can create a varie
modify report settings, memorize report settings for future use, 
styles, and automate report generation.

Firewall Reports
Firewall Activity Profiles can generate reports in a variety of form
these reports can be viewed and printed in HTML, Microsoft Wo
Excel formats. 

To see the report formats, select a General, Outgoing, or Incom
Activity profiles and click Report to open the Reports dialog bo

Note
The sample profiles include report settings for both Firewall Act
and Alerting and Monitoring Reports. For more information on A
Monitoring Reports, see “Alerting and Monitoring” on page 103.



Generating Firewall Activity Reports
To generate a firewall report:

1. On the Main Console, select a profile from one of the Firewall Activity 
profile lists.

2. Click Report to open the Reports dialog box.

.

tings that 
zed Report 

d loads the 
all Suite 
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3. Select a report from the Available Report Templates list.

An Available Report Template is a collection of saved report set
you can use when creating or scheduling a report. See “Memori
Settings” on page 203.

4. Click Start to generate the report.

Once the data is collected, Firewall Suite launches your browser an
report. If you are generating a Microsoft Word or Excel report, Firew
launches the appropriate program. 
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Reports and Color Depth
To properly display reports, your operating system color palette must be set to 
a minimum color depth of 16 bits. Settings below 16 bits may result in graphs 
where individual pixels can be seen. 

To change color depth:

Right-click on your desktop, then select Properties > Settings > Colors. Make 
sure the color depth is at least 16 bit.

the settings so 

ofile.

ing.
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Memorized Report Settings
When you create a Firewall report, Firewall Suite lets you save 
that you can apply them to other reports at a later time.

To create a new memorized report setting:

1. On the Main Console, select any Firewall or Web Activity pr

2. Click Report to open the Reports dialog box.

3. Click New. The Report Description dialog box opens.

4. Enter a descriptive name for the report setting you are creat

5. Click OK. The New Report window opens. 



6. Select the Report Range tab to open the Report Range dialog box.

add a pre-
the Options 
ns” on 
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7. Do one of the following: 

− Select a pre-defined range from the dropdown list. You can 
defined range to the list in the Report Ranges dialog box of 
window. For more information, see “Report Range Definitio
page 230.



ith Reports     205

− Select Specific Range and type a start and end date and time to set up 
your own time range. “Report Range Definitions” on page 230 shows 
the options available. Make sure the date range you specify corresponds 
to existing dates in the log file.

Notes
Use the format ##$��$%%%% in the Date text box. Use 24-hour time 
format, including seconds (��
##
��) for the Time fields. To correctly 
enter the format, it may be easiest to use the dropdown calendar 

at for the Time 

 Date/Time 
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8. Select the Format tab. The Format dialog box opens.

interface for the Date text box. To enter the correct form
text box, you may also scroll.

If you access your log file remotely via FTP or HTTP, the
ranges read N/A.



9. Select one of the following report formats from the list:

− HTML Document

− Microsoft Word Document

− Microsoft Excel Document

based on 

Note
To generate reports in the Microsoft Word or Microsoft Excel formats, You 
must have Microsoft Office 95 or 97 installed on your computer. Stand-alone 
versions of Word and Excel do not provide the macro language necessary to 
206     User Guide

− Comma-delimited Document

− ASCII Text Document

The HTML report is the quickest to create. All other reports are 
the HTML report.

create these reports.
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10. Select the Save As/Mail To tab to open the Save As/Mail To dialog box, in 
which you identify the destination and name for saved reports. This dialog 
box varies in appearance, depending on which Save Report As option you 
select.
Chapter 6 • Working w



11. Choose from one of the following Save Report As methods:

− To save the file on a local drive or a drive mapped to your computer, 
select file:/// and type a path or browse to the directory where you 
want to save the report.

− To upload the file using ftp, select ftp:// and type a path or browse to 
the directory where you want to save the report. If your ftp server 
requires a login, type the login name and password.

− To send the file an email attachment to the addresse(s) you specify and 
save a copy of the report on a mapped or local drive, select mailto:, 

nd type the 

orts. See 

l server 
tails. 
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browse to the location where you want to save the report, a
email address(es) where you want to send the report.

Notes
You can use date macros to specify the names for saved rep
“Date Macros” on page 353

To send reports as email attachments, you must define emai
settings. See “E-Mail dialog box settings” on page 296 for de
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12. Select the Style tab.

appear at the 

age that you 

all profiles of 
anish, but 

ept of a 
r in reports, for 

ization. Create 
d text for tables 
age Settings, 
nly)” on 
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13. In the Report Title text box, type the title that you want to 
top of your report above the log profile description.

14. Use the Report Language dropdown list to select the langu
want to use for the report. 

Report languages are among the Options made available to 
one type. A language can be English, French, German, or Sp
specific text phrases and titles are also included in the conc
language. The text of titles for tables and graphs that appea
example, are configured as a part of a language. 

You can change report titles to meet the needs of your organ
a custom language for your report that includes the preferre
and graphs. For more information on defining Report Langu
see “Language dialog box settings (firewall activity profiles o
page 310.



15. Use the Report Style dropdown list to select a style from the dropdown 
list. 

Style identifies the colors, fonts, table borders, and other criteria of report 
appearance. You can create a style that uses your organization’s colors and 
logo. Some style selections affect report output. For example, you can 
output one file per section, which creates smaller files and shortens printing 
or download time. You can choose a style that eliminates the table of 
contents, or one that includes the long descriptions of each table and graph. 

For more information about creating your own style to add to this 
9.

and expla-
ort. Report 
he reports 
ion to 
210     User Guide

dropdown list, see “Adding or Editing Report Styles” on page 21

16. Select Report Help Cards if you wish to append a description 
nation of the various report components to the bottom of the rep
Help Cards can help you gain an understanding of how to use t
when you are just starting out, or may provide helpful informat
people receiving the reports.
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17.  Select the Content tab. The Content dialog box opens. Select the check 
box for each report item you want to include in this report. Report Items are 
groups of related tables and graphs.

 

 and graphs to 

graph types are 
bar, standard 
d side stack bar.

t 3D to 
vailable for all 

 increase or 
h (for example, 
).
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18.  Expand the Available Items, and select the individual tables
include. 

For each individual graph: 

− Select a Type of Graph from the dropdown list. Not all 
available for all graphs. The choices may include: stack 
bar, Z-bar, pie chart, area graph, line graph, side bar, an

− Select 3D, to generate a 3-dimensional graph or de-selec
generate a 2-dimensional graph. These options are not a
graphs.

− Enter the # Elements if this option is available. You can
decrease the number of elements to include in your grap
the number of bars for bar charts or slices in a pie chart



− Enter the # Sub-Items if this option is available. You can increase or 
decrease the number of sub-items or elements to include. These are 
detailed data associated with each element item.

− Select the criteria by which to sort the data in the Sort By dropdown list 
if this option is available.

19.  Click OK to save the report settings. You return to the Reports dialog box. 

20. Select the report template you just created and click Start to activate the 
settings you have defined and to generate the report. A Building Report 
progress window opens and shows you the status of your report gener-

 and loads 
xcel report, 

d the report 

 modifying 

w Previ-
en previ-
rt from a 
 report. 
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ation.

After the data is collected, Firewall Suite launches your browser
the report. If you are generating a Microsoft Word or Microsoft E
Firewall Suite launches the appropriate program.

Note
While the report is being generated, you can click Cancel to en
generation.

Notes
See “Alerting and Monitoring Reports” on page 213 for details on
report style and content.

Select any Available Report Template from the list and click Vie
ously Generated Report to quickly view the report if it has be
ously generated. When you use this option, you access the repo
file rather than analyzing the data and completely rebuilding the
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Alerting and Monitoring Reports
There are three types of Alerting and Monitoring reports: 

• The Short report provides a basic activity information for the device 
specified, including how long the device was down and the total up and 
down times for the reporting period. 

• The Complete report provides a complete report on the specified device. 
 time of the 

nitored device. 

ized Report 
 defaults, select 

g the default 
 the report 
scription of the 
o create a new 
3.
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Each alerting event is described in detail, including date and
event, event type, and a description of the responses sent.

• The Summary report provides the current state of every mo

A default setting for each report type is provided in the Memor
dropdown list in the Create Report dialog box. To see the three
an Alerting and Monitoring profile and select Report.

You can override the settings of any memorized report (includin
reports) by changing the values in the text boxes of each tab in
dialog box. The overrides affect only the current report. For a de
report settings to use to override memorized report settings or t
memorized report, see “Memorized Report Settings” on page 20



Creating Alerting and Monitoring Reports
To create an alerting and monitoring report:

1. In the Main Console, select the Alerting and Monitoring profile you want to 
use for the report from the Profile Description list.

2. Click Report. The Reports dialog box opens.

mplates 

r and loads 
xcel report, 
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3. Select the report you want to use from the Available Report Te
list.

4. Click Start to run the report. 

Once the data is collected, Firewall Suite launches your browse
the report. If you are generating a Microsoft Word or Microsoft E
Firewall Suite launches the appropriate program.
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Memorized Alerting and Monitoring Report Settings
You can save new memorized settings for a report. Complete the following 
steps, click Memorize, and name the new group of settings to make them 
available in the memorized report dropdown list. 

To create a new memorized report setting for alerting and monitoring 
reports:

to open the 

 Content dialog 

eport, but you 

ant to create 
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1. Select any alerting and monitoring profile and click Report 
Reports dialog box. 

2. Click the Range and Content tab to display the Range and
box.

3. By default, all alerting activity in the log is included in the r
can specify a range in the Time Range dropdown list. 

4. Select the type of alerting and monitoring report that you w
(short report, complete report, or summary report).



5. Select the Style tab to open the Style dialog box. 

ear at the 

 that you 

le to all 
n, or 
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r in reports, 
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ttings” on 
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6. In the Report Title text box, type the title that you want to app
top of your report above the log profile description.

7. Use the Report Language dropdown list to select the language
want to use for the report. 

Report languages are among the General Options made availab
profiles of one type. A language can be English, French, Germa
Spanish, but specific text phrases and titles are also included in 
of a language. The text of titles for tables and graphs that appea
for example, are configured as a part of a language. 

You can change report titles to meet the needs of your organiza
a custom language for your report that includes the preferred tex
and graphs. See “Alerting & Monitoring - General dialog box se
page 331.

8. Use the Report Style dropdown list to select a style from the d
list. 
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Style identifies the colors, fonts, table borders, and other criteria for report 
appearance. You can create a style that uses your organization’s colors and 
logo. Some style selections affect report output. For example, you can 
output one file per section, which creates smaller files and shortens printing 
or download time. You can choose a style that eliminates the table of 
contents, or one that includes the long descriptions of each table and graph. 

For more information about creating your own style to add to this 
dropdown list, See “Adding or Editing Report Styles” on page 219.

 dialog box.

ur computer, 
 where you 

h or browse to 
 ftp server 
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9. Click the Save As/Mail To tab to open the Save As/Mail To

10. Choose how you want to distribute the report. 

− To save the file on a local drive or a drive mapped to yo
select file:/// and type a path or browse to the directory
want to save the report.

− To upload the file using ftp, select ftp:// and type a pat
the directory where you want to save the report. If your
requires a login, type the login name and password.



− To send the file an email attachment to the addresse(s) you specify and 
save a copy of the report on a mapped or local drive, select mailto:, 
browse to the location where you want to save the report, and type the 
email address(es) where you want to send the report.

box.

erate the 

d loads the 
port, 

Notes
You can use date macros to specify the names for saved reports. See 
“Date macros” on page 362

To send reports as email attachments, you must define email server 
settings. See “E-Mail dialog box settings” on page 296 for details. 

 the report 
ration.

odifying 
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11. Click OK to save your settings and return to the Reports dialog 

12. Click Start to activate the settings you have defined and to gen
report.

Once the data is collected, Firewall Suite launches your browser an
report. If you are generating a Microsoft Word or Microsoft Excel re
Firewall Suite launches the appropriate program.

Note
While the report is generating, you can click Stop Here to create
with the data collected so far, or click Cancel to halt report gene

Note
See “Alerting and Monitoring Reports” on page 213 for details on m
report style and content.
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Customizing Reports
Firewall Suite provides report editors for tailoring your reports:

• The Style Editor modifies the colors, fonts, table frames, and logos used in 
HTML reports. You can create multiple combinations, save them, and apply 
them to different reports. For more information, see “Adding or Editing 
Report Styles” on page 219.

mmon to your 
ports. For more 
eport 

 in each table. 
age 229. 

 as HTML files. 
nts must be 
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• The Language Editor customizes reports with terminology co
organization or creates foreign language versions of your re
information on the language editor, see “Adding or Editing R
Languages” on page 228.

• The Content Editor specifies the tables and graphs included
For more information, see “Modifying Report Content” on p

Adding or Editing Report Styles
Style Editor styles apply only to Firewall Suite reports generated
Reports generated as Microsoft Word or Microsoft Excel docume
edited using those programs.



To add or edit a style:

1. On the Main Console, select Tools > Style Editor to access the Style Wizard 
Introduction dialog box. The steps of the Style Wizard take you through the 
process of creating or changing a report style.

e right side, 
 style.

t Styles list, 
e modified 
nce to save 

ne a new 
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2. The Introduction dialog box displays a list of report styles on th
while on the left, the dialog box shows a sample of the selected

3. This dialog box lets you do a number of tasks related to styles:

− Modify an existing style. Select a style in the Available Repor
then select Edit the Selected Report Style. You can give th
style a new name in the last dialog box of the wizard seque
it, and you can retain the unmodified style as well.

− Define a new style. Select Create New Report Style to defi
style. 
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− Rename an existing style. Select a style in the Existing Styles list, and 
click the Rename button. Type a new name for the style.

− Delete a style. Select a style in the Existing Styles list, and click the 
Delete button. The style is deleted.

4. Click Next. The Color Configuration dialog box opens. 

 the ... button. 

color sample 
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5. Select a background image for your report pages.

a. Select the first Page Background radio button and click
The Open a File dialog box appears.

b. Browse to the desired GIF or JPEG file and select it. 

c. Click Open.

6. Select a color for a page background.

a. Select the second Page Background radio button. The 
buttons display the currently selected color

b. Click the color sample button.



c. When the dialog box opens, select the desired color. 

− Select a color for other page elements and for table elements.

Click the color sample button for each of the desired elements.

7. Click Next. The Font Selection dialog box opens. 

ion. As you 
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8. Use the dropdown lists to identify the fonts for each report sect
change fonts, the sample on the left displays your selections.
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9. Click Next. The Table Layout (for Web Activity Reports) dialog box opens.

 

 Web Activity 

ns that will be 
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This dialog box lets you modify report features for Incoming
and Outgoing Web Activity reports.

10. In the Column Items area of the dialog box, select the colum
included in report tables. 



11. Click Next. The Table Layout (Firewall Activity Reports) dialog box opens.

all Activity 

de long or 
riptions are 
For more 
 profiles 
and 
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This dialog box lets you modify report settings for General Firew
reports.

12. In the Section Description area of the dialog box, you can inclu
short descriptions of each of the tables in the reports. These desc
defined in the Languages dialog boxes of the Options window. 
information, see “Language dialog box settings (firewall activity
only)” on page 310 and “Language dialog box settings (alerting 
monitoring profiles)” on page 337.
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13. In the Sort By area of the dialog box, you can choose to order the columns 
of your tables in ascending order by:

− Events. An action recorded by the firewall and stored in the firewall log 
file.

− Percentage of Events. The percentage of the total number of events that 
an item represents.

− Bandwidth. The amount of activity coming through and leaving the 

ns that will be 

 framed table of 
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firewall, measured in KB transferred.

14. In the Column Items area of the dialog box, select the colum
included in report tables. 

15. Click Next. The Page Layout dialog box opens.

16. Select the Table of Contents Frame check box to include a
contents in HTML reports.



17. Select the way that the report will be saved. 

− Entire report in one file saves the entire report in a single file.

− Each group in its own file saves each group (for example, General 
Statistics, Bandwidth Usage) in a separate file.

− Each chapter in its own file saves each chapter (for example, the 
General Firewall Statistics chapter in the General Statistics group) in a 
separate file.

18. In the Align Number in Table Columns area of the dialog box, choose 
port cells. 

of your 
our report. 

r the report 
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whether to center, left-justify, or right-justify the data in table re

19. Click the browse button to specify the location of a logo for all 
reports. This logo file appears at the bottom of the last page of y

20. Click Next. The Graphing Options dialog box opens.

This dialog box lets you select colors, fonts, and 3-D features fo
graphs.
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21. Use the dropdown lists to select colors for:

− Palette. Select the color scheme applied to the graph itself.

− Background. Select the color behind the graph and behind the legends.

− Text. Select the color of text for headings and labels.

22. Select the 3D features. Click Test to see what your 3D feature selections will 
look like.

nts to appear 

 (the x and y 

ur graph.

ur font selec-

ed to all text: 

, Italic, or 
t style.
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− Size. Select the size in which you want the graph eleme

− Depth. Select the three-dimensional depth of the “cage”
backdrop).

− Cage style. Select the thickness of the cage walls for yo

− Cage wall. Select the color of the cage walls.

23. Select the Graph Font settings. Click Sample to see what yo
tions will look like.

a. Use the Font dropdown list to select the font face appli
Times Roman, Swiss or Modern.

b. Select the check box for the Font Style you want: Bold
Underline. Leave the check boxes clear for Regular fon

c. Use the Size dropdown list to select a font size.



24. Click Next. The Finalization dialog box opens.
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25. Type a name for the report style into the Style Name text box, 
dropdown list to select an existing name.

26. Click Finish to save your settings and exit the Style Editor.

Adding or Editing Report Languages
Use the Language settings in the Options window to modify the de
languages or to customize the words and phrases that appear in rep

• For Firewall and Proxy Server profiles, use the language editor 
General Options dialog box. See “Language dialog box settings 
activity profiles only)” on page 310. 

• For Alerting and Monitoring reports, use the language editor in 
and Monitoring Options dialog box. See “Language dialog box s
(alerting and monitoring profiles)” on page 337. 
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Modifying Report Content
The Content tab in the Edit Report window lets you modify the content of 
sections included in a report.

1. On the Main Console, select the profile with the report you wish to modify, 

eport dialog 

he Content 

to be included 
e it; clear the 

aph to be used. 

o-dimensional 
rsion.

e selected 

tion (such as 
s list to specify 

rized, you can 

Note
The tables and graphs available vary according to profile and firewall type.
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2. Click Report. The Reports dialog box opens.

3. In the Available Report Templates list, Click Edit. The Edit R
box opens.

4. Select the Content tab in the Edit Report window to open t
dialog box.

5. Use the Available Items list to select the tables and graphs 
in the report. Select the check box next to an item to includ
check box to leave it out.

6. Use the Graph Type dropdown list to choose the type of gr
The list shows a thumbnail for each graph type. 

7. Once you have selected a graph type, select 2D to use the tw
version of the graph, or 3D to use the three-dimensional ve

8. Use the Elements list to select the number of elements in th
graph or the number of items in the selected table.

9. If you have selected a table that includes secondary informa
Top Search Keywords with Engine Detail) use the Sub-Item
the number of sub-items to be included.

10. Click OK to save your report settings. Once they are memo
apply them when you are creating or scheduling a report.

11. Click Start to generate the report.



Report Range Definitions
When you generate a report, you can specify the date or time range to include 
in the report. 

The following lost defines the predefined report range definitions.

All of Log
Reports on all data in the log file.

Specify Date/Time
ate to a 
. For 2:30 
urope, use 

nutes.

urs.

9:59. 

:59.

ay up to the 

to Saturday.

t 11:59 
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Reports on the time frame from a specified Start Time and D
specified End Time and Date. Times use the 24-hour format
PM, type  ��
��
��. Dates use the ##$��$%%%% format. For E
��$##$%%%%. For Japan, use %%%%$##$��.

Last 15 minutes
Reports on the activity that has taken place in the last 15 mi

Last hour
Reports on the activity that has taken place in the last hour.

Last 12 hours
Reports on the activity that has taken place in the last 12 ho

Today
Reports on activity for the current day from midnight to 11:5

Yesterday
Reports on the activity for yesterday from midnight to 11:59

This week
Reports on activity for the current calendar week, from Sund
time when the report is started.

Last week
Reports on activity for the last calendar week, from Sunday 

Last 7 days
Reports on activity for the seven calendar days that ended a
yesterday.
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These 2 weeks
Reports on activity from Sunday of the previous calendar week up to 
the time when the report is started.

Last 14 days
Reports on activity for the 14 calendar days that ended at 11:59 p.m. 
yesterday.

Last 2 weeks

month until the 

ple, selecting 
 month of June.

 the time when 

r January–June 

s to the current 
erates a report 
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Reports on activity for the last two calendar weeks.

This month
Reports on activity from the first of the current calendar 
time when the report is started.

Last full month
Reports on activity for the last calendar month. For exam
this range in mid-July will generate a report covering the

Last 30 days
Reports on activity for the last 30 days.

This quarter
Reports on activity for the current calendar quarter up to
the report is started. 

Last quarter
Reports on activity for the last calendar quarter. 

This 6 months
Reports on activity for the current six-month period, eithe
or July–December.

Last 6 months
Reports on the activity for the six-month period previou
one. For example, selecting this range in March 2002 gen
for July–December 2001.



This year (by equal 4-week periods)
Reports on activity from January 1 of the current year to the time when 
the report is started. Each bar in the graph represents a four-week 
period.

This year (by months)
Reports on activity from January 1 for the current year up to the time 
when the report is started. Each bar in the graph represents one month.

Last year (by equal 4-week periods)
Reports on activity for the last full calendar year. Each bar in the graph 

 the graph 

 time when 
dar year. 

e day that 

 day before 

at includes 

r week 
 log file.

g file.
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represents a four-week period.

Last year (by months)
Reports on activity for the last full calendar year. Each bar in
represents one month.

This year and last year (by months)
Reports on activity from January 1 of the current year to the
the report was started plus the activity for the previous calen
Each bar in the graph represents one month.

Last day of log
Reports on all activity from midnight to 11:59:59 p.m. for th
includes the very last entry in the log file.

Previous day of log
Reports on all activity from midnight to 11:59:59 p.m. for the
the day that includes the very last entry in the log file.

Last week of log
Reports on activity from Sunday to Saturday for the week th
the very last entry in the log file.

Previous week of log
Reports on activity from Sunday to Saturday for the calenda
previous to the week that includes the very last entry in the

Last 7 days of log
Reports on activity for the last seven days of entries in the lo
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Last 2 weeks of log
Reports on activity from Sunday of the current week up to the last entry 
in the log file plus the activity for the calendar week previous to the 
current one. 

Previous 2 weeks of log
Reports on activity from Sunday to Saturday for the last two full calendar 
weeks previous to the week that includes the very last entry in the log 
file.

og file.

dar month up 

 of the calendar 
entry in the log 

og file.

dar quarter up 

 of the calendar 
t entry in the 

r year up to the 
esents a four-
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Last 14 days of log
Reports on activity for the last 14 days of entries in the l

Last month of log
Reports on activity from the first day of the current calen
to the very last entry in the log file.

Previous month of log
Reports on activity from the first day through the last day
month previous to the month that includes the very last 
file.

Last 30 days of log
Reports on activity for the last 30 days of entries in the l

Last quarter of log
Reports on activity from the first day of the current calen
to the very last entry in the log file.

Previous quarter of log
Reports on activity from the first day through the last day
quarter previous to the quarter that contains the very las
log file.

Last year of log (by equal 4-week periods)
Reports on activity from January 1 of the current calenda
very last entry in the log file. Each bar in the graph repr
week period.



Last year of log (by months)
Reports on activity from January 1 of the current calendar year to the 
very last entry in the log file. Each bar in the graph represents one 
month.

Previous year of log (by equal 4-week periods)
Reports on activity from January 1 to December 31 for the last full 
calendar year. Each bar in the graph represents a four-week period.

Previous year of log (by months)
Reports on activity from January 1 to December 31 for last full calendar 

lendar day 

r week that 

calendar 
try in the 

very first 

 very first 
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year. Each bar in the graph represents one month.

First day of log
Reports on activity from midnight to 11:59:59 p.m. of the ca
that includes the very first entry in the log file.

First week of log
Reports on activity from Sunday to Saturday for the calenda
includes the very first entry in the log file.

First 2 weeks of log
Reports on activity from Sunday to Saturday for each of the 
weeks in the two-week period that includes the very first en
log file.

First month of log
Reports on activity for the calendar month that includes the 
entry in the log file.

First quarter of log
Reports on activity for the calendar quarter that includes the
entry in the log file. 
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First year of log (by equal 4-week periods)
Reports on activity from January 1 to December 31 of the calendar year 
that includes the very first entry in the log file. Each bar in the graph 
represents a four-week period.

First year of log (by months)
Reports on activity from January 1 to December 31 of the calendar year 
that includes the very first entry in the log file. Each bar in the graph 
represents one month.

em by email. 
 Create Report 

he report from 

 method and 

 dialog box.

u want to save 
button to 
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Specifying a Distribution Method
You can save reports locally, transfer them using FTP, or send th
These methods are specified on the Save As/Mail To tab in the
dialog box.

To save a report locally:

1. In the Main Console, select the profile you want to use for t
the Profile Description list.

2. Click Report. The Reports dialog box opens.

3. Select the report for which you wish to specify a distribution
click Edit.

4. Select the Save As/Mail To tab to open the Save As/Mail To

5. Select file:/// from the dropdown list.

6. In the Save Report As text box, type the file path where yo
the report. If you don’t know the location, click the browse 
navigate to the exact directory.

7. Select another tab or click OK to save your settings.



To transfer the report using FTP:

1. In the Main Console, select the profile you want to use for the report from 
the Profile Description list.

2. Click Report. The Reports dialog box opens.

3. Select the report for which you wish to specify a distribution method and 
click Edit.

4. Select the Save As/Mail To tab to open the Save As/Mail To dialog box.

 root of the 

and 

eport from 

ethod and 

log box.

in the Save 
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5. Select ftp:// from the dropdown list.

6. In the Save Report As text box, type the complete path from the
FTP server. 

7. If the FTP server requires authentication, enter the User Name 
Password.

8. Select another tab or click OK to save your changes.

To send the report by email:

1. In the Main Console, select the profile you want to use for the r
the Profile Description list.

2. Click Report. The Reports dialog box opens.

3. Select the report for which you wish to specify a distribution m
click Edit.

4. Select the Save As/Mail To tab to open the Save As/Mail To dia

5. Select mailto: from the dropdown list.

6. If you want to save a copy of the report locally, type a file path 
To text box or browse to the location.
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7. In the Save Report As text box, type the email address where the report 
should be sent. 

8. Select another tab or click OK to save your changes.

curate statistics 
 become quite 

 include the 
ounts of 

he report from 

tatistics table 

 tab.

Tip
If you routinely send a report to the same group of people, create an alias 
to a list of their email addresses rather than re-typing each address 
separately each time you send the report.
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Limiting Memory Used by Reports
All entries in a log file must be included in the analysis so that ac
can be calculated. The database for some categories of data can
large. 

Determining Memory Usage
To determine which tables are using large amounts of memory,
Debug Statistics table in each report. This table specifies the am
memory used by each table in the report. 

To include the Debug Statistics table in a report:

1. In the Main Console, select the profile you want to use for t
the Profile Description list.

2. Click Report. The Reports dialog box opens.

3. Select the report for which you wish to include the Debug S
and click Edit.

4. When the Edit Report window appears, select the Contents

5. Select the Debug Statistics Table check box.



Limiting Memory Usage

If you have limited system resources or you are analyzing very large log files, 
you can limit the size of some tables to improve performance. This is an 
especially good idea if your analysis appears to “thrash”—a condition charac-
terized by low CPU usage, high hard-disk activity, and slow progress in the 

bles. 

arge 
of elements 

Note
This feature is available for firewall activity reports only.
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analysis. In this case, you may want to limit the size of very large ta

Use the Debug Statistics table to determine which tables are using l
amounts of memory, then limit that usage by reducing the number 
stored for that category.
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To limit the memory used by tables:

1. On the Main Console, select the firewall activity profile used to generate the 
report in Profile Description list. 

2. Select Tools > Limit Memory Usage. The Limit Memory Usage dialog box 
opens.

ile type, the 
for each profile 
rofile type you 
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Because there are different sections and tables for each prof
Limit Memory Usage dialog box has different items available 
type, as a result, this dialog box will vary depending on the p
have selected.



3. Use the up- and down-arrows to adjust the maximum number of elements 
(in thousands) shown in each of the list boxes in the Max Elements column. 
The amount of memory (in MB) shown in the Mem Usage column will 
change to reflect the new number of elements.

For example, in an incoming profile type, you can limit the number of users 
(elements) included in the report.

4. Click OK.
240     User Guide
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Chapter 7

Scheduling Reports

cessing for:

window

Scheduler icon 

a, or by 

y scheduled 
e the way the 
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This chapter explains how to use the Scheduler to automate pro

• Profiles that are set up to run automatically

• On-demand reports that are generated through the Reports 

• Reports that are launched from the command line

• Real-time Analysis profiles

The Scheduler is launched when you start Firewall Suite, and a 
is added to your system tray. 

Open the Scheduler by clicking Scheduler on the Functions are
double-clicking the Scheduler icon  in the system tray.

The Scheduler 
The tabs in the Scheduler window let you work with events (an
profile is referred to as an event), monitor activity, and customiz
Scheduler works.



Tabs
• Scheduled Events lets you maintain a list of all profiles that are processed by 

the Scheduler. 

• Schedule Log provides a record of daily Scheduler activity.

• Performance Analysis Log provides a record of your system’s performance 
for scheduled events and other system processes if you are running the 
program on Windows NT, and the Scheduler Performance feature is 
activated.

cheduler 

.

monitor 

ndently 
nts to run 
vailable for 
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Functions Area
The following items are available in the upper right portion of the S
Main window for all three Scheduler tabs.

• Options lets you change configuration settings for the Scheduler

• Remote activates the Remote Scheduling server so that you can 
activity and kick off reports remotely.

• Service lets you run the Scheduler as a Windows service.

• Help opens online help for the Scheduler.

The Scheduler takes advantage of multi-processing and runs indepe
from other Firewall Suite processes. This design lets you set up eve
simultaneously, while keeping the main Firewall Suite application a
other tasks while reports are running.
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Scheduling and Running Events

Scheduling a New Event
To schedule an event:

1. On the Main Console, click Scheduler to open the Scheduler Main 

ab is the 
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window. 

2. Select the Scheduled Events tab. (The Scheduled Events t
default.)



Add a Scheduled Event
3. Click New. The Select Profile Type dialog box opens.

4. Select the profile type you are scheduling. The New Scheduled Event 
wizard opens to the Analysis dialog box.

n you want 
buttons. 

conds 

%%% format. 
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5. In the Start Date/Time text boxes, type the date and time whe
the analysis to start. You can also select a date using the arrow 

− If you type the time, use 24-hour clock format, including se
(��
##
��). 

− If you type the date in the second text box, use the ��$##$%
For example, type �K$��$����.
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6. In the Repeat Every text boxes, select the interval at which to repeat the 
analysis and report. 

port. See 
rmation.

 or delivering 

Note
You can run reports simultaneously by scheduling them to run at the same 
time, or you can run them a minute apart if you want a specific order. The 
Scheduler Options window defines the number of events that can be 
processed at once.
Chapter 7 • Schedu

7. Click Next. The Reporting dialog box opens.

Set up the Report
8. Click Report to open the Reports dialog box and select a re

“Memorized Report Settings” on page 217 for additional info

9. In the Save As/Mail To text box, select a method for saving
the report. 



You can save the report locally, transfer it via FTP, or send it as an email 
attachment. See “Specifying a Distribution Method” on page 252 for details.

10. Use the Report Range dropdown list to select the range of time to be 
covered by the report. See “Report range definitions” on page 240 for more 
information. 

 processed, 
eck box.

r batch file, 

Note
Make sure that the range you specify corresponds to existing dates in the 
log file.
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11. Click Next and the Pre-Processing dialog box opens.

Set up Pre-Processing
12. To run an application or batch file before the scheduled event is

select the Enable processing before the scheduled event ch

13. In the Application text box, type the path for the application o
or browse to its directory. 
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14. In the Working Folder text box, type the path for the directory where the 
application should run, or browse to its directory. 

15. If the program requires any command-line parameters, type them in the 
Command-line parameters text box.

16. Click Next, and the Post-processing dialog box opens. 

t is processed, 
heck box.

n or batch file, 

tory where the 

 them in the 
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Set up Post-Processing
17. To run an application or batch file after the scheduled even

select the Enable processing after the scheduled event c

18. In the Application text box, type the path for the applicatio
or browse to its directory. 

19. In the Working Folder text box, type the path for the direc
application should run, or browse to its directory. 

20. If the program requires any command-line parameters, type
Command-line parameters text box.



21. Click Next, and the Priority dialog box opens.

at are 
 frequently.

he default 

 window.
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Set the Processing Priority
22. Select the processing priority for this profile. 

− Low priority should be used for real-time events—those th
designed to run in the background because they are updated

− Normal priority should be used for most profiles. This is t
setting. 

− High priority should be used for critical reports only.

23. Click Finish to save the event and return to the Scheduler Main
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Editing a Scheduled Event
To edit a scheduled event:

1. On the Main Console, click Scheduler.

2. When the Scheduler window appears, select the Scheduled Events tab.

3. Select the scheduled event that you want to edit, and click Edit. The Edit 
Scheduled Event window opens.

 adding a new 

schedule for 

generating the 

 or batch file 
Chapter 7 • Schedu

These tabs in this window match the dialog box used when
scheduled event. 

− The Analysis tab lets you modify the profile name and 
running the profile.

− The Reporting tab lets you modify settings used when 
report.

− The Pre-Processing tab lets you modify the application
run before the event is processed.



− The Post-Processing tab lets you modify the application or batch file 
run after the event is processed.

− The Priority tab lets you modify the profile’s processing priority.

4. When you have made all necessary changes, click OK to save the event and 
return to the Scheduler window.

Running a Scheduled Event on Demand
Firewall Suite lets you run an event without waiting for the next scheduled 

every 
ith the 

ents tab.

e Start Now 
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time. For example, if you have scheduled a report to be generated 
Monday morning, you can preview the report on Friday afternoon w
information to date.

To run a scheduled event on demand:

1. On the Main Console, click Scheduler.

2. When the Scheduler window appears, select the Scheduled Ev

3. Select the event that you want to run, then click Start Now. Th
dialog box appears.
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4. Select one of the following options:

− Advance to the next start time. Leave this option selected if you want 
a scheduled event to run immediately instead of at the next scheduled 
time.

− DO NOT adjust the next start time. Select this option to run an event 
immediately and at the next scheduled time.

− Delete event(s) when done. Select this option to run an event once 

ar the Prompt 

 Status column 
rocessing.

en you exit the 
or on-demand 

can “kill” it, 
e at its next 

 Events tab.

processing for 
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and then delete it. 

5. If you prefer not to be prompted when this event is run, cle
me every time check box.

6. Click OK. The event is put in the queue to be processed. The
on the Scheduler window now shows the time left before p

Stopping an Event from Processing
At installation, the Scheduler is configured to stop processing wh
application using Exit and Unload. Scheduled events (except f
events) will resume when you restart Firewall Suite.

While a scheduled event is running, you cannot disable it. You 
however. Unless subsequently disabled, a killed event will resum
scheduled date and time.

To kill a scheduled event:

1. On the Main Console, click Scheduler.

2. When the Scheduler window appears, select the Scheduled

3. Select the event that you want to stop.

4. Right-click and select Kill from the menu that appears. The 
the selected event stops.



Specifying a Distribution Method
Firewall Suite lets you save reports locally, transfer them using FTP, or send 
them as email attachements.

To save a report locally:

1. On the Main Console, click Scheduler.

2. When the Scheduler window appears, select the Scheduled Events tab.

3. Select a profile and click Edit. The Edit Scheduled Event dialog box 

eport, or 

ents tab.

 box 

 server. If 
ser name 
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appears.

4. Select the Reporting tab.

5. Select file:/// from the Save As/Mail To dropdown list.

6. In the text box, type the file path where you want to save the r
click Browse to navigate to the location.

7. Click OK.

To transfer the report using FTP:

1. On the Main Console, click Scheduler.

2. When the Scheduler window appears, select the Scheduled Ev

3. Select a profile and click Edit. The Edit Scheduled Event dialog
appears.

4. Select the Reporting tab.

5. Select ftp:// from the Save As/Mail To dropdown list.

6. In the text box, type the complete path from the root of the FTP
you are required to authenticate to access the server, enter the u
and password to use.

7. Click OK.
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To send the report via email:

1. On the Main Console, click Scheduler.

2. When the Scheduler window appears, select the Scheduled Events tab.

3. Select a profile and click Edit. The Edit Scheduled Event dialog box 
appears.

4. Select the Reporting tab.

 Save To text 

e the report 

e file or 
me for 30 

 URL path for 

an typing 
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5. Select mailto: from the Save As/Mail To dropdown list.

6. To save a copy of the report locally, type the file path in the
box.

7. In the eMail address text box, type the email address wher
should be sent. 

8. Click OK.

Date Macros
Firewall Suite provides built-in macros that you can use to defin
directory names that represent the current date. If the log file na
December, 1999 looks like this:

�����������.

If you want to schedule the previous day’s activity, the Log File
the profile would look like this:

�
���.������>��	�A�>>��>>##>>%%%%>���.

Tip
To send the report to many people, create an alias rather th
several email addresses.



The following table shows the content returned by date macros

Macro Dates Returned

>��> Day

>##> 2-digit month

>-��> Abbreviated month

This macro is case sensitive: %Mon% returns Jan, mon returns 
jan, MON returns JAN
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>%%> 2-digit year

>%%%%> 4-digit year

>��	�A�> Subtracts n days from the current system date 

>��	�Q�> Adds n days to current system date

>##A�> Subtracts n months from current month

>##Q�> Adds n months to current month

>%%A�> Subtracts n years from current year

>%%Q�> Adds n years to current year

>%%%%A�> Subtracts n years from current year

>%%%%Q�> Adds n years to current year

>�%> Day of the year, 001–366

>�%> Week of the year, 00–53

>��> Day of the week, 0–6

>�#> Week of the month, 0–5
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Managing Scheduled Events
Scheduled events may be managed through the Scheduled Events windows 
available through the three Scheduler tabs:

• Scheduled Events tab

• Schedule Log

o an icon in 
rner of the 
.

on appears on 
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• Performance Analysis Log

Once events have been scheduled, the Scheduler is minimized t
your computer’s system tray (located in the lower, right-hand co
screen). To view the Scheduler window, double-click the icon 

Note
If Hide is selected in any of the Scheduler tabs, the Scheduler ic
the system task bar.



Scheduled Events Tab Elements
Elements specific to the Scheduled Events tab include the Tasks area, the 
Scheduled Events list, and the Scheduled Events shortcut menu.
256     User Guide
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Tasks Area
The Tasks area is located on the left side of the Scheduler Main window and 
varies according to the selected tab. You can perform the following activities 
using the Tasks area of the Scheduled Events tab:

• New lets you add a new scheduled event for a specific profile type.

• Edit lets you edit a selected scheduled event.

Scheduled 

mediately.

vents currently 

.

s are displayed. 
ays “Next.” 

or this event.

 the profile was 
0), this field 
If the profile 
and time of the 

r Real-Time 
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• Delete lets you delete a selected scheduled event from the 
Events list.

• Start Now lets you process the selected scheduled event im

Scheduled Events List
The Scheduled Events list displays information for each of the e
scheduled. The following fields are shown for each list entry:

• Profile Description displays the profile used for this event

• Status shows the number of seconds until the analysis begin
When a profile is next in line for analysis, this column displ
When the analysis begins, the status changes to “Running.”

• Profile Type specifies the type of profile analyzed.

• Report Description displays the memorized report name f

• Date/Time shows when the profile will be analyzed next. If
scheduled to run once (the Repeat Every text box is set to 
displays the date and time the event was scheduled to run. 
was scheduled to run repeatedly, this field displays the date 
next analysis.

• Event Type displays Scheduled Event, On-demand Event o
Analysis Event.

• Repeat Every specifies the interval between each analysis.



• Save As Path varies according to the selected distribution method:

− If the report is to be saved locally, this field specifies the directory for 
the report. 

− If the report is transferred using FTP, this field specifies the path to the 
FTP server.

−  If the report is sent by email, this field specifies the recipients.

• Schedule Filename specifies the file name and location for the scheduled 
event file. This file contains all the settings for the event.

ber of 

hortcut 

 to create a 

 modify the 

odify the 

has begun.

plays 
ent.
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Scheduler Status
The lowest portion of the Scheduler window displays the total num
scheduled events.

Scheduled Events Shortcut Menu
Right-clicking anywhere in the Scheduled Events window opens a s
menu containing these commands:

• New starts the New Scheduled Event wizard, which allows you
scheduled event.

• Edit opens the Edit Scheduled Event dialog box so that you can
selected event.

• Copy copies the selected scheduled event and allows you to m
copy in the Edit Scheduled Event dialog box. 

• Start Now! kicks off the selected scheduled event immediately.

• Delete lets you delete the selected event.

• Kill allows you to kill processing for the selected event once it 

• Details opens the Scheduled Events Details window, which dis
profile, report, event, and file information about the selected ev
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• Set Priority opens the Set Priority Level dialog box, in which you choose 
the processing priority for this event.

• Update all security checksums

• Show Scheduled Events for all profile types shows all scheduled events 
for all profile types.

• Show Scheduled Events for only one profile type allows you to display 
the scheduled events for a single profile type.

f every column 

olumn. Click to 
u want to hide. 

ecting each 
events at once 
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• Align Columns adjusts column widths so that the contents o
is completely visible.

• Select Columns hides or shows a Scheduled Event detail c
clear the Available Column check box next to the column yo
By default all the Available Column boxes are checked. 

• Print prints the Scheduled Events list.

• Select All selects all the items in the list

• De-select All deselects all selected items in the list.

You can select multiple events by holding the 0	���key and sel
event in turn. For example, you can add, edit, or delete several 
by selecting them, right-clicking, and selecting the appropriate c

Using the Scheduled Events Tab
The Scheduled Events tab lists all scheduled events. 

To disable or enable an event:

Select or clear the check box next to the event name. Disabling
not stop the analysis once it has begun. See “Stopping an Event
Processing” on page 251 for instruction on “killing” an event wh
processed.



To access the Scheduled Event Command menu:

Move the cursor to anywhere in the Scheduled Events window, then right-click 
to open a shortcut menu.

To access the command menu for a particular event:

Select an event in the Scheduled Events window and right-click to open a 
shortcut menu.

olumns in 

 that 

nd until the 
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Managing the Scheduled Events List
You can sort the events in the Scheduled Events list and align the c
the list to view the information optimally.

To sort the events by column type:

Select the desired column heading. The list is sorted on the basis of
column.

To change column alignment and view long entries:

Hold the cursor to the right of the column heading you wish to expa
cursor changes into a double arrow. Manually adjust column width 
and dragging the right edge of the column heading.
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Schedule Log Tab Elements
The Schedule Log tab provides a history of all scheduled events for a selected 
date, including details about their status. Events are listed in the order they 
were scheduled. 

he Event 
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Use the + ahead of each item to expand and collapse items in t
Description tree. 



Tasks Area
The Tasks area is located on the left side of the Scheduler Main window and 
varies according to the selected tab. You can perform the following activities 
using the Tasks area of the Schedule Log tab:

• Refresh lets you update the scheduled event list.

• View Report lets you view the report associated with the selected 
scheduled event.

elected day 

ich you can 
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• Clear This Day clears out the log history data for the currently s
(selected in the Daily Log History Files dropdown list).

• Clear All Days clears out all the log history data.

• Tech Support opens the eMail Diagnostic Data dialog box, wh
use to send diagnostic information to NetIQ Technical Support. 

Schedule Log List
The following information is shown for each list entry of the Sched

• Event Description shows the name of the profile.

• Profile Type displays the type of profile.

• Date/Time displays the date and time the event took place.

• Event Type displays Scheduled Event, On-demand Event, or Re
Analysis Event.

• Additional Messages displays any information about the event
problems encountered.

• Next Event displays the time the next event is scheduled to tak

• Repeat Every specifies how often the event is scheduled to tak
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Schedule Log Shortcut Menu
Right-clicking anywhere in the Schedule Log tab opens a shortcut menu 
containing these commands:

• View Report lets you view the report associated with the selected 
scheduled event.

• Show all events shows every event generated by the log, regardless of 
whether or not the event was successful.
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• Show error events only displays only the error events gen

• Show All Profile Types displays the log history information
types.

• Show One Profile Type Only displays the log history infor
profile type you select.

• Clear This Day clears out the log history data for the curren
(selected in the Daily Log History Files dropdown list).

• Clear All Days clears out all the log history data.

• Align Columns adjusts column widths so that the contents o
is completely visible.

• Select Columns hides or shows a Schedule Log Available C
clear the Available Column check box next to the column yo
By default all the Available Column boxes are checked. 

• Print prints the Schedule Log list.

• Collapse all collapses the listed items to just show the top-l

• Expand all expands the list to show all folders and sub-item

Using the Schedule Log
When you select the Schedule Log tab, the schedule log for th
displayed. 



To select history files: 

Use the Daily Log History Files dropdown list to select the date of Schedule 
Log History files.

To sort the events by column type:

Select the desired column heading. The list is reorganized on the basis of that 
column.

To change column alignment and view long entries:

nd until the 
by clicking 

 This Day 
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Hold the cursor to the right of the column heading you wish to expa
cursor changes into a double arrow. Manually adjust column width 
and dragging the right edge of the column heading.

To clear the Schedule Log:

Remove all schedule logs by clicking Clear All Days, or click Clear
to remove the schedule logs for the day selected in the Daily Log H
Files dropdown list. 

To refresh the Schedule Log:

Click Refresh in the Tasks area. By default, it is updated every two
You can change the refresh rate in the Options tab.

To view a report for the selected event:

Click View Report in the Tasks area to display the report generated
selected event

Performance Analysis Log Tab Elements
The Performance Analysis Log tab provides a breakdown of you
performance by event, including processing time, memory usage, an
processes. 

Note
A schedule log is created for each day. By default, two weeks worth
schedule logs (14 logs) are maintained. 
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The Performance Analysis Log tab is useful for troubleshooting. If an event 
takes longer than usual to run, you can determine which other processes were 
running and how much memory was available. If your computer consistently 
runs out of memory, consider increasing the physical memory.

To view computer details for a performance record, select it, right-click, and 
select Details. This feature is available only on systems running Microsoft 
Windows NT 4.0. You must configure the Performance settings in the Scheduler 
Options tab to get this information.
Chapter 7 • Schedu



Tasks Area
The Tasks area is located on the left side of the Scheduler Main window and 
varies according to the selected tab. You can perform the following activities 
using the Tasks area of the Schedule Log tab:

• Refresh updates the Performance tab with any new activity. By default, it 
is updated every five minutes. You can change the refresh rate in the 
Options tab under Performance analysis, How often

• Details shows information about the selected performance analysis log 
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item.

• Clear This Day deletes the performance file for the selected da

• Clear All Days deletes all performance files.

• Tech Support opens the eMail Diagnostic Data dialog box, wh
use to describe your technical support issue in an email messag
Technical Support.

Performance Analysis Log List
The following information is shown for each list entry:

• Application Name/Cartridge displays the name of the progra
cartridge.

• Total Execution Time specifies the length of time since the pr
started, although not necessarily the amount of time it took to r
example, some applications start when you log on, but only run
called.

• Time in Kernel Mode shows the length of time that the proces
priority processing time in kernel mode. This gives you a good in
actual processing time.

• Time in User Mode shows the length of time that the process w
processing time in user mode, a slightly lower priority than kern
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• Page Faults shows the number of page faults that occurred during 
processing. Page faults occur when the process requires more physical 
memory than is available.

• Peak Working Set (MB) specifies the most memory used by the appli-
cation or event. Pay close attention if the peak working memory exceeds 
the physical memory because this is when swapping occurs. You may need 
more physical memory if your computer runs out of memory often.

cation or event 
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• Working Set (MB) specifies the memory used by this appli
when the performance was recorded.

• Peak Pagefile Usage specifies the most memory that was sw
for this application or event. If it requires more memory than
it must be swapped to the paging file.

• Pagefile Usage specifies the memory that was being swapp
cation or event when the performance was recorded.

• Profile displays the profile used.

• Report displays the memorized report name.

Performance Analysis Log Shortcut Menu
• Details shows information about the selected performance 

item.

• Clear This Day deletes the performance file for the selected

• Clear All Days deletes all performance files.

• Align Columns adjusts column widths so that the contents o
is completely visible.

• Select Columns hides or shows an Available Column of the
Analysis Log. Click to clear the Available Column check box
column you want to hide. By default all the Available Colum
checked. 

• Print prints the Performance Analysis Log list.



• Collapse all collapses the listed items to just show the top-level folders.

• Expand all expands the list to show all folders and sub-items in folders.

Using the Performance Analysis Log Tab
When you select the Performance Analysis Log tab, the current day is 
displayed. 

To select performance files: 

sis of that 

nd until the 
by clicking 

s are 
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Use the dropdown list to select the date of performance files.

To sort the events by column type:

Select the desired column heading. The list is reorganized on the ba
column.

To change column alignment and view long entries:

Hold the cursor to the right of the column heading you wish to expa
cursor changes into a double arrow. Manually adjust column width 
and dragging the right edge of the column heading.

Using the Options Tab
The Options tab provides settings that affect how scheduled event
processed.The following areas are available:

• Simultaneous Processes

• Schedule Log Files

• Performance Analysis
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• Priority for On Demand Report

• Miscellaneous

ents that you 

ssor on the 
on your 

econds to be 
cheduled event.
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Simultaneous Processes 
• # of Processes lets you specify the maximum number of ev

wish to run at the same time. The default is 4.

Typically, you can run two scheduled events for each proce
computer. If you have more than two processors operating 
computer, you may want to increase this setting.

• Countdown (in seconds) lets you specify the number of s
visually counted off in the status column before running a s



Schedule Log Files
Schedule Log Files lets you specify how often to refresh your log files and lets 
you specify how many daily log files you want to save.

• Refresh Rate (minutes) lets you specify how often the Schedule Log tab 
is updated. At installation, this option is set to two minutes.

• # Daily Log Files lets you specify the maximum number of Schedule Log 
files saved. 
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You can save up to a year’s worth of files.One Schedule Log file
for each day. When the limit specified by this option is reached
file is deleted and replaced with the Schedule Log for the curren

Performance Analysis
Performance analysis lets you capture the state of the computer a
intervals (if you’re running Firewall Suite on Windows NT 4.0 or lat

• Track performance of scheduled events enables the Schedu
the performance of processes and display a breakdown of the d
Performance Analysis Log tab. 

• How Often (minutes) lets you specify how frequently, in minu
performance snap-shot is taken of the Firewall Suite computer. 
the Performance dialog box is updated every five minutes, but y
change it to anything from between one and sixty minutes.

− Perform Analysis on all processes monitors system perfo
all applications and events. In addition to Firewall Suite sch
events, all other processes running on your system are reco

− Only perform analysis on running events monitors syste
mance only for events that are running.
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Performance for On Demand Report
Lets you specify Low, Normal, or High priority for processing on demand 
reports relative to other events.

Low (the default setting) ensures that on-demand reports do not interfere with 
other processes. Use this setting for most, if not all, on-demand reports.
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Miscellaneous
• Only launch “secure” events launches only schedule even

an encrypted checksum. All scheduled events that are create
user interface have this checksum, which ensures the file w
Firewall Suite and not by someone who has accessed your co
Internet or your network. 

• Do not show the reporting errors dialog box turns off t
errors popup. 

• Run from the Startup Group loads and runs the Schedule
startup.

• Log Errors to the NT Event Log logs errors the Windows N
This option is available only if you are running Windows NT

Note
Do not use this option if you create events through batch fil



Commands
Performance tab commands are accessed using the following buttons:

• Start Now! Options opens the Start Now! dialog box, in which you can 
specify:

− Advance to the next start time. Leave this option selected if you want 
a scheduled event to run immediately instead of at the next scheduled 
time.
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− DO NOT adjust the next start time. Select this option to ru
immediately and at the next scheduled time.

− Delete event(s) when done. Select this option to run an e
and then delete it. 

• Restore Defaults restores settings to the original defaults.

• OK saves your settings and close the Options dialog box.

• Cancel closes the Options dialog box without saving your settin

• Help opens Help for the Scheduler options.

Using the Remote Scheduling Tab
Use the Remote option in the Functions area (top right of the Sche
window) to set up the Remote Scheduling Server. With the Remote 
Server, you can access Scheduler features through a browser. For ex
can look at the Schedule Log to monitor Scheduler activity or view 
have been generated. Or, you can check the details of reports.

Note
The Scheduler must either be running on its host system or running 
to access the Remote Scheduling Server.
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Setting up the Remote Scheduling Server
Use the Remote Scheduling Server dialog box to specify the location where the 
Remote Scheduling Server will run. 

To set up the Remote Scheduling Server:

1. On the Scheduler Main window, select Remote. The Remote Scheduling 
Server dialog box opens.
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2. Select the Enable Remote Reporting Server check box.

3. Select the Bind all IP Addresses check box if the compute
Firewall Suite has multiple IP addresses, and you want to be
the Remote Scheduling Server using any of them. 

For example, the system might be assigned an IP that can on
locally and an IP that can be accessed throughout the netwo
explicitly defining the IP, select the Bind all IP Addresses c



4. If you un-selected Bind all IP Addresses, type the IP address in the IP 
Address text box. You will use this if your computer has only one IP 
address, or if there are more than one IP but you want to access the Remote 
Scheduling Server with a specific IP.

5. Type the Port number in the Port text box that the Remote Scheduler will 
as it is not 

a log file in 
 

d save this 

se to run 
rivilege.

ols > User 

Note
The primary IP address of the computer you are using appears as the 
default address.

-on users.
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use. The default is 99 which you should be able to use as long 
used by another service.

6. Select Enable logging of Server activities option to maintain 
NCSA format for this remote reporting server. This file is named
remote.log, and by default is stored in Firewall Suite’s 
����������	������	� directory. However, you can browse to an
file to a new location.

7. Click OK.

Configuring Your User Account for Remote 
Scheduling

In order to run the Remote Scheduler Server, the account that you u
Firewall Suite must have the “act as part of the operating system” p

To define the “Act as part of the operating system” privilege:

1. From the Start menu and select Programs > Administrative To
Manager. The User Manager window opens.

2. Select yourself in the Username list.

Note
The logged-on users box displays the names of all currently logged
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3. From the Policies menu, select User Rights. The User Policy window 
opens.

4. Select the Show Advanced User Rights check box at the bottom left of the 
dialog box.

5. In the Right dropdown list, select Act as Part of Operating System.

6. Click Add and the Add Users and Groups dialog box opens.

 Your name 

all Suite host 
e Scheduling 

Remote Sched-
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7. Click Show Users.

8. Select your user name from the list of names and click Add.
appear in the Add Names list.

Accessing the Remote Scheduling Server
To access the Remote Scheduling Server:

1. Open your Web browser. 

2. In the Address/URL box, type the IP address for your Firew
system and the port number that you defined in the Remot
Server dialog box. Use the following syntax:

�		�
$$=J��������
���	��
#(��

The Remote Scheduling Server Logon window opens.

3. Type your user name and password, and click Logon. The 
uling Server opens.



Schedule Log
To use the Schedule log:

1. From the Remote Scheduling Server, click Schedule Log. 

2. Select the day that you want to look at from the dropdown list, and click 
View Report. You can access reports that are saved to the 
����������	������	� directory and those that are saved using a UNC path.

3. After viewing the report, click Main to return to the Remote Scheduling 
ser’s Back 

ropdown 

uling Server 

or the 
g box. 

ils.
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Server main window. Without viewing a report, click your brow
button.

Using the Performance Log
To use the Performance log:

1. From the Remote Scheduling Server, click Performance Log. 

2. Select the day’s log from the Performance Log History Files d
list.

3. Click your browser’s Back button to return to the Remote Sched
main window.

Scheduled Events
Creating a scheduled event:

1. Click New.

2. Select a profile type (cartridge) from the dropdown list.

3. The Edit Scheduled Event dialog box opens. Select the profile f
scheduled event, and continue with the other boxes in the dialo
Review “Using the Scheduled Events Tab” on page 259 for deta
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Editing a scheduled event:

1. In the Scheduled Events window of the Remote Scheduling Server, select 
the event to edit.

2. Click Edit.

3. The Edit Scheduled Event dialog box opens. Make changes in the dialog 
box. Review “Using the Scheduled Events Tab” on page 259 for details.
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Running Reports 
To run reports for a scheduled event remotely

1. In the Scheduled Events window of the Remote Scheduling 
the event for the report that you want to run.

2. Click Start Now to place the selected event in the queue fo
processing.

The Start or Stop WebTrends Service Dialog 
You can set up the Scheduler to run as a service. This ensures t
events take place even if the system reboots accidentally. 



To activate the service settings:

1. In the Schedule Main window, select Service from the Functions area in the 
upper right corner. The Start or Stop WebTrends Service dialog box opens.

2. Select the Service tab. The Start or Stop WebTrends Service dialog box 
opens.
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3. By default, the Scheduler service logs on using the System Acco
want to run the service by impersonating another user, type the
and password that you want to use. You might do this in order to
files stored on another system that the system account doesn’t h
to.

 If you specify a user account, it must also have advanced privil
“Adding Privileges to your Windows User Account” on page 279

4. Click Start Service to start the Scheduler service. When the serv
successfully, a message is displayed in the lower portion of the 

5. Click OK to save your selections, or click Cancel to exit the dia
without saving your changes.
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Configuring the Service Startup
In order to run the Scheduler as a service, the Schedule must be allowed to 
interact with the desktop. 

To configure the startup:

1. From the system Start menu, select Settings > Control Panel.

2. Double-click Services. The Services window opens.

.
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3. Select WebTrends Scheduler from the list, and click Startup

4. Make sure the Allow the service to Interact with the desk
is selected.

Adding Privileges to your Windows User Acco
In order to run the Scheduler as a service, the privileges for the
you use to run Firewall Suite must allow it to do the following:

• Act as part of the operating system

• Log on as a service

• Log on locally

To add privileges:

1. Click the Start menu on your system.

2. Select Programs > Administrative Tools > User Manager
Manager window opens.

3. Select yourself in the Username list.

4. From the Policies menu, select User Rights. The User Polic
opens.

5. Select the Show Advanced User Rights check box at the b
dialog box.



6. In the Right dropdown list, select Act as Part of Operating System.

7. Click Add. The Add Users and Groups dialog box opens.

8. Click Show Users.

9. Select your user name from the list of names, and click Add. Your name 
appears in the Add Names list.

10. In the Right dropdown list, select Log on Locally.

11. Click Add. The Add Users and Groups dialog box opens.

ur name 

ame 
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12. Click Show Users.

13. Select your user name from the list of names, and click Add. Yo
appears in the Add Names list.

14. In the Right dropdown list, select Log on as a Service.

15. Click Add. The Add Users and Groups dialog box opens.

16. Click Show Users.

Select your user name from the list of names, and click Add. Your n
appears in the Add Names list.
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Chapter 8

Monitoring Activity
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This chapter contains scenarios showing how you can use Web
Suite to do the following:

• Monitor Security Events

• Monitor Internet Searches

• Monitor Bandwidth Usage

Monitoring Security Events
In this scenario, we are trying to find the source of critical even
event signals that you have potentially suspicious activity occurr
network. Critical events are defined differently within each firew
example, an event is considered critical if it meets the following

• Gauntlet considers an event critical if it is logged as a “secur

• Check Point considers an event critical if it is logged as “reje

• Raptor considers an event critical if it has an error code of 5



In this scenario you’ve noticed that for the last several days, the Critical Events 
table has reported a "503: Reverse address doesn’t match" critical event being 
reported 10 times for the same IP address. Such activity may indicate a possible 
port scan and warrants further investigation. 

 break 
 you want 
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You have visions of a disgruntled ex-employee persistently trying to
through your firewall. In order to make sure your firewall is secure,
want to find out what else this person has been doing.
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Finding the IP Addresses that Cause the Most Errors
To find the IP addresses:

1. Create a General Firewall Activity profile. See “Creating a Firewall Profile” 
on page 48. 

2. Create a General Firewall Activity report by clicking Report.

3. Select the Default Summary (HTML) report from the list of Available Report 

or External 
rity memorized 

 that is causing 
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Templates.

4. Click Edit. The Edit Report dialog box opens.

5. Select the Content tab and make sure the Critical Events f
Addresses check box is selected. You can also use the Secu
report which is provided with Firewall Suite.

6. Once you’ve generated the report, determine the IP address
the most errors. 

  



Focusing on an IP Address
To look at a specific IP address

1. Create a new General Firewall Activity profile to determine the activity for 
this IP address. Delete the Include Everything filter, and create a new one 
based only upon the external address you want to report on. See “External 
user address (general)” on page 191 for details on how to do this.
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2. Create a report on the profile you just created. Any activity recor
IP address is included in the report.

Monitoring Internet Searches
The type of Internet content retrieved in the work environment is a
concern for many companies. Inappropriate content can cause hara
lawsuits, lost productivity, and damage to the organization. Your Fir
the keywords used for Internet searches. You can create a list of wor
want to filter for and produce a report that displays the top users o
keywords, which keywords they use, and the sites they visited. Wh
combined with a User (by IP) filter, you can generate reports on the
the search being conducted by an individual.

more in-depth information on any HTTP activity this IP address
ating. 

Note
Only tables and graphs for which there is data appear in the rep
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To monitor Internet searches:

1. Create an Outgoing Web Activity profile to track Internet searches. See 
“Firewall Profiles” on page 27 for details.

2. Edit the Search Engine Keywords filter to contain only the keywords you 
want to search for. See “Filtering for Focused Reports” on page 173 for 
details.

3. Create a report based on the profile you’ve just created. It reports the users 
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who entered the keywords and the sites they visited. 

4. Create individual profiles for each IP address returned in the
Edit the Include Everything filter, and type the IP address in
IP) text box.

5. Create reports based on the Users by IP profile. These report
activity for an IP address.

Monitoring Bandwidth Usage
One simple way to assess productivity in your organization is th
Suite bandwidth tables and graphs. Bandwidth measures the am
transferred over the Internet. Firewall Suite breaks down bandw
protocol, telling you the type of activity conducted. Firewall Suit
looks for protocol activity and graphs it, but you can also repor
protocol or track an individual user’s bandwidth by protocol.

In this scenario, we determine which protocol uses the most ba
which uses this protocol most often. We also determine what ot
individual is generating.

Note
If your organization requires users to log on to the firewall with
and password, you can create a similar report based on authent



To create a report showing bandwidth usage by protocol:

1. Create a General Firewall Activity profile using the steps described in 
“Creating a Firewall Profile” on page 48. 

2. Create a General Firewall Activity report making sure the Bandwidth by 
Protocol element is selected in the Content tab. See “Modifying report 
content” on page 239 for details.

3. Once you’ve generated the report, determine the protocol that uses the 
most bandwidth.
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Identifying High-Bandwidth Users
To create a report showing bandwidth usage by protocol and 

1. Create a new profile to find the individual who used the most b
for this protocol. Edit the Include Everything filter to include on
of Traffic. In the Type of Traffic tab, select the protocol that us
bandwidth. See “Working with Filters” on page 175 for details.

2. Create a report based on the new profile. Check the Top Users 
Bandwidth section to determine the individual who used the m
bandwidth for this protocol.

To create a report showing an individual’s activity:

1. Create a new profile to examine the activity of the top user of th
Edit the Include filter to include just the Internal Address. This i
filter element that you want to use because you want to assess a
activity, not just for a particular protocol.

2. Create a report based on this profile. This report breaks down t
individual’s activity.

Table 1-1.  
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Chapter 9

Options
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This chapter explains how to modify your configuration settings
your environment. Options are divided into three main areas:

• Main

• General Firewall Activity

• Alerting & Monitoring

The various settings you can configure within each main area a
the following sections.

Main Options
The Main Options settings apply to the entire program. These le

• Your country of origin.

• The file path to your Web browser used for viewing HTML r

• The day that the report week starts on.

• The month in which your fiscal year begins.



• How you will access your network resources, including your firewall log 
file.

• Settings to send reports by email.

• Settings that allow your firewall reporting solution to generate reports in 
Microsoft Word and Excel.

• A list of search engines that you want your firewall reporting solution to 
identify in firewall log files. 

• Report ranges that specify the time period a report can cover.
288     User Guide

• Settings for accessing files through a proxy server.

• The language used in reports.
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Main - General Dialog Box
The topics in this section cover the settings you may configure in the Main - 
General dialog box.
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Identifying the Country of Origin
You have the option to identify the “source” country for your re
considered “domestic.” For example, if you are in Italy and wan
to your site to be considered domestic and all others to be cons
international, you should select Italy as your country of origin.



To specify the country of origin:

1. On the Main Console, click Options in the Functions area. The Options 
window opens.

2. In the left-side navigation area, click Main. The right side of the window 
opens to the Main - General dialog box.

3. In the Your Country of Origin dropdown list, select the country you wish 
to be considered domestic.

4. Click OK to save your selection.

stem 
TML 

lt browser 

 Options 

 window 

rowser that 

l define the 
nday as the 
nge of Last 
290     User Guide

Selecting a Web Browser
By default, your firewall reporting solution launches your default sy
browser, such as Microsoft Explorer or Netscape, for viewing your H
reports. You can specify a different browser by modifying the defau
path that your firewall reporting solution uses.

To specify a different browser:

1. On the Main Console, click Options in the Functions area. The
window opens.

2. In the left-side navigation area, click Main. The right side of the
opens to the Main - General dialog box.

3. In the Path to Default Browser text box, type the path to the b
you wish to use, or click  to search for a specific location.

4. Click OK to save your selection.

Defining the Week
Select the day you want to start your week. The day you choose wil
first day of the week in your reports. For example, if you choose Su
day you want to start your week any report you create with a date ra
Week will include information from Sunday through Saturday. 
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To change the start day for the week:

1. On the Main Console, click Options in the Functions area. The Options 
window opens.

2. In the left-side navigation area, click Main. The right side of the window 
opens to the Main - General dialog box.

3. In the Report Week Starts On dropdown list, select the day you wish to be 
considered as the first day of the week for your reports.
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4. Click OK to save your selection.

Defining the Month
Select the month on which your fiscal year starts. The month yo
determine how fiscal data is displayed in your reports. For exam
choose January as the month you want your fiscal year to start, 
create with the date range Current Fiscal Year will include inf
January through the current date.

To change the start month for the fiscal year:

1. On the Main Console, click Options in the Functions area. 
window opens.

2. In the left-side navigation area, click Main. The right side o
opens to the Main - General dialog box.

3. In the Your Fiscal Year Starts In dropdown list, select the m
your reports to consider as the first month in the fiscal year 
generating reports based on the fiscal year.

4. Click OK to save your selection.

Managing Reports
You may wish to close the Reports dialog box once you begin g
on-demand report.



To close the Reports dialog box automatically when generating on-
demand reports:

1. On the Main Console, click Options in the Functions area. The Options 
window opens.

2. In the left-side navigation area, click Main. The right side of the window 
opens to the Main - General dialog box.

3. Select the Managing Reports check box.

4. Click OK to save your selection.

e Main - 
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Access to Internet Dialog Box
The topics in this section cover the settings you may configure in th
Access to Internet dialog box.
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Enabling FTP PASV Mode
If you are behind a firewall and are using FTP to access your firewall log files, 
then you must enable FTP PASV mode.

To enable FTP PASV mode:

1. On the Main Console, click Options in the Functions area. The Options 
window opens.

d click Access 
s.

er, or if you 
ust define your 

The Options 

ck Access to 

e proxy server.

.

and port to use 
Chapter

2. In the left-side navigation area, expand the Main section an
to Internet. The Main - Access to Internet dialog box open

3. Select the Enable FTP PASV Mode check box.

Proxy Server Settings
If you access your firewall log files using HTTP via a proxy serv
register for and download a URL categorization database, you m
proxy settings.

To set up the proxy server connection:

1. On the Main Console, click Options in the Functions area. 
window opens.

2. In the left navigation area, expand the Main section and cli
Internet. The Main - Access to Internet dialog box opens.

3. Select the Connect through a Proxy Server check box.

4. In the HTTP Address text box, type the HTTP address of th

5. In the Port text box, type the port used by the proxy server

Note
If necessary, consult your network administrator for the address 
in this dialog box. 



6. If the proxy server is password-protected, select the HTTP access requires 
a User Name/Password check box and supply the user name and 
password used to log in to the proxy server in the text boxes provided.

7. Click OK to save your selection.

E-Mail Dialog Box
To send reports automatically by email, you must provide information about the 
type of email service your organization uses. Use the Main - e-Mail dialog box 
294     User Guide

to specify these settings.
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Sending Reports with SMTP Email
Simple Mail Transfer Protocol (SMTP) is used by most Internet mail programs 
(for example Eudora and Netscape). You can use SMTP email to send your 
reports.

To send reports using SMTP email:

1. On the Main Console, click Options in the Functions area. The Options 
window opens.

d click e-Mail. 
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2. In the left-side navigation area, expand the Main section an
The Main - e-Mail dialog box opens.

3. Select the SMTP Mail check box

4. In the Server text box, type the host name or IP Address of
server. 

5. In the From text box, type the email address that will be pl
From field of the emailed report, for example �����	�E��(	

6. In the Reply-To text box, type the email address that any re
to. Usually this is the same as what’s in the From text box, 
cases it can be different.

7. In the Subject text box, type the text for the subject line tha
appear on the report email.

8. Optionally compress email attachments by selecting the Com
attachments, including generated e-Mail reports check 

9. Click OK to save your selections.

Note
See your network administrator or refer to your email progr
configuration for this information.



Sending reports with MAPI email
Mail Application Programming Interface is an industry-wide standard for 
accessing large mail systems like Microsoft Mail and cc:Mail. You can use MAPI 
email to send your reports.

To send reports using MAPI email:

1. On the Main Console, click Options in the Functions area. The Options 
window opens.

ick e-Mail. 
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2. In the left-side navigation area, expand the Main section and cl
The Main - e-Mail dialog box opens.

3. Select the MAPI Mail check box.

4. In the Profile text box, type the name of the profile to use for r
by email, for example Microsoft Outlook.

5. If applicable, type the password for the profile into the Passwo

6. In the Subject text box, type the text for the subject line that yo
appear on the report email.

7. Optionally compress email attachments by selecting the Compr
attachments, including generated e-Mail reports check box

8. Click OK to save your selections.

Note
See your network administrator or refer to your email program 
configuration for this information.
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MS-Word and Excel Dialog Box
You can specify an author and company name to be included in reports 
generated in the Microsoft Word or Excel formats. By default, this information is 
taken from your system registry.

Note
You can generate reports in Microsoft Word or Excel formats only if you have 
Microsoft Office 95, Office 97, or Office 2000 installed on your system. Stand-

acro language 
Chapter

alone versions of Microsoft Word and Excel do not provide the m
necessary to create these reports.



To specify MS-Word and Excel information:

1. On the Main Console, click Options in the Functions area. The Options 
window opens.

2. In the left-side navigation area, expand the Main section and click MS-
Word and Excel. The Main - MS-Word and Excel dialog box opens.

3. In the Author text box, type the author name that you want to appear in 
reports.

4. In the Company text box, type the Company name as you want it to 
298     User Guide

appear in reports.

5. Click OK to close the Options window.
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Search Engines Dialog Box
Firewall Suite can analyze a log file and pick out which search strings and 
which search engines visitors to your Web site used when they located and 
connected to your Web pages. The software already includes an extensive list 
of popular or common search engines it can identify and methods by which it 
can recognize keyword search terms. However, you can use the Main - Search 
Engines dialog box to add new search engines and keyword-recognition 
methods, change settings for search engines already in the list, or delete search 

The Options 

d click Search 
Chapter

engines from the list.

To add a new search engine:

1. On the Main Console, click Options in the Functions area. 
window opens.

2. In the left-side navigation area, expand the Main section an
Engines. The Main - Search Engines dialog box opens.



3. Click New. The Search Engine Information dialog box opens.

 

arch engine 

ox opens.
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4. In the Search Engine Name text box, enter the name of the se
you are adding.

5. In the Identification Strings area, click New. The Name dialog b
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6. Enter an identification string in the text box. These strings must correspond 
exactly to those that the search engine records in your firewall log file. 
Usually, you can spot the identification string by looking for a URL in the 
Referrers field and entering as much of it as you want Firewall Suite to 
look for when it analyzes the log file. Entering a single term such as "yahoo" 
will capture a broad selection of search engines that Yahoo! might use. 
Entering a more focused term such as "search.server1.yahoo.com" (a 
fictitious example), allows you to break down your report to identify 
specific engines.

Information 
y identification 

g box opens.

o determine 
u can use this 
 pages in the 
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7. Click OK to save the string and return to the Search Engine 
dialog box. You may repeat Steps 5 through 7 to add as man
strings as needed.

8. In the Keyword Indicators area, click New. The Name dialo

9. Enter a keyword indicator in the text box. This allows you t
which search terms visitors used to locate your Web site. Yo
information to adjust the keywords you use to identify your
Meta tag or the keywords you used to register your site with

The keyword indicators usually have a distinctive format an
end of the URL that identifies the search engine in your log 
enter only the indicator itself -- often, a character such as ? o
start of the indicator, while a semicolon, an = sign, or other 
mark the end of the indicator.

10. Click OK to save the string and return to the Search Engine 
dialog box.

11. Repeat Steps 8 through 10 to add as many identification stri
need.

To edit an existing search engine in the list:

1. On the Main Console, click Options in the Functions area. 
window opens.

2. In the left-side navigation area, expand the Main section an
Engines. The Main - Search Engines dialog box opens.



3. From the list, select the search engine you wish to edit.

4. Click Edit. The Search Engine Information dialog box opens. 

5. Select an element that you wish to edit from the Identification Strings area 
or the Keyword Indicators area.

6. Click Edit. The Names dialog box opens.

7. Edit the string as needed and click OK to return to the Search Engine 
Information dialog box. 

h Engines 

 Options 

ick Search 

st.
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8. Repeat Steps 5 through 7 to edit as many items as needed.

9. Click OK to accept your changes and return to the Main - Searc
dialog box.

To delete a search engine from the list:

1. On the Main Console, click Options in the Functions area. The
window opens.

2. In the left-side navigation area, expand the Main section and cl
Engines. The Main - Search Engines dialog box opens.

3. From the list, select the search engine you wish to delete.

4. Click Delete. The selected search engine is removed from the li
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Report Ranges Dialog Box
Report ranges define the time period for which you want to generate reports. 
You can choose to report on the contents of the entire log file, or you can limit 
how much you report on by selecting a time period for which to generate 
reports. Your firewall reporting solution installs with many pre-defined report 
ranges, but you can add, edit, or delete report ranges as needed. Use the Main - 
Report Ranges dialog box to perform these actions.

The Options 

d click Report 
Chapter

To add a new report range:

1. On the Main Console, click Options in the Functions area. 
window opens.

2. In the left-side navigation area, expand the Main section an
Ranges. The Main - Report Ranges dialog box opens.



3. Click New. The Define Report Range dialog box opens.

 report 
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4. In the Display Name text box, enter a descriptive name for the
range you are defining. This name will appear in the list of repo
the Main - Report Ranges dialog box.

5. Select This will be available in the Report Wizard to have yo
range listed in the Pre-defined Range dropdown menu in the 
Range tab. This tab appears either in the New Report or the Edi
dialog box when you create or modify a report template.

6. Type the macros that you want to use to designate the start of y
range. Or click Report Range Assistant to specify the report ra
learn how to enter macros for this purpose, see “Using Macros 
Report Range” on page 306.

7. Enter the macros that designate the end of your report range. To
to do so, see “Using Macros to Define a Report Range” on page

If you want the software to guide you as you enter your macros
provided text box, click Report Range Assistant. 
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8. Use the Profile Type dropdown list to select a profile type. Because the 
content of reports is different for each profile type, modifications to a 
“language” affect only the profile type that you select here.

9. In the Report Language pane, do one of the following:

− Select an existing language to modify it.

− Click Add to create a new language. When the Add New Report 
Language dialog box appears, type a name for your new report 
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language, and select an existing language to base it on.

10. The Report Items pane displays a tree containing the report
corresponding text areas. 

− Click Collapse All to close all of the books and view on
directories of the selected language tree. 

− Click Expand All to open all subdirectories and view th

− Click Find to access the Find/Replace dialog box, which
for and replace text that appears in the reports.

11. When you select a report text string in Report Items, the tex
Content text box. Edit the text in this text box and click Sav
Restore to revert to a previously saved text string (for the s
item or the entire report language.

12. If desired, click Set Default Language to define the languag
reports will use by default.

13. Click Save to keep your changes or Restore to return to th
settings.

14. Click OK to return to the Main Console.

To edit a report range:

1. Select the report range you wish to edit from the list.

2. Click Edit.

3. Edit any items in the dialog box and click OK to save your 
return to the Main - Report Ranges dialog box.



To delete a report range:

1. Select the report range you wish to delete from the list.

2. Click Delete. A confirmation message appears

3. Click Yes to confirm that you wish to delete the report range.

Using Macros to Define a Report Range
To specify a report range, you need both a reference point and units of time 

 the end of 
tion uses to 
e start and 
ossible 
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that your firewall reporting solution can use to calculate the start and
the range. A reference point is a fixed point that your reporting solu
add to or subtract units of time from when defining the report rang
end times. The date and time of the first record in your file is one p
reference point. 



 9 • Options     307

See the following tables to learn more about each of the items available in the 
report range macro "vocabulary." The column labeled What you enter shows 
you the exact characters that you enter in the text boxes provided in the Define 
Report Range dialog box.

The following table defines macros that set reference points.

Macro Name Macro text Macro Resolution

t you 

ate 
tured 
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nning 
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inning 
f the 

partic-
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The following table defines macros that set units of time.

Now >���> Sets the reference point to the time tha
run your log analysis report

Start of log >��.;> Sets the reference point equal to the d
and time stamp for the first record cap
in your log file

End of log >��.9> Sets the reference point equal to the d
and time stamp for the last record capt
in your log file

Macro Name Macro Text Macro Resolution

Seconds %sec% Depending on its context, sets the begi
of the report range at the current secon
at a particular second.

Minute %min% Depending on its context, sets the begi
of the report range at the first second o
current minute or at the first second of
ticular minute.

Hour %hr% Depending on its context, sets the beg
of the report range at the first second o
current hour or at the first second of a 
ular hour.



Day >��%> Depending on its context, sets the beginning 
of the report range at the exact point of mid-
night today or at the exact point of midnight 
on a particular day.

Week >�,> Depending on its context, sets the beginning 
of a report range at the exact point of mid-
night on the first day of the current week or 
on the first day of a particular week.

 

 

. 
 

g 

r 

Macro Name Macro Text Macro Resolution
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The definition of the first day of the week 
depends on what you have specified in the
Main Options page.

Four Week 
Period

>��,> Breaks the processed report into four-week
periods, but does not otherwise affect the 
report range you specify with other macros
Use this macro at the end of the first macro
string.

Month >#��> Depending on its context, sets the beginnin
of a report range at the exact point of mid-
night on the first day of the current month o
of a particular month.
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 reporting 
nge in the Main 
ed Report 

Report dialog 
re-defined 
cro strings.

Calendar 
Quarter

>�R	�> Depending on its context, sets the beginning 
of a report range at the exact point of mid-
night on the first day of the current calendar 
quarter, or at the exact point of midnight on 
the first day of a particular calendar quarter.

A calendar quarter is a three-month period.

inning 
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Report Range Macros in Pre-Defined Reports
To see how the pre-defined reports available with your firewall
solutions use macros to specify their ranges, click on a report ra
- Report Ranges dialog box and examine the Preview of Select
Range area at the bottom of the dialog box.

The pre-defined reports available in the Create Report and Edit 
boxes all use macros to specify their report ranges. Use these p
reports as examples to guide you as you construct your own ma

Fiscal Quarter >�R	�> Depending on its context, sets the beg
of a report range at the exact point of m
night on the first day of the current fisc
quarter, or at the exact point of midnigh
the first day of a particular fiscal quarte

A fiscal quarter is a three-month period
whose start depends on what you set i
Main Options dialog box as the start of
fiscal year.

Year >%�> Depending on its context, sets the beg
or a report range to the exact point of m
night on the first day of the current year
the exact point of midnight on the first d
a particular year.



Language Dialog Box
The Main - Language dialog box allows you to specify the language options for 
firewall activity reports. Alerting and Monitoring language options are set 
separately in the Alerting and Monitoring section of the Options window.

Besides the available choices of English, French, German, and Spanish, this 
dialog box lets you define specific phrases and titles as a part of the "language" 
to use in reports. You can also modify an existing language to meet your 
reporting needs.

:

 Options 

ick 
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To define report language settings for firewall activity reports

1. On the Main Console, click Options in the Functions area. The
window opens.

2. In the left-side navigation area, expand the Main section and cl
Language. The Main - Language dialog box opens.



 9 • Options     311

3. In the Profile Type dropdown list, select the profile type you wish to set 
language options for.

4. To use an existing language, select it from the list.

5. To add a new report language:

a. Click Add. The Add New Report Language dialog box opens. 

b. In the New Language Name text box, type the name of the new 

u wish to edit. 
e Content area 

e the text in the 

l be used by 
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ort language.
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language you are going to add to the list.

c. Click OK to return to the Main - Languages dialog box.

6. In the Report Items list, select any item from the list that yo
The language associated with the selected item appears in th
below.

7. If you wish to change the text that appears in reports, replac
Content area with the text you wish to see. 

8. Click Set Default Language to define the language that wil
default for all new reports. 

9. Click Save to save your changes.

10. Click OK to save your selections and changes.

Restoring Language Settings
Within the Main - Language dialog box, you can revert back to 
saved version of either the selected report item or the entire rep

Note
Click Collapse All or Expand All to collapse or expand the
Report Items list. To locate a specific report item, click Find
Find/Replace dialog box to search for and replace text that 
reports.



To restore language settings for a report item:

1. In the Main - Languages dialog box, select the report item you wish to 
restore.

2. Click Restore. The Content area should display the previously saved 
version of the selected item.

3. Click OK to save your changes.

To restore language settings for the entire report:

all reports. 

, select the 

veral 
ailable 

cale tab 
a Web 
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1. In the Main - Languages dialog box, click Restore.

2. Click OK to save your changes.

Specifying the Default Report Language
You can change which language to use as the default language for 

To specify the default report language:

1. In the Report Language list of the Main - Languages dialog box
report language you wish to set as the default language.

2. Click Set Default Language. 

3. Click OK to save your changes.

Report Date Format
Firewall Suite lets you display the date that appears in reports in se
formats. By default, the date is written in ##$��$%% format. Other av
formats are ��$##$%% and %%$##$��.

Note
The day of the week you select from the Weeks Start list on the Lo
determines what constitutes a week in your reports. See “Selecting 
Browser” on page 290 for details.
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To select a report date format:

1. On the Main Console, click Options in the Functions area. The Options 
window opens.

2. In the left-side navigation area, expand the Main section and click 
Language. The Main - Language dialog box opens.

3. Select a profile type from the dropdown list. The date format change 
applies to all reports of this profile type.

pand Date and 

type the format 

ths, names for 
 delimiter, and 
Chapter

4. If you are using an incoming profile:

a. Select a Report Language. The default is English.

b. In the Report Items area, expand Common Strings and ex
Local.

c. Select Report Date Format, and in the Content text box, 
option you wish to use in your reports.

Note
You can also change the abbreviations for days and mon
days and months, the Report Date delimiter, Report time
hours designated as Work Hours and After Hours.



5. If you are using an outgoing profile:

a. Select a Report Language. The default is English.

b. In the Report Items field, expand Tables and Graphs and expand 
Locale Variables (near the bottom of the list). 

c. Select Report Date Format, and in the Content text box, type the 
format option you wish to use in your reports. 

 to how 
gs 

Note
delimiter, 
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6. Click Save.

General Firewall Activity Options
The settings in the General Firewall Activity Options window apply
profiles and reports are processed. You can define a variety of settin
including the following: 

• The types of files and extensions to report on

• The types of domains to report on

• How often to retrieve the log file if accessed via HTTP or FTP

• The protocols logged by your firewall

• The size of the cache used for domain name (DNS) lookups

• How long to keep DNS lookups cached before deleting them

You can also change the Report Date delimiter, Report time 
and hours designated as Work Hours and After Hours by en
in the Content text box. 
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• How often to rotate WebTrends Syslog Service log files

• The Check Point LEA connections that can be selected when you create a 
profile that references a Check Point firewall with OPSEC LEA.

• The firewalls for which this product is licensed

• If you use a Cisco PIX firewall, which interfaces the firewall interacts with.

trol the DNS 
the terminate 
Chapter

General Firewall Activity - General Options
The General Firewall Activity - General dialog box lets you con
Cache size, set the frequency of the log file list refresh, specify 
user session interval, and define HTML report settings. 



To define General dialog box options:

1. On the Main Console, click Options in the Functions area. The Options 
window opens.

2. In the left-side navigation area, click General Firewall Activity. The 
General Firewall Activity - General dialog box opens.

3. In the Visitor Session Time-Out list, type or scroll to a number that to 
adjust the length of time for which, if there is no activity by a visitor to your 
site, his/her user session is considered terminated.

e title of 
 selected, 

ify the 
ys to save 
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4. Optionally select Retrieve HTML Page Titles to display the pag
your Web site pages in related report tables. If this option is not
only the URL of the page appears

5. Optionally select Store Cache on Disk for Later Use and spec
maximum number of page titles to cache and the number of da
them.

6. Click OK to save your changes.
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File Types Dialog Box
The General Firewall Activity - File Types dialog box of the Options window 
lets you add or remove the file extensions that Firewall Suite includes in the 
relevant tables and graphs. These lists are used in distinguishing hits and 
download counts.

The Options 

ll Activity 
ll Activity - File 
Chapter

To define file types:

1. On the Main Console, click Options in the Functions area. 
window opens.

2. In the left-side navigation area, expand the General Firewa
section and select the File Types option. The General Firewa
Types dialog box opens.

 



3.  Select the file type that you want to modify:

− Download File Extensions and Types adds or removes the file types 
that are included in the Most Downloaded File Types table and graph.

− Document File Extensions and Types adds or removes the file types 
included in report tables and graphs that track documents, for example 
Top and Least Requested Pages, Top Entry and Exit Pages, and Single 
Access Pages.

4. Click Edit to make changes to the selected list. If you selected:

 Extensions 
s and condi-

 Extensions 
s and condi-
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− Download File Extensions and Types, the Download File
and Types dialog box opens with a list of the file extension
tions.

− Document File Extensions and Types, the Document File
and Types dialog box opens with a list of the file extension
tions. 
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5. To add a file type, click Add to open the Add File Type dialog box and do 
the following:

ile type in your 

e if you wish to 
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ou wish to 
are generated 

o edit and click 
Chapter

a. Enter the file extension for the new file type and select:

− Always if you wish to always include requests for this f
reports.

− Only if they ARE NOT from a script or dynamic pag
include requests for this file type in your reports if they 
generated from a script or by a dynamic page.

− Only if they ARE from a script or dynamic page if y
include requests for this file type in your reports if they 
from a script or by a dynamic page.

b. Click Add to add the new file extension.

6. To edit a file type, select an item from the list that you wish t
Edit. 

7. Enter the file extension for the new file type.



8. Do one of the following:

− Select Always if you wish to always include requests for this file type in 
your reports.

− Select Only if they ARE NOT from a script or dynamic page if you 
wish to include requests for this file type in your reports if they are not 
generated from a script or by a dynamic page.

− Select Only if they ARE from a script or dynamic page if you wish 
to include requests for this file type in your reports if they are generated 
from a script or by a dynamic page.

nother tab.

the file 
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9. Click OK to save your file extension edits.

10. To remove a file type, select it from the list and click Remove. 

11. When the Firewall Types window reopens, click OK or select a

Warning
The Remove function does not ask you to confirm the removal—
type is removed immediately.
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Domains Dialog Box
The General Firewall Activity - Domains dialog box lets you add, edit, or 
remove the domain name suffixes that your firewall reporting solution includes 
in the listed domain name groupings, for example United States Domains, 
Government Domains, and Military Domains. 

The Options 

ll Activity 
ll Activity - 
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To add a domain grouping:

1. On the Main Console, click Options in the Functions area. 
window opens.

2. In the left-side navigation area, expand the General Firewa
section and select the Domains option. The General Firewa
Domains dialog box opens.

3. Click New.

4. Type the Domain Name and Domain Type.



5. In the text box to the right of the Domain Suffixes list, type the extension 
associated with your domain. For example, type .�D for government 
domains.

6. Click Add. The extension is added to the list.

To edit a domain grouping:

1. On the Main Console, click Options in the Functions area. The Options 
window opens.

2. In the left-side navigation area, expand the General Firewall Activity 
ctivity - 

 ;���	�and 

d.

t All to de-
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section and select the Domains option. The General Firewall A
Domains dialog box opens.

3. Select a domain grouping from the list.

4. Click Edit.

5. To add a domain extension to the list:

a. Enter the extension into the text box.

b. Click Add. 

6. To remove an item from the list.

a. Select the domain extension(s) you wish to remove. Use the
0	�� keys to select multiple items. 

b. Click Remove. Any selected domain extensions are remove

7. Click OK to save your changes.

Note
Click Select All to select all items in the list. Click Un-selec
select any selected item in the list.
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To delete a domain grouping:

1. On the Main Console, click Options in the Functions area. The Options 
window opens.

2. In the left-side navigation area, click General Firewall Activity and select 
the Domains option. The General Firewall Activity - Domains dialog box 
opens.

3. Select a domain grouping from the list.

he list.
Chapter

4. Click Remove.

5. Click OK. The selected domain grouping is removed from t



FTP Dialog Box
If your firewall log file is retrieved by either HTTP or FTP, you can configure 
how frequently the log file is downloaded. More frequent downloads require 
more processing time, but ensure that your log file data is more current. Keep 
in mind that file access to your log file is quicker than either of these methods.

Note
Most firewalls do not allow you to download files via HTTP or FTP, but if yours 
does, these settings apply. If you only access the firewall log file through file 
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retrieval, you don’t need to define these settings.
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To specify how often to download the log file via HTTP or FTP:

1. On the Main Console, click Options in the Functions area. The Options 
window opens.

2. In the left-side navigation area, expand the General Firewall Activity 
section and select the FTP option. The General Firewall Activity - FTP dialog 
box opens.

3. Select one of the following options:

wish to 
ted, regardless 

ts until 
 only one time 
generated on it 
tion for best 

ted in the 
n new activity 
wall reporting 
ce the last 
nged.

ce, click Flush 
e for all 
ssed via HTTP 
tored.

provide a 
in your log file.
Chapter

− Always download the log file for each report if you 
download the log file every time a new report is genera
of whether there is any new activity.

− Download log file and keep it for subsequent repor
WebTrends is exited if you wish to retrieve the log file
during each session, regardless of the number of reports 
or whether there has been any new activity. Use this op
performance when creating several successive reports.

− Download the log file only when changes are detec
remote file if you wish to retrieve the log file only whe
has been recorded. Each time you run a report, your fire
solution determines whether the log file has changed sin
report was run and updates the log file only if it has cha

4. To clear the entries in the log file cache and restore disk spa
Log File Cache. Flushing the Log File Cache clears the cach
profiles. However, when you report on a log file that is acce
or FTP, the file must be downloaded until the entries are res

Protocols Dialog Box
General Firewall Activity reports include tables and graphs that 
summary of protocol activity and details for a specific protocol 



For reporting purposes, protocols from your log file are associated with (or 
assigned to) a specific type of protocol (protocol family) in the General Firewall 
Activity - Protocols dialog box of the Options window. Types of protocols may 
include email, FTP, RealAudio, Telnet, or Web. You can associate protocols in 
groups that make the reports responsive to your needs. You can even create 
your own family of protocols.

w protocols 
 protocol as 
 how the 
. 
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The Protocol in Log File and Type of Protocol columns show ho
are currently defined. The Protocol in Log File column identifies the
it is recorded in the log file. The Type of Protocol column indicates
associated Protocol in Log File has been set up to appear in reports
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Any protocol not included in the Protocol in Log File list or associated with a 
type of traffic is reported as “other.” The activity of these non-associated 
protocols is difficult to analyze.

l Family filter. 
filtering 

 file and assign 
alyzed and 

The Options 

ll Activity 
all Activity - 

Note
To determine if protocols are defined correctly, run a General Firewall Activity 
report, and view the Incoming Protocol Usage and Outgoing Protocol Usage 
tables. These tables display the protocols found in the log file. You can 
compare these protocols to those found in the Protocols dialog box. Any 

tegories should 
Chapter

You can further refine the reports on protocols with the Protoco
See “Protocol Family” on page 195 for more information about 
protocols.

You may want to add a new protocol that is present in your log
its protocol type to determine how this new protocol will be an
presented in reports. 

To add a new protocol and assign its type:

1. On the Main Console, click Options in the Functions area. 
window opens.

2. In the left-side navigation area, expand the General Firewa
section and select the Protocols option. The General Firew
Protocols dialog box opens.

protocols not listed here that apply to one of the pre-defined ca
be added. 



3. Click New. The New Protocol dialog box opens.

ame as it 

ns: 

n list.

ew type of 
t from now 

 Options 

ctivity 
ctivity - 
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4. In the Protocol appearing in log text box, type the protocol n
appears in your firewall log,

5. Assign the protocol type by choosing one of the following optio

− Select a protocol type from the Type of Protocol dropdow

− Type a name in the Type of Protocol text box to create a n
protocol. This new type will be available in the dropdown lis
on, unless you delete all protocol names assigned to it.

6. Click OK to return to the Protocols dialog box.

7. Click OK to save your changes. 

To edit an existing protocol:

1. On the Main Console, click Options in the Functions area. The
window opens.

2. In the left-side navigation area, expand the General Firewall A
section and select the Protocols option. The General Firewall A
Protocols dialog box opens.

3. Select the protocol you wish to edit.

4. Click Edit. The Edit Protocol dialog box opens.



 9 • Options     329

5. In the Protocol appearing in log text box, type the protocol name as it 
appears in your firewall log.

6. Assign the protocol type by choosing one of the following options: 

− Select a protocol type from the Type of Protocol dropdown list.

− Type a name in the Type of Protocol text box to create a new type of 
protocol. This new type will be available in the dropdown list from now 
on, unless you delete all protocol names assigned to it.

The Options 

ll Activity 
all Activity - 

 Domain Name 
e. 
Chapter

7. Click OK to return to the Protocols dialog box.

8. Click OK to save your changes. 

To delete an existing protocol:

1. On the Main Console, click Options in the Functions area. 
window opens.

2. In the left-side navigation area, expand the General Firewa
section and select the Protocols option. The General Firew
Protocols dialog box opens.

3. Select the protocol you wish to delete.

4. Click Delete. The selected protocol is deleted from the list.

DNS Dialog Box
When you create a Firewall activity profile, you can determine a
System (DNS) lookup method and the location of the DNS cach



Use the DNS dialog box to optimize DNS lookups for the profiles when you’ve 
chosen to use either Resolve Mode or Auto Mode with the profile.

 Options 

ctivity 
 - DNS 

eue used to 
 of the 
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To specify DNS Lookup options:

1. On the Main Console, click Options in the Functions area. The
window opens.

2. In the left-side navigation area, expand the General Firewall A
section and select the DNS option. The General Firewall Activity
dialog box opens.

3. In the Size of DNS Lookup Queue list, select the size of the qu
process DNS lookups. The default is 10,000. Increasing the size
queue can speed up processing, but it takes more memory.
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4. In the DNS Lookup Timeout list, select the number of milliseconds that 
must elapse before DNS lookups time-out. If DNS lookup is unsuccessful 
within this time span, your firewall reporting solution assumes failure. The 
lookup for the IP is recorded in the cache as failed. No further DNS lookup 
is attempted until the cache expires.

5. In the DNS Cache Expiration list, select the number of days that a domain 
name will be retained in the cache. After this number of days passes for a 
given IP address, it is discarded from the cache. If the IP address is 

ache the next 

esolve to the 
e less accurate 

.225.44, 
d, only one 
 first three 
es. 
Chapter

encountered at a later date, it is resolved and added to the c
time the profile is used.

6. If desired, select the Ignore last octet of IP check box to r
network ID. This can speed up processing, but results may b
because the last part of the IP address is ignored. 

For example, the following log entries:

����A��A�����
��
�����B�B����B����P�*�;<0K
��*9:;9!<9!�P�591�$����
�	��	#S
����A��A�����
��
�����B�B����B��B�P�*�;<0K
��*9:;9!<9!�P�591�$��.����%7��$������	#S
����A��A�����
��
�����B�B����B����P�*�;<0K
��*9:;9!<9!�P�591�$�	%���$�	%�������S

would normally trigger three separate DNS lookups (195.52
195.52.225.45, 195.52.225.46). With Ignore last octet enable
lookup occurs (195.52.225.44). Since all three have the same
parts, the first lookup is applied to the other two IP address

7. Click OK to save your changes.



Syslog Dialog Box

Use the General Firewall Activity - Syslog dialog box to modify the settings for 
the WebTrends Syslog Service.

 Options 

ctivity 
ity - Syslog 

Note
You must have Administrator rights on the Firewall Suite computer to be able to 
define the WebTrends Syslog Service settings.
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To define WebTrends Syslog Service settings:

1. On the Main Console, click Options in the Functions area. The
window opens.

2. In the left-side navigation area, expand the General Firewall A
section and select the Syslog option. The General Firewall Activ
dialog box opens.
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3. In the Log File Rotation area, select how often you want the current log file 
archived and a new log started.

4. In the Syslog Server IP Address area, choose a binding method. Select:

− Bind to all IP addresses to assure that all IP addresses respond to the 
Syslog Server. This is the default setting. Do not bind to a specific IP 
address unless absolutely necessary.

− Bind to a specific IP address and select the address from the 
Chapter

dropdown list. 

5. Click OK to save your changes.



LEA Connections Dialog Box
The LEA Connections dialog box lists all currently configured connections 
between a Check Point firewall and the WebTrends LEA Service. A Check Point 
LEA connection is required for the WebTrends LEA Service to collect Check 
Point log data. Use this dialog box to create, edit, and delete LEA connections. 
When you create a profile that uses Check Point with OPSEC LEA, you select 
one of the LEA connections in the list to collect the log data. 
334     User Guide
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Before you add or edit connections, make sure you have configured your 
Check Point firewall to communicate with the WebTrends LEA Service. You 
need information about your Check Point configuration to create a LEA 
connection. For instructions on configuring Check Point firewalls, see the 
Firewall Configuration Guide or the Firewall Suite Help.

 create a 
nnections can 
ot user-defined 
 installation 

The Options 

ll Activity 
dialog box 

quired infor-

Edit , then edit 
dialog box.

ined connec-

k Delete.

Note
You can fine-tune your LEA connection settings using the *�(	�������� file in 
the Firewall Suite installation directory. For more information, see the Firewall 
Chapter

About User-Defined Connections
When you create a user-defined connection, you must manually
�������� file to define the connection settings. User-defined co
only be edited by changing the settings in this file. To troublesho
connections, check the ������D������.�file in the Firewall Suite
directory.

To manage Check Point connections: 

1. On the Main Console, click Options in the Functions area. 
window opens.

2. In the left-side navigation area, expand the General Firewa
section and click LEA Connections. The LEA Connections 
opens.

− To add a LEA connection, click New and provide the re
mation in the New LEA Connection wizard. 

− To edit a LEA connection, select a connection and click 
the information in the tabs on the Edit LEA Connection 

You cannot edit a user-defined connection. For user-def
tions the Edit icon is grayed out. 

− To delete a LEA connection, select a connection and clic

Configuration Guide.



Creating a LEA Connection

To create a new LEA connection:

1. On the Main Console, click Options in the Functions area. The Options 
window opens.

2. In the left-side navigation area, expand the General Firewall Activity 
section and click LEA Connections. The LEA Connections dialog box 
opens.

me that will 
dialog box. 
 your 
 Check 
), or a 

d the type 
ormation 
tion Guide 

ined from 

 this 
Trends LEA 

 connection 
e, and only 
list. After 
 using the 
ut User-
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3. Click New.

4. The General dialog box opens.  In the Name text box, type a na
identify this LEA connection when you select it in the Log Files 
For example, depending on the number and type of firewalls in
configuration, you might use the host name or IP address of the
Point Management Server, the version of the firewall (4.x or NG
connection type such as sslca or Unauthenticated. 

5. Select the type of Check Point firewall you want to report on an
of OPSEC LEA connections you want to configure. For more inf
about Check Point connection types, see the Firewall Configura
or the Firewall Suite Help.

6. If you selected Check Point vNG, select sslca, clear, or user-def
the list.  

7. To enable or disable the connection, clear or select the Disable
connection check box. When a connection is disabled, the Web
Service cannot collect Check Point firewall data.

Note
Select user-defined only if you want to create a custom NG
type by manually configuring the �������� configuration fil
if you do not want to use any other connection type in the 
they are created, user-defined connections cannot be edited
Firewall Suite user interface. For more information, see “Abo
Defined Connections” on page 335
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8. Click Next.  The Location dialog box opens.

9. In the Directory text box, browse or type a path to the directory where 
you want the WebTrends LEA Service to store the Check Point firewall logs 
it collects. The path must be unique, because you cannot store logs for 
more than one LEA connection in the same directory.

10. In the Host IP Address text box, type the IP address of the computer 
where the Check Point Management Server is installed. 

ds LEA Service 
he default port 

clear 
ton to return to 
l your 
g box. When 
nection.  

Step 5, the 
ng on the 
e enabled. For 
need for the 
r the Firewall 

 OPSEC 
e DN number 
PSEC 

N number for 
 number can 

ct Properties 
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11. In the Host Port text box, type the port number the WebTren
should use to communicate with the Check Point firewall. T
is �����.

12. Click Next.

13. If you chose Check Point v4.x or Check Point NG with a 
connection in Step 5, use the Back, Finish, or Cancel but
the previous screen, save your connection settings, or cance
connection settings and return to the LEA Connections dialo
you click Finish, Firewall Suite attempts to establish the con

14. If you selected any other Check Point NG connection type in 
Type-Specific panel opens. Continue with Step 15. Dependi
connection type you chose, not all the fields in this panel ar
more information about how to obtain the information you 
Type-Specific panel, see the Firewall Configuration Guide o
Suite Help.

15. In the LEA SIC Name text box, type the DN number for the
application you created in the Check Point Policy Editor. Th
can be found under Secure Internal Communication in the O
Application Properties dialog box. 

16. In the Management Server SIC Name text box, type the D
the Check Point Management Server network object. The DN
be found under Secure Internal Communication in the Obje
dialog box. 



17. In the Certificate File Name text box, type the name of the certificate file 
created using the �������
������	 tool. The default name for the certificate 
file is ���������. 

18. Use the Back, Finish, or Cancel button to return to the previous screen, 
save your connection settings, or cancel your connection settings and return 
to the LEA Connections dialog box. When you click Finish, Firewall Suite 
attempts to establish the connection.  To check the status of the connection, 
see “Check Point LEA Status” on page 338. 
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Check Point LEA Status
You can check on the status of LEA connections you create using th
Connection status dialog box.

To check LEA connection status:

1. Select LEA Connection Status from the Tools menu.

2. To monitor the status of a connection, check the Status column.
following table explains the meaning of each connection  status

3. To determine how much data was transferred, check the Log Si

4. To disable a connection, select it in the list and click Disable.

5. To create, edit, or delete connections, click Manage to open the
LEA Connections dialog box.

Uninitialized Connection information has been saved, but
nection has not yet been established.

Successful The LEA service connected successfully and
lected data with no errors.

Connection Error An error was generated before, during or aft
necting.

Critical Error The LEA service itself generated an error, ca
connection failure.
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Licensed Firewalls Dialog Box
The General Firewall Activity - Licensed Firewalls dialog box lists the licensed 
firewalls that are defined for your system. These licensed firewalls were 
specified when you created a profile. 

The standard software license lets you install your firewall reporting solution on 
one system and report on one firewall. To report on more than one firewall, 
you must purchase Firewall Add-Ons. For example, a 3 Firewall Add-On license 

al of four 
e add-ons.
Chapter

lets you install Firewall Suite on one system and report on a tot
firewalls. Contact NetIQ Corporation or your reseller to purchas



To view the list of licensed firewalls:

1. On the Main Console, click Options in the Functions area. The Options 
window opens.

2. In the left-side navigation area, expand the General Firewall Activity 
section and select the Licensed Firewalls option. The General Firewall 
Activity - Licensed Firewalls dialog box opens.

3. Review the list and click OK to exit the dialog box.

later only. 
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Cisco PIX Interfaces Dialog Box
The Cisco PIX Interfaces dialog box is used for Cisco PIX v6.2 and 
Using this dialog box to map interfaces increases the usefulness of 
when the PIX firewall is configured in connection with more than o
to a device or network. For example, the firewall may use an interfa
device as well as to the network, or it may connect to more than on
When you define these interfaces in the Cisco PIX Interfaces dialog
Firewall Suite can parse the device names found in your log files an
to report more effectively on the direction of traffic through the fire

To add or edit an interface:

1. Click New, or select an interface name and click Edit.

2. In the Interface Name text box, type the name of the device or 
it appears in the log file.

3. Click OK to save your changes, or click Cancel to abandon the

4. Click OK again to save the list of interfaces and exit the dialog 

To delete an interface:

Select the interface in the list and click Delete.
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Alerting and Monitoring Options
The Alerting and Monitoring options define settings that apply to Alerting and 
Monitoring profiles and reports, including report language settings and access 
to response schedules, configurations and actions.

Alerting & Monitoring - General Dialog Box
nitoring. Here 
r alerts, and 
Chapter

The General options affect the performance of Alerting and Mo
you can disable Alerting and Monitoring, reset the alert log, clea
define the number of threads you need for processing.



To set General dialog box options:

1. On the Main Console, click Options in the Functions area. The Options 
window opens.

2. In the left-side navigation area, click Alerting & Monitoring. The Alerting 
& Monitoring - General dialog box opens.

3. Modify any of the following settings:

− Select Disable Alerting and Monitoring cartridge to turn off Alerting 
and Monitoring. Devices are not monitored when Alerting and 

 monitored 

x, type or 
hread 
ds is 

hile you are 

ing log file. 
og file, and 
using this 
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Monitoring is disabled. 

− Select Generate Startup Responses to send a response if a
device is down when Firewall Suite is started.

− In the Number of simultaneous monitor threads text bo
select the number of devices you will be monitoring. Each t
monitors one device.A maximum of 100 simultaneous threa
allowed. 

− Click Clear All Pending Alerts if you need to reset alerts w
troubleshooting or repairing profile settings.

− Click Flush All Log Files to delete the Alerting and Monitor
If you find that you no longer need to report on the entire l
you want to purge the log files to start over, you can do so 
feature.

4. Click OK to save your changes.



 9 • Options     343

Response Schedules Dialog Box
The Alerting & Monitoring - Response Schedules dialog box allows you to 
create, edit, and delete response schedules for the Alerting and Monitoring 
module. Configuring responses for Alerting and Monitoring profiles is discussed 
in-depth in “Alerting and Monitoring” on page 103.

The Options 

itoring section 
- Response 
Chapter

To add, edit or delete a response schedule:

1. On the Main Console, click Options in the Functions area. 
window opens.

2. In the left-side navigation area, expand the Alerting & Mon
and click Response Schedules. The Alerting & Monitoring 
Schedules dialog box opens.



3. Choose one of the following three options:

− Click New. The Edit Response Schedule dialog box opens. For more 
information, see “Alerting and Monitoring” on page 103.

− Select a response schedule from the list and click Edit. The Response 
Configuration dialog box opens. For more information, see “Alerting 
and Monitoring” on page 103.

− Select a response schedule from the list and click Delete to remove the 
response schedule from the list.
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4. Click OK to save your changes.
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Response Configurations Dialog Box
The Alerting & Monitoring - Response Configurations dialog box allows you to 
create, edit, and delete response configurations for the Alerting and Monitoring 
module. Configuring responses for Alerting and Monitoring profiles is discussed 
in-depth in “Alerting and Monitoring” on page 103.

The Options 

itoring section 
oring - 
Chapter

To add, edit, or delete a response configuration:

1. On the Main Console, click Options in the Functions area. 
window opens.

2. In the left-side navigation area, expand the Alerting & Mon
and click Response Configurations. The Alerting & Monit
Response Configurations dialog box opens.



3. Choose one of the following three options:

− Click New. The Response Configuration Settings dialog box opens. For 
more information, see “Alerting and Monitoring” on page 103.

− Select a response schedule from the list and click Edit. The Response 
Configuration Settings dialog box opens. For more information, see 
“Alerting and Monitoring” on page 103.

− Select a response configuration from the list and click Delete to remove 
the response configuration from the list.
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4. Click OK to save your changes.
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Response Actions Dialog Box
− The Alerting & Monitoring - Response Actions dialog box allows you to 

create, edit, and delete response actions for the Alerting and Monitoring 
module. Configuring responses for Alerting and Monitoring profiles is 
discussed in-depth in “Alerting and Monitoring” on page 103.

.

The Options 

itoring section 
sponse Actions 
Chapter

To create a response action for a response schedule:

1. On the Main Console, click Options in the Functions area. 
window opens.

2. In the left-side navigation area, expand the Alerting & Mon
and click Response Actions. The Alerting & Monitoring - Re
dialog box opens.



3. Choose one of the following three options:

− Click New. The Edit Response Actions dialog box opens. For more 
information, see “Alerting and Monitoring” on page 103.

− Select a response schedule from the list and click Edit. The Edit 
Response Actions dialog box opens. or more information, see “Alerting 
and Monitoring” on page 103.

− Select a response action from the list and click Delete to remove the 
response action from the list.
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4. Click OK to save your changes.
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Language Dialog Box 
Use the Language dialog box to define your own text to use in alerting and 
monitoring reports.The Language options for Firewall and Proxy Server reports 
are available in the Main - Language options. For more information, see 
“Language Dialog Box” on page 310. 

The Options 

itoring section 
dialog box 
Chapter

To set language options:

1. On the Main Console, click Options in the Functions area. 
window opens.

2. In the left-side navigation area, expand the Alerting & Mon
and click Language. The Alerting & Monitoring - Language 
opens.



3. Under Report Language, select an existing language to modify from the 
dropdown list, or click New to open the Add New Report Language dialog 
box and specify a new language name.

4. Under Language Contents, you see a tree of the report sections and 
corresponding text areas. 

− Click Collapse All to close all of the books and view only the first 
directories of the selected language tree. 

− Click Expand All to open all subdirectories and view the entire tree.

 can search 
 text.

in the 
 one of the 

 for the 

 the default 
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− Click Find to access the Find/Replace dialog box where you
for text that appears in reports and replace it with your own

5. Under Content for Selected Item, selecting a report text area 
Report Items section displays the text in the Content section. Do
following:

− Edit the text in this field and click Save. 

− Click Restore to revert to a previously saved version of text
selected Report Item or the entire Report Language.

− Select a language and click Set Default Language to define
language to use for all new reports.

6. Click OK to save your changes.
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Appendix A

Specifying Log Paths

xamples in this 

.

erver.

th.
Appendix A • Specifyin

Formatting Log File Path Entries
If you are having trouble specifying your log file location, the e
section may help.

Standard Examples

This path: Specifies

�
���.���������������. a local file location

�	����#������#$��.�$�������������.� a path to an FTP s

������#������#$��.�$�������������.� an HTTP log file pa



Compressed Logs

ildcards in 
retrieval 
ing ftp or 


$$$ 

type one of 

This path: Specifies

�
���.�������������7��� the zipped log 
�����������7��

�	��������#$��.�$�����������.7 the compressed log 
�����������.7, located 
in the���. directory on 
the ������# FTP server. 
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Wildcards
When you specify multiple files, use asterisks or question marks as w
the file name only when using the ����
$$$, �	�
$$, and �		�
$$�
methods. Do not use wildcards in the rest of the path when specify
http access. For example, type one of the following: 

�
���.���������D��������'���.

�
���.���������D�������������'���.

�
���.���������D��������������8���.

You can use wildcards in the file name itself when you specify ����
retrieval method only. For example, type one of the following:

�
���.���������D��88��������������.

�
���.������'�'���.

You can also use a vertical bar (&) to separate entries. For example, 
the following:

�
���.���������D�������������������.&����������B���.

�
���.���������D�����'���.&����D�����'���.

�
���.������'������������.&�
���.������'������������.
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Date Macros

The following table shows the information returned by date macros.

Note
Date macros are case sensitive. For example,�>-��> returns Jan,�#�� returns jan, 
and -)3 returns JAN 
Appendix A • Specifyin

This date macro Returns the following dates:

>��> Day 

>##> Month (2-digit) 

>-��> Month (Abbr) 

>%%> Year (2-digit) 

>LLLL> Year (4-digit) 

>?�	�A�> Subtract n days from the current system date

>?�	�Q�> Add n days to the current system date

>##A�> Subtract n days from the current system date

>##Q�> Subtract n days from the current system date

>%%A�> Subtract n days from the current system year

>%%Q�> Add n years to the current system year

>%%%%A�> Subtract n years from the current system date

>%%%%Q�> Add n years to the current system date

>�%> Day of year

>�%> Week of year



Date Macro Examples

>�#> Week of month

>��> Day of week

>�#> Day of month

����.

This date macro Returns the following dates:
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The following examples use 02/24/2000 as the current system date.

IP Addresses
The following table shows how to specify ranges of IP addresses.

This macro: Specifies this path

�
�����	��%�	�#��
���.��������>%%%%>>##>>��>���.�

�
�����	��%�	�#�����.A
�������������������.

�
�����	��%�	�#��
���.��������>%%%%>>##>'���.

�
�����	��%�	�#�����.A
��������������'���.

�
�����	��%�	�#��
���.��������>?�	�A
B>>%%%%>>##>>��>���.

�
�����	��%�	�#�����.A
�������������������.

�
�����	��%�	�#��
���.������������A>-��>$>��>$
>%%%%>���.

�
�����	��%�	�#�����.A
������������A��($��$���

This IP address Specifies

�BB�' An entire Class A subnet

�BB��BB�' An entire Class B subnet

�BB��BB�' An entire Class C subnet
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 can modify 

 that focus on 
r profiles. For 
57.

�����������$�� A classless subnet in CIDR format (where /28 
indicates the number of bits used to identify the 
network)

�����������$�� Addresses 0–63 of a Class C address space that is 
divided into four subnets

������������$�� Addresses 64–127 of a Class C address space that 

ss space that 

ss space that 

 space that is 

ss space that 

This IP address Specifies
Appendix A • Specifyin

Performance
A number of factors can affect how Firewall Suite performs. You
many of these options to suit your environment. 

Using Filters to Optimize Performance
To maximize performance on your system and to create reports
just the data you’re interested in, consider adding a filter to you
more information, see “Filtering for Focused Reports” on page 1

is divided into four subnets

�������������$�� Addresses 128–191 of a Class C addre
is divided into four subnets

�������������$�� Addresses 192–255 of a Class C addre
is divided into four subnets

�����������$�B Addresses 0–127 of a Class C address
divided into two subnets

�������������$�B Addresses 128–255 of a Class C addre
is divided into two subnets



Running Reports Without DNS Lookup
Domain Name System (DNS) lookups translate the numeric IP address into a 
domain name. Most users consider domain names more useful for analysis than 
IP addresses, but DNS lookup (or DNS resolution) can be a slow process. 

DNS lookups can be done either by the firewall or proxy server or by Firewall 
Suite when analyzing the log file. However, DNS lookups are performed more 
efficiently by the firewall or proxy server as the log is created—if this server 
option is available to you, you can optimize processing by using it.

 lookups at 
ick mode 

net 

 a database 

ctivate 

 page 72.

al. If you 
n the log 
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If numeric IP addresses are adequate for your needs, do not do DNS
all. Disable DNS lookups in the firewall or proxy server and use Qu
for DNS lookups in Firewall Suite. For more information, see “Inter
Resolution Dialog Box” on page 45.

Activating FastTrends
The FastTrends feature lets you collect data for the current profile in
so that future reports can be generated more quickly. 

To turn on FastTrends:

1. On the Main Console, select the profile for which you want to a
FastTrends.

2. Click Edit to display the Edit Profile dialog box.

3. Select the Database and Real-Time tab.

4. Select the FastTrends database check box.

For more information, see “Database and Real-Time Dialog Box” on

Accessing the Log File
The fastest way to access the log file for a site is through file retriev
can access the log file locally, your analysis is quicker than it is whe
file is retrieved via HTTP or FTP.
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Selecting the Report Type
HTML document reports are the fastest to create. All other report types (such as 
Microsoft Word or Excel) are based on this HTML report.

Alerting and Monitoring creates only HTML reports.

For firewall profiles, see “Memorized Report Settings” on page 203.

e system space. 
zip. 
Appendix A • Specifyin

Zipping Archived Log Files
Firewall Suite can report on zipped log files, allowing you to sav
Zip your archived log files using a tool such as WinZip or PKUn
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Appendix B

Silent Installation

warning 
on will abort at 

add a license to 
.

 Do not attempt 
network.
Appendix B • Silen

Disk Space
Make sure to check for available disk space. You will receive a 
message when 200 MB of disk space are left. The silent installati
50 MB. 

Licensing Issues
Silent installations do not handle licensing for Firewall Suite. To 
these products, use the command-line executable wtlicense.exe

Warning
An unattended or “silent” installation is for advanced users only.
this procedure if you are unfamiliar with Firewall Suite or your 



Silent Installation for Windows NT, Windows 2000, 
and Windows XP

While some of the parameters described below are optional, others are 
required. Pay attention to the order as well as the case of the commands. 
Failure to follow the required order or use the correct case will cause problems 
with your Firewall Suite installation. 

To run a silent installation:
360     User Guide

Run the setup program with the following syntax: 

��	
������$;�= Silent Install

$3);@-J"9;�= No Sample Profiles

$= = destination path

Installing as Administrator
To run a silent installation as administrator:

Run the setup program using the following syntax: 

��	
������$;�$=?9;1=3@1=)34���	����	�������	���	������	�

Please note the following:

Notes:
The parameters must be given in the order presented

The parameter�$?9;1=3@1=)3 does not include quotes.

Notes:
The parameters must be given in the order presented

The parameter�$?9;1=3@1=)3 does not include quotes.
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If you do not want to install sample files, you can use the 
$3);@-J"9; parameter with the following syntax:

��	
������$;�$3);@-J"9;�$=?9;1=3@1=)34���	����	�������	���	������	��
Appendix B • Silen
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thentication  Technique by which 
cess to Internet or intranet resources 
quires users to identify themselves 
ing a name and password.

ndwidth Measure (in kilobytes of data 
nsferred) of the traffic on the site.

owser A program used to locate and 
w HTML documents (Netscape 
vigator, Mosaic, Microsoft Explorer, for 
ample).

tegory A category is a predefined 
ouping of URLs that have a common 
eme, such as Shopping, Games, and 
rsonals/Dating.

ient The browser used by a visitor to a 
eb site.

ient error An error occurring due to an 
valid request by the visitor’s browser. 
ient errors are in the 400-range. See 
turn Code.

company database The pro
database used by Firewall Su
up the company name, city, 
country corresponding to a s
domain name.

connection A record of any
activity as recorded in the fire
unique user is determined by
address or domain name. Co
only applies to general profil
For example, for an ftp file d
both the request and the dow
considered a single connectio
connection would correspon
hit. 

Core categories A set of UR
that may present liability con
as sex or gambling sites.



critical event  In Firewall Suite reports, a 
firewall event that meets the following 
criteria:

• Gauntlet: The event is logged 
as a “security alert.”

• Check Point: The event is 
logged as “rejected.”

• Raptor: The event has an error 

FTP Acronym for File Transfer Protocol, 
which is the way that most files are sent 
between computers over the Internet.

General Firewall Activity reporting A 
type of analysis that lets you analyze and 
report on general Web statistics, potential 
attacks on the firewall, and protocol 
usage.

eb site. 
 visitors 
e rest of 
 to a 

col, a 
data 
b 

uite, 
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 users 

e feature 
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code of 500 or greater.

domain name The text name corre-
sponding to the numeric IP address of a 
computer on the Internet, for example  
www.webtrends.com.

Domain Name System (DNS) lookup 
The process of converting an numeric IP 
address into a text name. For example, 
204.245.240.194 is converted to 
www.webtrends.com.

event A firewall activity recorded in a 
line of the firewall log file is usually 
referred to as a firewall event. A log 
analysis and reporting job in the 
Scheduler is also called an event. It is 
usually referred to as a scheduled event. 

FastTrends database This patent-
pending technology makes it possible to 
store the results of the log file analysis in 
a database to significantly speed future 
reports based on the same profile.

filter A means of narrowing the scope of 
a report by specifying the log file data 
that you want to include or exclude in a 
profile.

home page The main page of a W
The home page usually provides
with an overview and links to th
the site. It often contains or links
table of contents for the site.

HTTP Hyper Text Transfer Proto
standard method of transferring 
between a Web server and a We
browser.

incoming activity In Firewall S
activity initiated on outside of th
firewall, coming through the fire
considered incoming activity.

IP address An Internet Protocol
identifying a computer connecte
Internet.

IP spoofing An attack on a netw
uses false IP addresses to imitate
with access rights. 

Language Editor A Firewall Suit
that lets you change the languag
available for reports. You can als
your own “language” by modifyi
text that appears in Firewall Suite
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OPSEC LEA Check Point’s OPSEC Log 
Export API, a proprietary method of 
logging firewall data.

outgoing activity Any activity that is 
initiated behind the firewall and then 
goes through the firewall.

ping of death An attack executed by 

real-time analysis A technique that lets 
Firewall Suite continuously collect data in 
the background to speed up the creation 
of future reports based on the same log 
file.

referrer URL of an HTML page that 
refers to your Web site.

by Firewall 
 of the log 
d graphs. 

iles.

e of the log 
n.

s of a 
ies whether 
d why.

configured 
ine what 
d where 
f activity is 
 firewall 

rotocol, a 
il programs 
.

 feature that 
rs, fonts, 

or HTML 
using an illegally large TCP/IP ping 
packet to halt a target computer by 
breaking down its buffers. 

platform The operating system used by 
a visitor to a Web site.

profile A collection of settings used by 
Firewall Suite to create reports. A profile 
defines how to access the log file and 
where the log file resides. It also sets up 
IP resolution, filters, IP addresses behind 
the firewall, and, in the case of Incoming 
Web Activity profiles, the Web site’s home 
page. All reports are based on profiles.

Productivity categories A set of URL 
categories that may have a negative 
impact on an employee productivity but 
do not pose a legal risk to employers. 

Protocol A set of rules used to send data 
over the Internet. Some common 
protocols are HTTP, FTP, and SMTP. 

RealAudio An Internet sound technology 
developed by RealNetworks. Because 
RealAudio requires a great deal of 
bandwidth, many firewalls block 
RealAudio activity. 

report A document created 
Suite that presents the results
file analysis through tables an
All reports are based on prof

report range The time rang
file that you want to report o

return code The return statu
transfer request which specif
the transfer was successful an

Rules A set of specifications 
on the firewall. Rules determ
users on the inside can do an
they can go, and what type o
allowed to come through the
from the outside.

SMTP Simple Mail Transfer P
protocol used by Internet ma
such as Eudora and Netscape

Style Editor A Firewall Suite
allows you to define the colo
and table and page layouts f
reports.



SYN flood An attack that bombards the 
firewall with requests to synchronize TCP 
connections, which causes the firewall to 
allocate all available buffer space to these 
requests. The firewall is then unable to 
accept any legitimate connections.

Sync Storm See Syn Flood.

TCP/IP Transmission Control Protocol/

User session A session of Web activity 
(all hits) as recorded in the firewall logs, 
including both FTP and HTTP activity. A 
unique user is determined by the IP 
address or domain name. By default, a 
user session is terminated when a user 
falls inactive for more than 30 minutes. 
User sessions only apply to incoming and 
outgoing profile reports.

PN uses 
 
data 

eets the 

s not 
ert.”

nt is 

ogged 
 200–499.

tion of 
f 
 can use 
s, URLs, 
th for 
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Internet Protocol, a required Internet 
protocol.

Tunneling Using the Internet to create a 
private secure network.

UDP User Datagram Protocol, a protocol 
that can substitute for the TCP part of 
TCP/IP. Although UDP does not provide 
all the data that TCP does, it does provide 
port numbers to differentiate requests 
and can verify data arrival.

URL Uniform Resource Locator, a means 
of identifying an exact location on the 
Internet.

URL categorization A Firewall Suite 
feature that categorizes sites visited by 
their content.

URL database A database of URLs 
indexed by category.

VPN Virtual Private Network. A V
the Internet to establish a secure
connection using tunneling and 
encryption.

Warning A firewall event that m
following criteria:

• Gauntlet: The event i
logged as “security al

• Check Point: The eve
logged as “dropped.”

• Raptor: The event is l
with a code between

Wildcard  A symbol or combina
symbols that stands for a range o
characters. In Firewall Suite, you
wildcards to specify log file path
filter entries, and the Save/As pa
reports.
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Language dialog box 349
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Response Schedules dialog box 343
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about 103
adding a response schedule 118
choosing response options 115

creating 109
disabling 145
naming 110
response actions 123
response phase 120
sample 105
selecting device to monito
specifying profile details 1
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alerting and monitoring repo
language 349

alerts
audio 125
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SNMP trap settings 141
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168
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bandwidth cost
reporting on 70
settings 70
specifying 71

Bandwidth Cost dialog box 70
bandwidth usage, monitoring example 

benefits 88
ClusterTrends

firewall add-on support 88
color in reports 221
command line

files used 94
running profiles 94

computers behind firewall, specifying 43

files 79

 289
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285
browser

selecting a default 290
specifying multiple log files 83

Browser filter element 169

C

categories
list of names 60
viewing mapping names 60

Categories dialog box 50, 52
core categories list 53
downloading databases 55
general categories list 54
updating URL categorization databases 

55
categorizing URLs 50
Category filter element 169
Check Point

LEA Connections dialog box 334
Check Point LEA 334, 336

monitoring 338
status 338

Check Point LEA Connections
user-defined 335

Cisco PIX interfaces, defining 340
clusters

add-on support 88

content editor 219
copying, firewall activity pro
core categories list 53

downloading 55
updating 55

country of origin, identifying
custom Web paging settings 

D

Database and Real-Time dial
Date and Time filter element
date format in reports 312
date macros 255, 354

examples 87
saving reports 207
to specify log files 85

department management
about 90
list of departments 91
using 90

departments
adding a domain or IP ad
editing 92

Departments filter element 1
Directory filter element 173

examples 174
disk space requirements 2
distributing reports in schedu



DNS cache
clearing 48
sharing 49

DNS lookup 45
clearing DNS cache 48
for performance 356
settings 329
sharing DNS cache 49
specifying options 330
specifying settings 46

email alert 126
employees, specifying IP addresses 43
events

disabling 259
execute program response action, creating 

128
extended browse, locating log files 81
External User Address filter element 175
external user address filter element 175
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document file types 318
domain behind firewall

adding 44
deleting 44
specifying 43

domain names
resolving IP addresses 45
specifying settings for DNS lookup 46

domains
adding a group 321
adding to department list 91
deleting a group 323
editing 322
grouping 321
removing a group 323
settings 321

down alert 134
downloaded file types 318

E

email
alert 126
change alert message 142
creating alert 126
MAPI 296
reports 236
SMTP 295

F

FastTrends database
about 72
activating 356
advanced options 76
deleting entries 73
how it works 72
maintenance 73
specifying storage location 76

File filter element 177
file log file retrieval 38
file types

defining 317
settings 317

filter elements
Authenticated Username 168
Browser 169
Departments 172
Directory 172
External user address 175
File 177
Firewall Actions 179
Firewall Name 180
Firewall Status Codes 193
formatting criteria 158
Internal User Address 181
modifying 162
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Multi-Homed Domain 182
multi-response action 129
Protocol Family 195
Proxy Cache 184
Referrer 187
Return Codes 189
Rule 191
Sites 192

FastTrends database and real-time 
analysis settings 72

firewall log file format 34
log file format 34, 40
log file IP address 34, 40
naming 34
running from command line 94
setting up WebTrends Syslog Service 

tions 45
ration 32
ion options 

hind firewall 

le log files 

rends data 

, 40

50
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es 32
 37
 box 32
Traffic Direction 194
User (IP) 198
User Address 196

filters
adding to existing profile 160
copying and pasting 69
creating 67
defining 160
deleting 68, 163
editing 67, 68
Elements dialog box 161
modifying 162
optimize performance 355
using with firewall activity profiles 66

Filters dialog box 66
Firewall Actions filter element 179
firewall activity profiles

about 27
adding a filter 67, 160
adding servers to list 41
bandwidth cost information 70
choosing a profile type 30
copying 79
creating 31
deleting 80
deleting a server from list 42
designing 99
editing 78
editing server list 42

77
specifying DNS lookup op
specifying firewall configu
specifying Internet resolut

45
specifying IP addresses be

43
specifying single or multip

81
specifying storage of FastT

76
time zone adjustments 34
types 28
using filters with 66
using URL categorization 
viewing sample 28

firewall activity reports
content 99

firewall add-on support for c
benefits 88

firewall add-ons
purchasing and licensing 
support for clusters 88

Firewall and Profile Types ta
firewall configuration

single or multiple machin
WebTrends Syslog Service

Firewall Configuration dialog
firewall licenses

adding 7
firewall log files



file retrieval method 38
ftp retrieval method 39
http retrieval method 39
removed from File Specifications and 

Log File List 87
retrieval methods,accessing 38
specifying single log file 82
specifying single or multiple 81

Firewall Name filter element 180
firewall profiles

G

general categories list 54
downloading 55
updating 55

general firewall activity filters
authenticated username 168
departments 172
external user address 175
firewall actions 179

34

x 340

 339

ame 225
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copying and pasting a filter 69
deleting a filter 68
editing a filter 67, 68

firewall servers
adding to list 41
deleting a server 42
editing list 42

Firewall Status Codes filter element 193
Firewall Suite

uninstalling 4
Firewall Suite, features 9
firewalls

licensing 7
purchasing add-ons 7

fiscal year, defining start month for 291
font, customizing for reports 222
formatting, filter element criteria 158
frames, in HTML reports 225
ftp

downloading log files 325
enabling FTP PASV mode 293
log file retrieval 39
settings 324
using to send reports in scheduler 252

FTP PASV mode 293

firewall name 180
firewall status codes 193
rule 191
traffic direction 194
type of traffic 195

General Firewall Activity options
LEA Connections 334
LEA Connections dialog box 3

general firewall activity options
Cisco PIX interfaces dialog bo
configuring 314
DNS dialog box 329
Domains dialog box 321
File Types dialog box 317
FTP dialog box 324
General dialog box 315
Licensed Firewalls dialog box
Protocols dialog box 325
Syslog dialog box 332

H

HTML report, table of contents fr
HTTP

get request 135
http

downloading log files 325
settings 324



Index     374

http log file retrieval 39

I

incoming firewall activity filters
authenticated username 168
browser 169
directory 172

IP addresses
adding to department list 91
lookup 45
specifying 43
specifying internal 43

IPs Behind Firewall dialog box 43

L

10

334

 339

f origin 289

achines) 40

hines) 34
file 177
multi-homed domain 182
referrer 187
return codes 189

installation
instructions 2
license and registration 5
Log File Forwarding Agent for AXENT 

Raptor NT 5
minimum system requirements 2
purchased software 5
system requirements 2
time-limited trial 5
ugrade 5
using auto-run 2
versions 5
WebTrends Firewall Suite 2

international date formats 312
Internet resolution

clearing DNS cache 48
sharing DNS cache 49
specifying settings 46

Internet Resolution dialog box 45
Internet searches

monitoring (example) 284
IP address behind firewall

adding 44
deleting 44

language
defining for reports 310

language editor 219, 300
language settings

Firewall Activity profiles 3
LEA Connections 334
LEA connections

creating 336
status 338
user-defined 335

LEA Connections dialog box 
lea.conf file 335
leaservice.log file 335
Licensed Firewalls dialog box
licenses

adding more 7
licensing 5
limiting memory usage 237
location, changing country o
log details 264, 268
log file cache

clearing 325
Log File Forwarding Agent

installing 5
log file location

specifying 34
specifying (for multiple m

log file origin
time zone (for single mac



log file path
formatting examples 351
wildcards 352

log files
accessing faster 356
clearing 145
downloading frequency 325
downloading with HTTP or FTP 325
file retrieval method 38
flushing alerting and monitoring 342

MS-Word and Excel dialog box 297
Report Ranges dialog box 303
Search Engines dialog box 299

MAPI email 296
mapping categories

example 58
syntax 58

memorizing, report 212, 218
memory

limiting for tables 239
rts 237
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ar for 

ts 297
ent 182

list 42

ent 129
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forwarding agent for AXENT Raptor NT 
5

frequency of downloading 324
ftp retrieval method 39
http retrieval method 39
removed from File Specifications and 

Log File List 87
retrieval 38
specify with date macros 85
specifying multiple 81
specifying single log file 82
specifying the location 81
specifying with wildcards 84
zipping to save space 357

logo
adding to report 226

M

macros
for defining report ranges 306
log file path 351
previewing for pre-defined reports 309

Main options 287
Access to Internet dialog box 292
E-Mail dialog box 294
General dialog box 289
Language dialog box 310

limiting when generating repo
memory requirements 2
minimum system requirements 2
modifying, filters 162
monitor threads, setting 342
monitor types 148
monitoring

device 106
response actions 109
response configurations 108
response schedule 107
response settings 107
schedule 107

monitoring options, defining adv
144

month, defining start of fiscal ye
reports 291

MS-Word and Excel report forma
Multi-Homed Domain filter elem
multiple log files, specifying 82
multiple machine firewall 32

adding servers to list 41
deleting a server from server 
editing server list 42
List of Servers dialog box 40

Multi-Response Action filter elem
multi-response action, creating 1
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NT service
Scheduler 277

numeric pager settings 134
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pager settings
custom Web paging 134

password, pager alert 133
pending alerts

clearing 342
performance analysis, Scheduler 270
performance, optimizing 355
permissions, Alerting and Monitoring 
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files 27
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on-demand reports, setting priority 272
OPSEC LEA connections 334

creating 336
monitoring 338
status 338
troubleshooting 335
user-defined 335

outgoing firewall activity
URL categorization 50

outgoing firewall activity filters
authenticated username 168
departments 172
file 177
proxy cache 184
sites 192
User (IP) 198

outgoing firewall activity profiles
specifying categories 50

P

pager alert
alpha-numeric 132
creating 130
default numeric alert 134
numeric 134
password 133
time range 133

module
configuring as a Windows

platform, system requiremen
port, for remote scheduler 27
privileges

running scheduler as serv
profile types

firewall activity 28
profiles

about firewall activity pro
alerting and monitoring 1

Protocol Family filter elemen
protocols

adding 327
defining in reports 325
defining type 327
deleting 329
editing 328
settings 325

Proxy Cache filter element 18
proxy servers

defining settings for 293
for downloading URL cate

database 59
setting up 293

purchased software 5
purchasing after installing 6
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real-time analysis
about 73
how it works 73
of log files 72

reboot response action
creating 138

Referrer filter element 187
registration

previewing macros for 309
using macros 306

report style 219
reports

adding logo 226
adding or editing styles 219
bandwidth cost 70
changing company name in Ms Word 

or Excel 298
changing date format 312
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during installation 5
online 4

remapping categories
example 58
syntax 58

remote scheduling 272
accessing 275
configuring NT user account for 274
configuring user account 275
setting up center 273
starting 274
stopping 274

report content
modifying 229
table 99

report destination
time zone 34
time zone (for multiple machines) 40

report language 300
defining 310
restoring settings 311
settings 349
specifying default 312

report range 303
adding new 303
creating new 303
deleting 306
editing 305

changing title text 305
color set in OS 203
content 211
content contained 99
creating Firewall reports 202
customizing 219
customizing color 221
customizing font 222
defining fiscal year start mont
defining language for 310
defining start of week for 290
distributing in scheduler 252
editing appearance 219
expediting with FastTrends 35
fastest 357
generating 203
HTML table of contents frame
language editor 300
language settings 310
limiting memory usage 237
memorizing 212, 218
modifying content 229
running profiles from comman
saving 212, 218
saving locally 235
saving using date macros 207
selecting a language 209, 216
selecting a style 210, 216
sending via email 236
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sending via ftp 236
setting language 349
specifying default language 312
using URL categorization 59

requirements, system 2
response action 123

audio alert 125
defined 109

scheduled event
details 257, 262, 266

scheduled events
disabling 259

Scheduler
access remote scheduling 275
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email alert 126
execute program response 128
multi-response 129
pager alert 130
reboot response 138
restart service response 140
SNMP trap alert response 141

response configuration, defined 108
Response Configurations dialog box 345
response options, choosing 115
response phase 120
response schedule 107

adding 118
response settings 107
restart service response action, creating 

140
retrieval of firewall log files 38
Return Codes filter element 189
Rule filter element 191

S

sample, firewall activity profile 28
saving

reports 212, 218
saving reports in Scheduler 252
Schedule Log details 264, 268

Clear Schedule Log 264
configuring account for re

scheduling 275
customizing 268
defining as "act as part of 

privilege 274
disabling an event 259
editing an event 249
killing a scheduled event 

running 251
options 268
performance 264
performance analysis 270
performance details 268
privileges to run as servic
remote scheduling 272
running as a service 278
running event on demand
running profile on deman
running Scheduler as an N

277
running startup 271
Schedule Log 259
Schedule Log details 266
setting up remote schedul

273
specifying report distribut
start up Scheduler as serv
stopping 251



search engine
adding new 299
deleting 302
editing 301
options 299

security, examples 281
server list
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deleting 42
editing 42

Syslog
settings 332

system requirements 2

T

table of contents frame, HTML report 225
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Servers 40
service

configuring Scheduler startup 279
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